Copyright

Copyright ® 1968-2004 SYSTRAN Software, Inc. All Rights Reserved.

Information in this document is subject to change without notice. The software described in this document is furnished under a license agreement or a non-disclosure agreement. The software may be used or copied only in accordance with the terms of those agreements. No part of this publication may be reproduced, stored in a retrieval system, or transmitted by any means, electronic or mechanical, including photocopying and recording, for any purchaser’s personal use without the written permission of SYSTRAN Software, Inc.

SYSTRAN Software, Inc. SYSTRAN SA
9333 Genesee Avenue 1 Parvis de La Défense - La Grande
Plaza Level, Suite PL1 Arche
San Diego, CA 92121 92044, Paris La Défense Cedex
USA FRANCE

Trademarks

SYSTRAN Professional Premium, SYSTRAN Professional Standard, SYSTRAN Personal, SYSTRAN Toolbar, SYSTRAN Translation Project Manager, SYSTRAN Dictionary Manager, SYSTRAN MultiTranslate Utility, and SYSTRAN Clipboard Taskbar are registered trademarks of SYSTRAN Software, Inc. Microsoft® is a registered trademark, and Windows is a trademark of Microsoft Corporation. ScanSoft® OCR © 1994-2002 ScanSoft, Inc. All rights reserved. Other brands and their products are trademarks or registered trademarks of their respective holders and should be noted as such.
Part I: Introduction

Chapter 1: Using This Guide
  Using This User Guide
  Matching Users with Chapters
  Conventions Used in This User Guide

Chapter 2: SYSTRAN 5.0 Overview
  SYSTRAN 5.0 Overview
  Activities at a Glance
  Quick Tour of SYSTRAN 5.0 Applications
  Common Components
  Using the STPM and SMTU Workspace

Part II: SYSTRAN User Tools

Chapter 3: Using the Plugin for Internet Explorer
  Using the Plugin for Microsoft Internet Explorer
  Displaying or Hiding the Internet Plugin
  Understanding the Plugin for Internet Explorer
  Using the Plugin for Internet Explorer
  Specifying Fluid Navigation Options
  Customizing Translations

Chapter 4: Using the Plugins for Microsoft Office
  Using the Plugins for Microsoft Office
  Translating Documents, Presentations, and Spreadsheets
  Translating Selected Text in Microsoft Word
  Using Word’s Extended Alignment Feature
  Translating Email in Microsoft Outlook
  Customizing Translations
Chapter 5: Using the SYSTRAN Clipboard Taskbar (SCT) 54
- Launching SCT .............................................. 56
- Using SCT ..................................................... 56
- Selecting Clipboard Translator Options .................... 57
- Customizing Translations ................................ 58

Chapter 6: Translating PDF Documents .............. 60

Part III: SYSTRAN Expert Tools

Chapter 7: Using SYSTRAN Translation Project Manager (STPM) .... 63
- Understanding Files, Web Pages, and Projects ............ 64
- Launching STPM ............................................. 65
- Using STPM .................................................. 67
- Importing a File or Web Page ................................ 67
- Translating Files and Web Pages ............................. 70
- Improving Translations .................................... 71
- Performing Miscellaneous STPM Activities ............... 82

Chapter 8: Using SYSTRAN MultiTranslate Utility (SMTU) .... 92
- Understanding Batch Files ................................ 93
- Launching SMTU ............................................. 94
- Using SMTU .................................................. 96
- Opening a Batch File ....................................... 96
- Adding Files, Folders, and Web Pages ....................... 98
- Arranging Items in the Batch File ........................... 101
- Translating Batch File Contents ............................ 102
- Customizing Translations .................................. 103
- Performing Miscellaneous SMTU Activities ............... 105

Chapter 9: Using SYSTRAN Dictionary Manager (SDM) 112
- Overview ................................................. 113
- Launching SDM ........................................... 114
- Managing a Dictionary or Translation Memory ............ 115
- Working with User Dictionary Entries ...................... 125
- Working with Dictionaries ................................ 141
- Using Intuitive Coding to Build High-Quality Dictionaries 144
Part IV: Appendixes

Appendix A: Menu, Command, and Toolbar Reference
SYSTRAN Translation Project Manager (STPM) .......................... 151
SYSTRAN MultiTranslate Utility (SMTU) ........................................ 159
SYSTRAN Dictionary Manager (SDM) ................................. 162
SYSTRAN Server Commands ......................................................... 168

Appendix B: Preparing English Text for MT ...................... 169
General Principles ................................................................. 170
Grammar Writing Rules ......................................................... 170
Observing Punctuation Rules .............................................. 172
Lexical Ambiguities ............................................................... 175
Format and Typographical Issues ...................................... 176
Do-Not-Translate (DNT) Tags ............................................... 177

Appendix C: Sample Imperative Translations ............. 178
Sample Imperative Translations ........................................... 179
English into French .............................................................. 179
English into German ............................................................ 179
English into Italian ............................................................... 179
English into Portuguese ....................................................... 180
English into Spanish ............................................................. 180

Appendix D: Importing and Exporting Files .......... 181
Importing Formatted Text Files ...................................... 182
Importing Microsoft Excel Files .................................... 184
Exporting Files ................................................................. 184

Glossary ................................................................. 185
Index ................................................................. 195
Part I: Introduction

Contents
• Chapter 1, Using This Guide
• Chapter 2, SYSTRAN 5.0 Overview
Chapter 1:
Using This Guide

Using This User Guide  8
Matching Users with Chapters  8
Conventions Used in This User Guide  9
   Tips  9
   Notes  9
   Cautions  9
   Menu, Command, and Button Names  9
   Filenames and Items You Type  9
Using this User Guide  10
   Bookmarks  10
   Using the Navigation Arrows  10
Welcome

Welcome to SYSTRAN 5.0 — the finest translation software available. SYSTRAN 5.0 is a family of products that offers a variety of features and capabilities (for a list of the products that make up SYSTRAN 5.0, see SYSTRAN 5.0 Overview on page 12). While their feature sets vary, all SYSTRAN 5.0 products provide intuitive translation tools that let you perform translations efficiently and effectively.

Using This User Guide

This User Guide contains all the information you need to use SYSTRAN 5.0. It has been designed from the ground up to be as comprehensive as possible, while providing fast access to the information you need.

Matching Users with Chapters

Since SYSTRAN 5.0 supports basic and advanced components, this User Guide is organized into separate parts that describe these components. Table 1-1 identifies various users and the chapters they should read.

Table 1-1: Matching Readers with Chapters

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Casual User</th>
<th>Internet Explorer User</th>
<th>Microsoft Office User</th>
<th>PDF User</th>
<th>Advanced User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, Using This Guide</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chapter 2, SYSTRAN 5.0 Overview</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chapter 3, Using the Plugin for Internet Explorer</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 4, Using the Plugins for Microsoft Office</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 5, Using the SYSTRAN Clipboard Taskbar (SCT)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 6, Translating PDF Documents</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Chapter 7, Using SYSTRAN Translation Project Manager (STPM)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Chapter 8, Using SYSTRAN Multi-Translate Utility (SMTU)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Chapter 9, Using SYSTRAN Dictionary Manager (SDM)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
Conventions Used in This User Guide

The following conventions are used in this Guide.

**Tips**
A tip provides helpful information. The following icon is used to identify tips.

![A tip provides helpful information.](image)

**Notes**
A note is information that requires special attention. The following icon will be used to identify notes.

![A note is information that requires special attention.](image)

**Cautions**
A caution contains information that, if not followed, can cause damage to the application or critical files in the application or on the user's computer. The following icon will identify cautions.

![A caution contains information that, if not followed, can cause damage to the application or critical files in the application or on the user's computer.](image)

**Menu, Command, and Button Names**
The names of menus, commands, and Toolbar buttons are shown in a Helvetica Bold Condensed typeface.

**Filenames and Items You Type**
Filenames and items that you type are shown in a Courier typeface.
Using this User Guide

This User Guide has been designed to make it easy to navigate through pages and find the information you need.

Bookmarks

The contents of this User Guide are shown as bookmarks in the bookmark pane to the left. To view subtopics, click the plus sign next to a topic. The topic will be expanded to show the subtopics it contains.

Each bookmark is a hyperlink to the associated section of this User Guide. To view the contents, click the bookmark. As you view the contents in the document pane, the bookmark associated with that content is highlighted in the bookmark pane to help you easily identify where you are in the document.

Using the Navigation Arrows

The navigation arrows provide Next Page (➡️) and Previous Page (⬅️) navigation between the page number to allow you to navigate through the pages one at a time. You can also page through the document using the First Page, Previous Page, Next Page, and Last Page navigation arrows in the Acrobat toolbar.
Chapter 2: SYSTRAN 5.0 Overview

Activities at a Glance 14
Quick Tour of SYSTRAN 5.0 Applications 15
  Plugin for Internet Explorer 15
  SYSTRAN Clipboard Taskbar (SCT) 15
  Plugins for Microsoft Office 15
  PDF Translations 16
  SYSTRAN Translation Project Manager (STPM) 17
  SYSTRAN Dictionary Manager (SDM) 19
  SYSTRAN MultiTranslate Utility (SMTU) 20
Common Components 21
  SYSTRAN Toolbar 21
    Using the Source Language Drop-Down List 22
    Using the Target Language Drop-Down List 23
    Using the Translate Button 23
    Using the Translation Options Button 23
    Using the Dictionaries Button 27
    Using the Review Button 33
    Using the STPM and SMTU Workspace 35
SYSTRAN 5.0 OVERVIEW

SYSTRAN 5.0 consists of the following products:

- SYSTRAN Professional Premium™
- SYSTRAN Professional Standard™
- SYSTRAN Office Translator™
- SYSTRAN Personal™
- SYSTRAN Web Translator™
- SYSTRAN PDF Translator™

SYSTRAN 5.0, our flagship product, supports all Graphical User Interface (GUI) components and features. The other products support a subset of GUI components and features available in SYSTRAN 5.0. Table 2-1 shows the GUI components supported by the six SYSTRAN 5.0 products.

The beginning of each chapter identifies which SYSTRAN 5.0 products support the features in the chapter.

Table 2-1: Summary of GUI Components Supported by SYSTRAN 5.0 Products

<table>
<thead>
<tr>
<th>Feature</th>
<th>SYSTRAN PDF Translator</th>
<th>SYSTRAN Web Translator</th>
<th>SYSTRAN Personal</th>
<th>SYSTRAN Office Translator</th>
<th>SYSTRAN Professional Standard</th>
<th>SYSTRAN Professional Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation for PDF documents</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Clipboard Taskbar (SCT)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin for Internet Explorer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Plugin for Microsoft Word</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Plugin for Microsoft Outlook</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Plugin for Microsoft PowerPoint</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Plugin for Microsoft Excel</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Translation Project Manager (STPM)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Advanced</td>
<td>Expert</td>
</tr>
<tr>
<td>SYSTRAN Dictionary Manager (SDM)</td>
<td></td>
<td></td>
<td></td>
<td>Basic</td>
<td>Basic</td>
<td>Advanced</td>
</tr>
</tbody>
</table>
### Table 2-1: Summary of GUI Components Supported by SYSTRAN 5.0 Products (Continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>SYSTRAN PDF Translator</th>
<th>SYSTRAN Web Translator</th>
<th>SYSTRAN Personal</th>
<th>SYSTRAN Office Translator</th>
<th>SYSTRAN Professional Standard</th>
<th>SYSTRAN Professional Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTRAN MultiTranslate Utility (SMTU)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Language Detection</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Translation Options</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Dictionary Updates</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Translation Markup</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Translation Customization</td>
<td>UD</td>
<td>UD</td>
<td>UD</td>
<td>UD</td>
<td>UD</td>
<td>UD, TM, ND</td>
</tr>
<tr>
<td>Terminology Extraction</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NFW Only</td>
<td>✔</td>
</tr>
<tr>
<td>Access to SYSTRAN Online Dictionaries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Additional Specialized Terminology</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Limitations</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document Size</td>
<td>5 Pages</td>
<td>None</td>
<td>2 pages</td>
<td>5 pages</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No limit for IE</td>
<td>No limit for IE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UD Size</td>
<td>100</td>
<td>500</td>
<td>2,000</td>
<td>20,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UD Name</td>
<td>Fixed</td>
<td>Fixed</td>
<td>Adjustable</td>
<td>Adjustable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UD Type</td>
<td>Bilingual</td>
<td>Bilingual</td>
<td>Bilingual</td>
<td>Multilingual</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ND Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>20,000</td>
<td></td>
</tr>
<tr>
<td>TM Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>40,000</td>
<td></td>
</tr>
<tr>
<td>Number of UDs that can be loaded</td>
<td>NA</td>
<td>NA</td>
<td>1</td>
<td>1</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Number of TMs that can be loaded</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>Number of NDs that can be loaded</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Activities at a Glance

Table 2-2 summarizes key activities you can perform using SYSTRAN 5.0.

Table 2-2: Activities at a Glance

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse the Web in your native language, or surf and translate Web pages</td>
<td>SYSTRAN plugin for Internet Explorer</td>
</tr>
<tr>
<td>Translate Microsoft Word documents</td>
<td>SYSTRAN plugin for Microsoft Word</td>
</tr>
<tr>
<td>Translate Microsoft Excel spreadsheets</td>
<td>SYSTRAN plugin for Microsoft Excel</td>
</tr>
<tr>
<td>Translate Microsoft PowerPoint presentations</td>
<td>SYSTRAN plugin for Microsoft PowerPoint</td>
</tr>
<tr>
<td>Translate email in Microsoft Outlook</td>
<td>SYSTRAN plugin for Microsoft Outlook</td>
</tr>
<tr>
<td>Translate any text</td>
<td>SYSTRAN Clipboard Taskbar (SCT)</td>
</tr>
<tr>
<td>Translate PDF files</td>
<td>SYSTRAN Translation Project Manager (STPM), SYSTRAN MultiTranslate Utility (SMTU), SYSTRAN plugin for Microsoft Word, SYSTRAN plugin for Internet Explorer</td>
</tr>
<tr>
<td>Align source and target DOC, RTF, TXT, HTML, XHTML, and PDF files and Web pages; proof-read; and perform post-editing</td>
<td>SYSTRAN Translation Project Manager (STPM)</td>
</tr>
<tr>
<td>Define translation tasks for a set of documents and run scheduled batch-translation jobs</td>
<td>SYSTRAN MultiTranslate Utility (SMTU)</td>
</tr>
<tr>
<td>Develop customized dictionaries based on your company’s or industry’s terminology</td>
<td>SYSTRAN Dictionary Manager (SDM)</td>
</tr>
<tr>
<td>Add your own unique terminology to translations</td>
<td>SYSTRAN Dictionary Manager (SDM)</td>
</tr>
<tr>
<td>Create and use Translation Memories</td>
<td>SYSTRAN Dictionary Manager (SDM)</td>
</tr>
<tr>
<td>Create Normalization Dictionaries</td>
<td>SYSTRAN Dictionary Manager (SDM)</td>
</tr>
<tr>
<td>Extract terminology to create customized dictionaries</td>
<td>SYSTRAN Translation Project Manager (STPM), SYSTRAN MultiTranslate Utility (SMTU), SYSTRAN plugin for Microsoft Office, SYSTRAN plugin for Internet Explorer</td>
</tr>
</tbody>
</table>
Quick Tour of SYSTRAN 5.0 Applications

The following sections provide a quick tour of the applications available in SYSTRAN 5.0. Each section starts with a list of the SYSTRAN products that support the application.

**Plugin for Internet Explorer**
- SYSTRAN Web Translator
- SYSTRAN Personal
- SYSTRAN Office Translator
- SYSTRAN Professional Standard
- SYSTRAN Professional Premium

The plugin for Internet Explorer lets you browse Web pages in your native language and translate the pages. Once a page has been translated, the plugin’s “fluid navigation” automatically translates all pages linked to the translated page. When you click one of these links, the linked page appears in the target language you selected.

For more information, see [Chapter 3, Using the Plugin for Internet Explorer](#).

**SYSTRAN Clipboard Taskbar (SCT)**
- SYSTRAN Personal
- SYSTRAN Professional Standard
- SYSTRAN Professional Premium

The SYSTRAN Clipboard Taskbar (SCT) provides a fast and easy way to translate any text that has been cut or copied to the Windows Clipboard. Once the text has been cut or copied to the Windows Clipboard, clicking the Translate button on the Taskbar translates the text on the Clipboard. You can then paste the translated text from the Clipboard into your application using the tools you normally use to paste text within the target program. In addition to translating text, SCT maintains document formatting whenever possible.

For added convenience, SCT provides an Active Clipboard option that translates text automatically when the text is cut or copied to the Clipboard, without having to click the Translate button. This option gives you the convenience of translating text without any mouse clicks.

For more information, see [Chapter 5, Using the SYSTRAN Clipboard Taskbar (SCT)](#).

**Plugins for Microsoft Office**
- SYSTRAN PDF Translator (Microsoft Word only)
- SYSTRAN Office Translator
- SYSTRAN Professional Standard
- SYSTRAN Professional Premium

SYSTRAN 5.0 supports the following plugins for Microsoft Office 2003, XP, and 2000.
- Plugin for Microsoft Word
  - Lets you translate an entire document or selected text in a document. If you translate selected
text, the translated (target) text can either be added to the document or replace the original (source) text.

The plugin for Microsoft Word is also used to translate PDF files (see Chapter 4, Using the Plugins for Microsoft Office).

- Plugin for Microsoft PowerPoint
  Lets you translate an entire presentation or selected text in a presentation. If you translate selected text, the target text can either be added to the presentation or replace the source text.

- Plugin for Microsoft Excel
  Lets you translate an entire Excel spreadsheet.

- Plugin for Microsoft Outlook
  Lets you translate email. When you translate e-mail, the source text and target text appear are separated by a banner in the email.

The plugins are integrated into these Microsoft applications as toolbars. As a result, you can perform translations directly from these Microsoft Office applications. The plugins preserve the format of the document, spreadsheet, or presentation being translated.

The plugin for Microsoft Word provides the following additional features:

- Lets you view the original (source) and translated (target) documents side by side and alternate between them.
- Lets you use alignment to highlight text in one document and see the corresponding area highlighted in the other document.

For more information, see Chapter 4, Using the Plugins for Microsoft Office.

These plugins also work in a limited way with Microsoft Office 97. The limitations are documented under Translating Selected Text in Microsoft Word on page 47 and Using Word’s Extended Alignment Feature on page 48.

PDF Translations

- SYSTRAN PDF Translator
- SYSTRAN Professional Standard
- SYSTRAN Professional Premium

SYSTRAN 5.0 supports the translation of Portable Document Format (PDF) documents. For more information, see Chapter 6, Translating PDF Documents.
SYSTRAN Translation Project Manager (STPM)

- SYSTRAN Professional Standard: Advanced
- SYSTRAN Professional Premium: Expert

SYSTRAN Translation Project Manager (STPM) lets you work with, edit, and enhance your translations. It supports DOC, RTF, TXT, HTML, XHTML, and PDF documents and preserves their formatting. It also supports TMX-formatted files, but does not preserve their format (to preserve the format of these files, use SMTU, described below). STPM also lets you open online documents by entering their Web address (or URL).

Once a document or Web page is opened, you can translate it. You can then use STPM’s alignment feature to view and compare the original (source) and translated (target) documents or Web pages side by side. STPM also provides linguistic capabilities for improving translations.

These capabilities include:

- Defining Do Not Translate blocks (a sequence of words or paragraph that is not to be translated).
- Specifying translation options that suit your requirements. Examples include specifying whether alternate meanings in the main SYSTRAN dictionary should be displayed and whether capitalized words and phrases should be left as they are.
- Reviewing terminology, performing source analysis, reviewing the translation, and viewing alternative translations.
- Using Translation Memory to offer suggestions to sentences that either exactly match or are slightly different to those in previous translations.
- Source text linguistic enrichment capabilities that let you add information to avoid ambiguities and improve translations. In the sentence Contact SYSTRAN, for example, the word Contact can be analyzed as either a noun or a verb. Using these capabilities, you can force the translation to consider Contact as a verb.
- The ability to interact with SDM to build and validate a User Dictionary from STPM.

STPM also lets you interact with the translation by adding “User Choice annotations” such as Do Not Translate (DNT), source analysis, and alternate meaning selections. It also provides editing and formatting tools for changing the look and feel of source and target documents or Web pages.

STPM comes in two version:

- An Advanced version that SYSTRAN Professional Standard supports.
- An Expert version that SYSTRAN Professional Premium supports.

Table 2-3 shows the features supported by the Advanced and Expert versions of STPM. For more information about STPM, see Chapter 7, Using SYSTRAN Translation Project Manager (STPM).
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Advanced</th>
<th>Expert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side-by-side alignment</td>
<td>Side-by-side comparison and alignment of source and translated documents.</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>SDM interaction</td>
<td>Interaction with SDM to build and validate a User Dictionary from STPM.</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>DNT definition</td>
<td>Definition of Do Not Translate (DNT) blocks.</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Import TXT, RTF, DOC and HTML files</td>
<td>Import of TXT, RTF, DOC, and HTML documents (HTML documents could not be imported using SYSTRAN version 4).</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Online document support</td>
<td>Can open an online document by providing its Web address (URL).</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>HTML editing</td>
<td>HTML editing and formatting capabilities.</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Import/ export TMX files</td>
<td>Import and export of TMX files (format is not preserved; to preserve the format use SMTU).</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Translation review tool</td>
<td>Translation Review tool (post-edition) and interaction with SYSTRAN Translation Memory (post-edited sentences are candidates for integration into Translation Memory).</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Source text linguistic enrichment</td>
<td>Source text linguistic enrichment adds information to improve translations. For instance, ambiguous terms in text can be forced into a certain category. An example is the word contact in the phrase Contact SYSTRAN, where Contact can be analyzed as either a noun or a verb.</td>
<td>✔ ✔</td>
<td>✔ ✔</td>
</tr>
</tbody>
</table>
SYSTRAN Dictionary Manager (SDM)

- SYSTRAN Personal: Basic
- SYSTRAN Office Translator: Basic
- SYSTRAN Professional Standard: Advanced
- SYSTRAN Professional Premium: Expert

SYSTRAN Dictionary Manager (SDM) lets you build, create, and maintain User Dictionaries (UDs), Translation Memories (TMs), and Normalization Dictionaries (NDs). These dictionaries are used in other SYSTRAN 5.0 applications to customize your translations.

SDM comes in three versions:

- A Basic version that SYSTRAN Personal and SYSTRAN Office Translator support.
- An Advanced version that SYSTRAN Professional Standard supports.
- An Expert version that SYSTRAN Professional Premium supports.

Table 2-4 shows the features supported by the Basic, Advanced, and Expert versions of SDM. For more information, see Using SYSTRAN Dictionary Manager (SDM) on page 112.

Table 2-4: SDM Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Basic</th>
<th>Advanced</th>
<th>Expert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improved Intuitive Coding™</td>
<td>Provides superior analysis of plain entries (those without linguistic clues). Also supports special characters and provides expert dictionary coding capabilities (through clues only, no Wizard).</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Coding confidence indicator</td>
<td>Software automatically analyzes and codes an entry. Low confidence does not mean the entry is incorrect, but that it is more likely to be incorrect than one with a higher confidence.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Print dictionaries</td>
<td>Lets you print a hard copy of the dictionaries.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>UD format</td>
<td>Converts User Dictionaries from SYSTRAN version 4 format to version 5 format.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Improved UD search capabilities</td>
<td>Lets you search local dictionaries, as well as search, browse, and download SYSTRAN Online User Dictionaries.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Multilingual dictionary editor</td>
<td>Makes it easy to create multilingual dictionaries.</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Import/ Export</td>
<td>Imports/exports text and Microsoft Excel dictionaries.</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>
SYSTRAN MultiTranslate Utility (SMTU)

- SYSTRAN Professional Premium

SYSTRAN MultiTranslate Utility (SMTU) is designed for users who perform a large number of translations. Using SMTU, you can place documents into groups (or “batches”) and translate them in one operation. You can add documents to batches individually or as entire directories (folders).

To optimize translations, SMTU lets you specify general and document-specific translation options. It also supports terminology extraction aggregated for the entire set of documents. SMTU supports TXT, RTF, DOC, HTML, XHTML, PPT, XLS, and PDF documents. It also supports TMX-formatted files. SMTU also lets you translate Web documents by specifying the Web page’s URL. SMTU provides a “Web crawler” that lets you extract and translate the content of a website.

For users who prefer command-line interfaces (CLIs), SMTU provides a CLI for automating the translation process.

For more information, see Chapter 8, Using SYSTRAN MultiTranslate Utility (SMTU)
Common Components

For ease of use, SYSTRAN 5.0 applications share common components. The following sections describe these shared components.

SYSTRAN Toolbar

The SYSTRAN Toolbar is common to all SYSTRAN 5.0 applications. You use the Toolbar to translate from an original (or “source”) language into a different (or “target”) language. The SYSTRAN Toolbar also provides buttons you can use to modify your translation. Since the applications in SYSTRAN 5.0 offer different capabilities and features, these buttons may vary between applications. Figure 2-1 shows the SYSTRAN Toolbar and the suggested order in which you use the components on it.

The Toolbar buttons have tool tips. If you place the pointer over a button, a tool tip identifies the button’s function.

In the Microsoft Office plugins, the source and target languages are selected from a single drop-down list (see Chapter 4, Using the Plugins for Microsoft Office).

The following procedure provides a general description about how to use the SYSTRAN Toolbar:

1. Select a source language from the left drop-down list, or use Auto Detect to have SYSTRAN 5.0 automatically ascertain the language for you.
2. Select a target language from the right drop-down list.
3. Click the Translate button to perform the translation.
4. Optional: Improve your translations:
   a) Click the Translation Options button to select your translation options.
   b) Click the Dictionary button to specify dictionary options. See Using the Dictionaries Button on page 27.
   c) Click the Review button to view the results of your translation. See Using the Review Button on page 33.

Figure 2-1: SYSTRAN Toolbar
d) Click the Search and Highlight button to search and highlight words and expressions, such as extracted terminology, Not Found Words, words, and words with alternative meanings or source ambiguities. See Searching and Highlighting on page 79.

e) Use any other buttons specific to the SYSTRAN application (see Table 2-5).

5. If you performed step 4, click the Translate button again to see whether the translation is improved. Repeat steps 4 and 5 as necessary until the desired translation is achieved.

Table 2-5: Application-Specific Buttons

<table>
<thead>
<tr>
<th>Application</th>
<th>Button Name</th>
<th>Button Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCT</td>
<td>Clipboard Options</td>
<td>Lets you enable or disable the Active Clipboard and Cross-Application Support options.</td>
</tr>
<tr>
<td></td>
<td>Translation Options</td>
<td></td>
</tr>
<tr>
<td>Plugin for Internet Explorer</td>
<td>Web Translator Options</td>
<td>Lets you define fluid navigation settings.</td>
</tr>
<tr>
<td></td>
<td>Source/ Target</td>
<td>Lets you toggle between source and target Web pages.</td>
</tr>
<tr>
<td>Plugin for Microsoft Word</td>
<td>Word Plugin Options</td>
<td>Lets you enable or disable extended alignment.</td>
</tr>
<tr>
<td>Plugin for Microsoft Outlook</td>
<td>Outlook Plugin Options</td>
<td>Lets you modify banner settings.</td>
</tr>
<tr>
<td>SMTU</td>
<td>Batch Entry Options</td>
<td>Lets you select batch entry options.</td>
</tr>
</tbody>
</table>

Using the Source Language Drop-Down List

The Source Language drop-down list lets you select the original (or “source”) language that SYSTRAN 5.0 is to translate from. The source languages available in this drop-down list depend on the languages you installed during the SYSTRAN 5.0 installation procedure.

One of the choices in this drop-down list is Auto Detect. This selection allows the software to automatically ascertain the source language for you. Auto Detect is especially helpful when you are not familiar with the language of a document, spreadsheet, presentation, email, or Web page that you want to translate. The languages that Auto Detect automatically identifies include:

- Arabic
- Chinese
- Danish
- Dutch
- English
- Farsi
- French
- German
- Greek
- Italian
- Japanese
- Korean
- Russian
- Spanish
- Swedish
- Urdu
- Portuguese

SYSTRAN 5.0 uses a statistical method to auto-detect source languages. For this reason, there may be times when the source language is either not identified correctly or not identified at all. Auto Detect is automatic with STPM.
Using the Target Language Drop-Down List

The Target Language drop-down list lets you select the target language that SYSTRAN 5.0 will translate to. The target languages available in this drop-down list depend on the languages you installed during the SYSTRAN 5.0 installation procedure and the source language you selected. For example, if you have Russian as the source language, the only target language you can select is English.

Using the Translate Button

After you select the target and source languages, click the Translate button ( ) to initiate the translation. You can then examine the translation and fine-tune it, if desired, using the buttons to the right of the Target Language drop-down list.

Using the Translation Options Button

After you perform a translation, you can review your current translation options and change them as necessary. To access translation options, click the Translations Options button on the SYSTRAN Toolbar:

The Translation Options window appears with a variety of translation settings you can use to modify translations. The options that appear vary by application and the source and target languages selected. Figure 2-2 on page 24 shows an example of the Translation Options window. Table 2-6 on page 25 describes the settings that can appear in the window.

Because Translation Options vary by application and source and target languages, some options in Table 2-6 on page 25 may not be available.
### Translation Options

<table>
<thead>
<tr>
<th>Formatting</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Document Sub...</td>
<td>No</td>
</tr>
<tr>
<td>Preserve Textual Format...</td>
<td>No</td>
</tr>
<tr>
<td>Text paragraph definition</td>
<td>Auto detection</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Linguistic options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not Translate Capitali</td>
<td>No</td>
</tr>
<tr>
<td>Do not Translate Address</td>
<td>No</td>
</tr>
<tr>
<td>Source Spellcheck</td>
<td>Yes</td>
</tr>
<tr>
<td>Imperative choice</td>
<td>Infinitive</td>
</tr>
</tbody>
</table>

#### Personal pronoun definition

<table>
<thead>
<tr>
<th>1st Person Singular</th>
<th>Masculine</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Person</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td>Masculine</td>
</tr>
<tr>
<td>Number</td>
<td>Singular</td>
</tr>
<tr>
<td>Polite/Informal</td>
<td>Informal</td>
</tr>
<tr>
<td>1st Person Plural Gender</td>
<td>Masculine</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicatore</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminology Extraction</td>
<td>No</td>
</tr>
</tbody>
</table>

Figure 2-2: Example of the Translation Options Window
### Table 2-6: Translation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Formatting</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Banner Setting</strong></td>
<td>Microsoft Outlook plugin only: Places a banner between the original email and the translation. Default is: &quot;------ Translated Message ------&quot;. To customize this banner, use Options in the toolbar of the SYSTRAN plugin for Microsoft Outlook.</td>
</tr>
<tr>
<td><strong>Translated thread</strong></td>
<td>Microsoft Outlook plugin only: Translate the entire thread in the body of an email or only the higher level.</td>
</tr>
<tr>
<td><strong>Support Document Sub-Languages</strong></td>
<td>Determines whether all sequences in the text that are marked as not being in the source language are considered DNT.</td>
</tr>
<tr>
<td><strong>Preserve Textual Formatting</strong></td>
<td>Determines whether formatting, including sequences of spaces between words, is preserved during translation.</td>
</tr>
<tr>
<td><strong>Text paragraph definition</strong></td>
<td>Determines whether text extends (or &quot;wraps&quot;) to the next line. Auto automatically ascertains whether text paragraphs wrap to the next line.</td>
</tr>
<tr>
<td><strong>DNT font list</strong></td>
<td>Prevents the specified fonts from being translated. Fonts are specified as a pair of font names separated by a comma. Adding an exclamation point after a comma indicates that the font should not be a DNT font. Example: Times, Wingdings defines Times as a DNT font, and Wingdings as a font to translate. Default DNT fonts are Symbol, Webdings, Wingdings, and all fonts of \fnil, \ftech font families.</td>
</tr>
<tr>
<td><strong>Font substitution list</strong></td>
<td>Defines substitution of fonts: value is the name of the font to be used for displaying all translated words. This option is useful when the source font does not support target language characters.</td>
</tr>
<tr>
<td><strong>Source charset</strong></td>
<td>SMTU only: Defines the source document’s character set. Auto detects the source character set automatically. This option has no effect on .doc and .rtf documents.</td>
</tr>
<tr>
<td><strong>Target charset</strong></td>
<td>SMTU: Defines the target document’s character set. Auto detects the target character set automatically, depending on the source character set and requirements of the target language. This option has no effect on .doc and .rtf documents. (Available in SMTU only)</td>
</tr>
<tr>
<td><strong>Transliteration</strong></td>
<td>Enables or disables the transliteration of NFW in target text.</td>
</tr>
</tbody>
</table>
Table 2-6: Translation Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segmentation character list</td>
<td>Lets you define certain characters (or character sequences) that are to be considered as sentence-segmentation symbols. In yahoo.fr, for instance, the character</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Lingustic Options</td>
<td></td>
</tr>
<tr>
<td>Do not Translate Capitalized</td>
<td>Allows capitalized words to be considered as DNT in the translation process.</td>
</tr>
<tr>
<td>Words</td>
<td></td>
</tr>
<tr>
<td>Do not Translate Address</td>
<td>Determines whether address recognition and protection are activated.</td>
</tr>
<tr>
<td>Source Spellcheck</td>
<td>Determines whether spellcheck is activated during translation.</td>
</tr>
<tr>
<td>Localization</td>
<td>Selects target language country localization for certain languages (for example, American/British English, European/Brazilian Portuguese, and Simplified/Traditional Chinese).</td>
</tr>
<tr>
<td>Source SubLanguage</td>
<td>Defines whether the source corpus is traditional or simplified. This feature is useful when choosing transcription systems.</td>
</tr>
<tr>
<td>German New Spelling</td>
<td>Enables new German spelling.</td>
</tr>
<tr>
<td>Imperative Choice</td>
<td>Lets you select an imperative mode that suits the style of the text. Imperative options depend on the target language.</td>
</tr>
<tr>
<td>Personal Pronoun Definition</td>
<td></td>
</tr>
<tr>
<td>1st Person Singular Gender</td>
<td>Determines whether first-person singular genders are treated as masculine or feminine expressions.</td>
</tr>
<tr>
<td>2nd Person</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td>Determines whether second-person singular genders are treated as masculine or feminine expressions.</td>
</tr>
<tr>
<td>Number</td>
<td>Determines whether numbers are treated as singular or plural expressions.</td>
</tr>
<tr>
<td>Polite/Informal</td>
<td>Determines whether polite or informal usage is followed during translation.</td>
</tr>
<tr>
<td>1st Person Plural Gender</td>
<td>Determines whether first-person singular genders are treated as masculine or feminine expressions.</td>
</tr>
</tbody>
</table>
Using the Dictionaries Button

The Dictionaries button ( ) lets you select SYSTRAN Dictionaries and User Dictionaries (UDs) to customize translations. SYSTRAN 5.0 users can also use this button to select Translation Memories (TMs) and Normalization Dictionaries (NDs) to further customize translations. Clicking this button lets you access the following dictionaries. The symbiotic combination of these dictionaries provides for more effective translations.

- **SYSTRAN Dictionaries**
  SYSTRAN 5.0 and SYSTRAN Professional Standard 5.0 contain five built-in dictionaries. These dictionaries contain terms associated with industries, business, life sciences, colloquial usage, and sciences. You cannot edit these dictionaries. However, you can prioritize them (see Working with SYSTRAN Dictionaries and Domains on page 28).

- **User Dictionaries (UD)**
  UD are functionally identical to the SYSTRAN dictionaries. Unlike SYSTRAN dictionaries, you can use SDM to add and edit terms in UD and train the software about your translation requirements. UD can be used with terms that have specific or unusual meanings. Examples might be your company name, or terms specific to your business or industry that are not found in the SYSTRAN dictionaries.

- **Translation Memory (TM)**
  SYSTRAN Professional Premium only: TM contains pretranslated and aligned source/target sen-

---

### Table 2-6: Translation Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Alternate Meanings</td>
<td>Takes alternate meanings from SYSTRAN or User Dictionaries and displays them in text. Internet Explorer plugin only: Lets you display alternate meanings popups. Words with alternative meanings are highlighted and moving the pointer over them displays alternative meanings as a tool-tip popup.</td>
</tr>
<tr>
<td>Not Found Words Marker</td>
<td>Shows the number of Not Found Words in the document and lets you select how they are to be displayed.</td>
</tr>
<tr>
<td>User Dictionary Marker</td>
<td>Shows the number of Dictionary Markers in the document and lets you select how they are to be displayed.</td>
</tr>
<tr>
<td>Translation Memory Marker</td>
<td>Shows the number of Translation Memory Markers in the document and lets you select how they are to be displayed.</td>
</tr>
<tr>
<td>Terminology Extraction</td>
<td>Activate terminology extraction. Terminology extends NFW extraction performed during translation and proposes specialized terminological expressions.</td>
</tr>
</tbody>
</table>

---
sentences. When a sentence in TM appears again, TM remembers the previous translation and suggests it to you.

- Normalization Dictionary (ND)
  SYSTRAN Professional Premium only: NDs provide a way to normalize source text before translation or normalize target text after translation. For example, terms like “4u” that are used in chat-type environments can be defined as “for you.” You can also use NDs to standardize spellings. If your company uses the term “online” instead of “on-line,” for example, you can use the ND to ensure that the appropriate instance of “online” is used.

SYSTRAN also provides online dictionaries that you can download from the SYSTRAN website at www.systransoft.com. Once downloaded onto your computer, the online dictionaries appear as UDs within the SYSTRAN applications.

**Working with SYSTRAN Dictionaries and Domains**

Each SYSTRAN Dictionary has domains associated with it. Domains are subdivisions of User Dictionaries. When you select SYSTRAN Dictionaries, you also select the domains that will be used. For example, you might want to use the Electronics and Mathematics domains from the Sciences Dictionary, along with the Economics/Business domain from the Business Dictionary. **Table 2-7** lists the SYSTRAN dictionaries and their domains.

**Table 2-7: SYSTRAN Dictionaries and Domains**

<table>
<thead>
<tr>
<th>SYSTRAN Dictionary</th>
<th>Domains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business</td>
<td>Economics/Business</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
</tr>
<tr>
<td></td>
<td>Political Science</td>
</tr>
<tr>
<td>Colloquial</td>
<td>Colloquial</td>
</tr>
<tr>
<td>Industries</td>
<td>Automotive</td>
</tr>
<tr>
<td></td>
<td>Aviation/Space</td>
</tr>
<tr>
<td></td>
<td>Military Science</td>
</tr>
<tr>
<td></td>
<td>Naval/ Maritime</td>
</tr>
<tr>
<td></td>
<td>Metallurgy</td>
</tr>
<tr>
<td>Life Sciences</td>
<td>Life Sciences</td>
</tr>
<tr>
<td></td>
<td>Earth Sciences</td>
</tr>
<tr>
<td></td>
<td>Medicine</td>
</tr>
<tr>
<td></td>
<td>Food Science</td>
</tr>
</tbody>
</table>
Table 2-7: SYSTRAN Dictionaries and Domains (Continued)

<table>
<thead>
<tr>
<th>SYSTRAN Dictionary</th>
<th>Domains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sciences</td>
<td>Computers/Data Processing</td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
</tr>
<tr>
<td></td>
<td>Mathematics</td>
</tr>
<tr>
<td></td>
<td>Mechanical/Engineering</td>
</tr>
<tr>
<td></td>
<td>Photography/Optics</td>
</tr>
<tr>
<td></td>
<td>Physics/Atomic Energy</td>
</tr>
<tr>
<td></td>
<td>Chemistry</td>
</tr>
</tbody>
</table>

The following procedure describes how to select SYSTRAN Dictionaries, UDs, TMs, and NDs:

1. Click the User Dictionaries button ( ). The User Dictionaries window appears (see Figure 2-3 on page 30). The dictionaries shown in the window depend on the source and target languages selected.

If you used SDM to create UDs, TMs, and NDs, the “friendly name” you assigned to them are the name ones that appear in the User Dictionaries window.
2. In the top pane, check each SYSTRAN Dictionary, UD, TM, and/or ND you want to use. Each time you click a SYSTRAN Dictionary, the domains associated with it appear in the bottom pane (see Figure 2-4 on page 31).
3. In the top pane, set the priority of the SYSTRAN Dictionaries, UDs, TMs, and NDs by clicking one of them and clicking the arrows at the right side to move your selection higher or lower in priority (see Figure 2-5 on page 32).
4. For each SYSTRAN Dictionary selected, go to the bottom pane and check each domain you want to use with your translations. Then set the priority of the domains by clicking one and clicking the arrows at the right side to move it higher or lower in priority (see Figure 2-5).

The User Dictionaries window has a Refresh button for updating the items shown in this window. If you create new UDIs in SDM, click this button to update the window contents with the dictionaries you created.

5. Click the Translate button ( ) again to perform another translation and see whether the desired results have been achieved.
Using the Review Button

The Review button ( ) displays a Review window that lets you identify expressions such as Not Found Word or Terminology Extraction that the software found. This window contains a Terminology Review tab that is common to all SYSTRAN applications. Each row in this tab contains an expression, a value that shows how often the expression appears in the document, and the confidence level associated with the expression.

Checkboxes next to each expression let you select the expressions you want to send to a new UD. After you check the expressions you want to send to the UD, click the button at the bottom of the tab to create the new UD that will contain the checked expressions. When the Save As dialog box appears, assign a name to the UD. You can then use SDM to open the UD and tailor it to meet your requirements.

The bottom of the tab also has check boxes for selecting all expressions or selecting all terms that have a frequency of one. Since there can be many terms with a frequency of one, this latter checkbox streamlines your review by hiding terms that occur only once. Figure 2-6 on page 34 shows an example of the Terminology Review tab.

If you click a term in this tab, all instances of that term are highlighted in the source and target documents, and the cursor moves from its current location to the next occurrence where the term appears in the document. Similarly, if you click a term in the source or target document that appears in the Terminology Review tab, that term is highlighted in the tab. You can move to the next occurrence of the term by pressing the F3 key.

For STPM, the Review window contains additional tabs for working with translations. For more information, see Adding User-Choice Selections on page 72.
Figure 2-6: Example of the Terminology Review Tab

You can sort the lists shown in a Review window column by clicking the header column. For example, to sort the expressions by frequency in the figure above, click the header column Freq. Similarly, to alphabetically by expression, click the Expression header column.
Using the STPM and SMTU Workspace

As mentioned earlier, the SYSTRAN Toolbar provides buttons to the right of the Target Language drop-down list for improving your translations. When you click these buttons in the STPM and SMTU applications, a window appears with information you can use to modify your translations.

Each of these window provides a thumb tack in the top-right corner that lets you hide the window when you are not using it. Figure 2-7 shows an example of the thumbtack in the User Dictionaries window.

![User Dictionaries Window](image)

Figure 2-7: User Dictionaries Window
When you click the thumb tack, the window hides behind the right side of the STPM or SMTU window, and a button with the window name appears vertically along the right side of the window (see Figure 2-8). To view the window, move the pointer over the window name. To return the window to its previous behavior, click the thumb tack again. To close the window, either click the X in the top-right corner or click the same button you used to display the window.

If you click the thumb tack in more than one window, the window names appear vertically one below the other at the right side of the window for easy access.

Figure 2-8: Close-up of the User Dictionaries Button
Part II: SYSTRAN User Tools

Contents

- Chapter 3, Using the Plugin for Internet Explorer
- Chapter 4, Using the Plugins for Microsoft Office
- Chapter 5, Using the SYSTRAN Clipboard Taskbar (SCT)
- Chapter 6, Translating PDF Documents
Chapter 3: Using the Plugin for Internet Explorer

Displaying or Hiding the Internet Plugin 39
Understanding the Plugin for Internet Explorer 39
Using the Plugin for Internet Explorer 40
Specifying Fluid Navigation Options 41
Customizing Translations 42
  Selecting Translation Options 42
  Using User Dictionaries 42
  Using the Review Feature 43
Using the Plugin for Microsoft Internet Explorer

The plugin for Microsoft Internet Explorer is supported by:

- SYSTRAN Web Translator
- SYSTRAN Personal
- SYSTRAN Office Translator
- SYSTRAN Professional Standard
- SYSTRAN Professional Premium

The features and limitations of your software may vary, depending on the product you purchased. For more information, see Table 2-1 on page 12.

The plugin for Microsoft Internet Explorer gives you the power to translate Web pages. It also supports “fluid navigation,” which enables automatic translation of all links on a Web page once the Web page has been translated. For added control, fluid navigation can be:

- Disabled.
- Restricted within the current domain with the same source language.
- Restricted within the current domain with any source language.
- Restricted to any domain that has the same source language as the current one.
- Unrestricted to any domain that has any source language.

When the plugin for Microsoft Internet Explorer translates a Web page, it caches the translated page. Consequently, if you move from the translated page to another Web page and then return to the previous page, the translated page reappears.

Displaying or Hiding the Internet Plugin

Initially, the SYSTRAN Toolbar may not appear in Internet Explorer. To display the SYSTRAN Toolbar:

1. Open Internet Explorer.
2. On the View menu, point to Toolbars.
3. Click the SYSTRAN 5.0 item so a check mark appears next to it.

To hide the SYSTRAN Toolbar, repeat this procedure, but uncheck the SYSTRAN 5.0 item in step 3.

Understanding the Plugin for Internet Explorer

The plugin for Internet Explorer is a toolbar that is automatically installed in Internet Explorer when you install SYSTRAN 5.0 (see Figure 3-1 on page 40). You can hide and display it as you would any toolbar in Internet Explorer.
By default, the Toolbar is shown. To hide it, click View, point to Toolbars, and click Systran 5.0. To redisplay it, repeat this procedure.

If you want to move the Toolbar, you must first unlock Internet Explorer toolbars. Click the View menu, point to Toolbars, and click Lock the Toolbars to remove the checkmark next to it.

Plugin for Internet Explorer

Figure 3-1: Plugin for Internet Explorer

Using the Plugin for Internet Explorer

To use the plugin for Internet Explorer:

1. Use Internet Explorer to navigate to a Web page.
2. Use the Source Language drop-down list to select a source language, or select Auto to have the plugin ascertain the language of the Web page automatically (see Using the Source Language Drop-Down List on page 22).
3. Use the Target Language drop-down list to select a target language (see Using the Target Language Drop-Down List on page 23).
4. Click the Translate button to translate the Web page:

5. Optional: Review the translation and improve it if necessary. See Customizing Translations on page 42.
6. To toggle between the source and target pages, click the Source/Target button:
Specifying Fluid Navigation Options

Using the Web Translation Options button ( ), you can define the fluid navigation settings used by the plugin for Internet Explorer.

1. Click the Web Translation Options button:

The Fluid Navigation option appears to the left of the Web page (see Figure 3-2).

2. Click the current option setting. A down arrow appears to the right of the current setting.

3. Click the down arrow and select the appropriate setting (see Table 3-1 on page 42). The settings range from the most restricted (top setting) to the most liberal (bottom setting).

4. Remove the Fluid navigation options, click either the X in the top-right corner of the window where the options appear or the Web Translation Options button.
Customizing Translations

After you translate a Web page, you can perform the following activities to customize your translations:

- Selecting Translation Options, below
- Using User Dictionaries, below

Selecting Translation Options

One way to customize translations is to review your current translation options and change them as necessary. You can then translate the document again to apply your selections to the translation.

To access translation options, click the Translations Options button on the SYSTRAN Toolbar.

For more information, see Using the Translation Options Button on page 23.

One of the translation options for the Internet Explorer plugin is Display Alternate Meanings. This option displays expressions found in other SYSTRAN or User Dictionaries either in text or as popups. If no additional dictionaries are selected, no alternative meanings are displayed.

Using User Dictionaries

Another way to customize translations is by using terms stored in User Dictionaries and Translation Memory. To access User Dictionaries and Translation Memory, click the User Dictionaries button on the SYSTRAN Toolbar.

For more information, see Using the Dictionaries Button on page 27.

Table 3-1: Fluid Navigation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>Turns off fluid navigation.</td>
</tr>
<tr>
<td>Restricted (within domain, same source</td>
<td>Allows fluid navigation within the current domain for pages that have the</td>
</tr>
<tr>
<td>language)</td>
<td>same source language as the one selected in the SYSTRAN Toolbar.</td>
</tr>
<tr>
<td>Domain Restricted (within domain, any</td>
<td>Allows fluid navigation within the current domain for pages that have any</td>
</tr>
<tr>
<td>source language)</td>
<td>source language.</td>
</tr>
<tr>
<td>Language Restricted (any domain,</td>
<td>Allows fluid navigation within any domain for pages that have the same</td>
</tr>
<tr>
<td>same source language)</td>
<td>source language as the one selected in the SYSTRAN Toolbar.</td>
</tr>
<tr>
<td>Unrestricted (any domain, any source</td>
<td>Allows fluid navigation within any domain for pages that have any source</td>
</tr>
<tr>
<td>language)</td>
<td>language.</td>
</tr>
</tbody>
</table>

Another translation option is Display Alternate Meanings. This option displays expressions found in other SYSTRAN or User Dictionaries either in text or as popups. If no additional dictionaries are selected, no alternative meanings are displayed.
Using the Review Feature

Another way to customize translations is by using the plugin’s Review feature. Using this feature, you can identify expressions such as Not Found Word or Do Not Translate blocks that the software found.

To access the plugin's Review features, click the Review button on the SYSTRAN Toolbar:

For more information, see Using the Review Button on page 33.
Chapter 4: Using the Plugins for Microsoft Office

Translating Documents, Presentations, and Spreadsheets 46
Translating Selected Text in Microsoft Word 47
Using Word’s Extended Alignment Feature 48
Translating Email in Microsoft Outlook 50
  Selecting Outlook Plugin Options 51
Customizing Translations 52
  Selecting Translation Options 52
  Using User Dictionaries 53
  Using the Review Feature 53
USING THE PLUGINS FOR MICROSOFT OFFICE

The plugins for Microsoft Office are supported by:

✔ SYSTRAN PDF Translator (supports Microsoft Word only)
✔ SYSTRAN Office Translator
✔ SYSTRAN Professional Standard
✔ SYSTRAN Professional Premium

The features and limitations of your software may vary, depending on the product you purchased. For more information, see Table 2-1 on page 12.

The SYSTRAN 5.0 plugins for the Microsoft Office work with the following Microsoft Office 2003, XP, and 2000 applications:

- Microsoft Word
- Microsoft Excel
- Microsoft PowerPoint
- Microsoft Outlook

These plugins also work in a limited way with Microsoft Office 97. The limitations are documented under Translating Selected Text in Microsoft Word on page 47 and Using Word’s Extended Alignment Feature on page 48.

Outlook Express is not supported by SYSTRAN 5.0.

The plugins place toolbars in these Office applications automatically. Using these toolbars, you can translate an entire Microsoft Word document, PowerPoint presentation, or Excel spreadsheet, while preserving format and layout. When you translate a document, presentation, or spreadsheet, the SYSTRAN plugins create a new target file that contains the translated text. To make it easy to find the translated file, the plugins assign a name that is similar to that of the source file, with the final characters denoting the source and target languages. For example, if you translate a Word document called RESUME.DOC from English to French, the target file will be named RESUME_ENFR.DOC, where EN denotes English and FR denotes French.

The plugin for Microsoft Word also provides the following features:

- Translation of selected text.
  In addition to translating an entire Word document, you can translate selected text and then specify whether the translated text should replace the original text or be inserted next to it.
- Extended alignment
  When a Word document is translated, the source (original) document and target (translated) document appear side by side. You can then use the plugin’s alignment feature to highlight text in one document and see the corresponding area in the other document.
Accessing right-click options

After you translate a Word document, you can press the right mouse button to display a context menu for accessing additional SYSTRAN features. These features include sending words and expressions to SDM (if SDM is installed) and defining DNT blocks.

The plugin for Microsoft Outlook lets you translate email. When you perform the translation, the source (original) text and target (translated) text appear in the same email, separated by a banner.

Translating Documents, Presentations, and Spreadsheets

To translate Microsoft Word documents, PowerPoint presentations, and Excel spreadsheets:

1. Open the document, presentation, or spreadsheet you want to translate.
2. Use the Language drop-down list to select the source-target language pair (see Figure 4-1).

![Language Drop-Down List](image)

Figure 4-1: Example of Selecting a Language Pair

3. Microsoft Word only: To see the source and target documents together following the translation, enable extended alignment in the Word Plugin Options (see Using Word’s Extended Alignment Feature on page 48).

4. Click the Translate button on the SYSTRAN Toolbar:

   ![Translate Button](image)

   A Save As dialog box appears, with the name of the file that will contain the translated document, presentation, or spreadsheet (see Figure 4-2 on page 47).

   The filename ends with an underline followed by two letters that indicate the source language and two letters that indicate the target language. In Figure 4-2 on page 47, for example, the plugin added _enfr to the filename to show that the source language is English (en) and the target language is French (fr).
5. Click Save to save the translated document, presentation, or spreadsheet.

6. Optional: Review the translation and improve it if necessary. See Customizing Translations on page 52.

If you translated a Word document with extended alignment enabled, the source and target documents appear together (see Using Word's Extended Alignment Feature on page 48).

Translating Selected Text in Microsoft Word

In addition to translating an entire document, you can translate selected text in a Microsoft Word document. The selected text can either replace the original text or appear next to it.

Selection translation is not supported in Microsoft PowerPoint, Excel, or Outlook.

For Office 97 (Word plugin), translation is not available through the contextual menu. The translation selection is only available in “replace” mode and is automatically performed when text is selected and the Translation button is clicked.

1. Open the document that contains the text you want to translate.

2. In your document, drag your pointer over the text you want to translate.

3. Press the right mouse button and click one of the following options:
   - Translate selection and replace translates the selected text and replaces the original text with the translated text.
   - Translate selection and insert inserts the translated text next to the original text you selected.

4. Optional: Review the translation and improve it if necessary. See Customizing Translations on page 52.
Using Word’s Extended Alignment Feature

The plugin for Microsoft Word provides an extended alignment feature that activates sentence alignment and terminology markup. When this feature is enabled, the plugin for Word displays the original and translated documents after the source document has been translated. You can then select a sentence in one of the documents and see the corresponding sentence highlighted in the other document.

This feature is not available for Office 97 plugins.

To enable the extended alignment feature:

1. In Microsoft Word, click the Word Plugin Options button on the SYSTRAN Toolbar.

   The Word Plugin Options window appears (see Figure 4.3).

2. Click Extended alignment. When the down arrow appears next to the current setting, select a different setting from the drop-down list (see Figure 4.4 on page 49).
3. Click the OK button to exit the Word Plugin Options window.

4. If you enabled extended alignment, select a sentence in either the source or target document. The corresponding area in the other document is highlighted automatically. Figure 4-5 on page 50 shows an example of using alignment in a Word document.
Translating Email in Microsoft Outlook

Using Outlook, you can translate an email:

1. Open Microsoft Outlook.
2. Type the email you want to translate.
3. Use the Language drop-down list to select the source-target language pair (see Figure 4-6).
4. Click the Translate button on the SYSTRAN Toolbar:

   The SYSTRAN plugin translates the email, inserts the translated text into the same email as the source text, and inserts a banner between the two (see Figure 4-7 on page 51).

   The default banner is ------ Translated Message ------. If desired, you can use the Outlook plugin options to change the banner (see Selecting Outlook Plugin Options on page 51).
5. Optional: Review the translation and improve it if necessary (see Customizing Translations on page 52), then repeat step 4 to translate again. Repeat steps 4 and 5 as necessary until you achieve the desired results.

Figure 4-7: Example of a Translated Email

Selecting Outlook Plugin Options
By default, the banner that separates the original email from the translated email is: ------Translated Message ------.

If desired, you can change this banner.

1. In Microsoft Outlook, click the Outlook Plugin Options button.

The Outlook Plugin Options window appears (see Figure 4-8 on page 52).
2. Click in the field where the current banner appears, then replace it with the banner you want to use.

3. When you finish typing the banner, click the OK button to exit the Outlook Plugin Options window.

**Customizing Translations**

After you translate a document, spreadsheet, presentation, or email, you can perform the following activities to customize your translations:

- Selecting Translation Options, below
- Using User Dictionaries on page 53
- Using the Review Feature on page 53

**Selecting Translation Options**

One way to customize translations is to review your current translation options and change them as necessary. You can then translate the document, spreadsheet, presentation, or email again to apply your selections to the translation.

To access translation options, click the Translations Options button on the SYSTRAN Toolbar:

For more information, see Using the Translation Options Button on page 23).
Using User Dictionaries

Another way to customize translations is by using terms stored in User Dictionaries and Translation Memory. To access User Dictionaries and Translation Memory, click the User Dictionaries button on the SYSTRAN Toolbar:

For more information, see Using the Dictionaries Button on page 27.

Using the Review Feature

Another way to customize translations is by using the plugin’s Review feature. Using this feature, you can identify expressions such as Not Found Word or Terminology Extraction that the software found.

To access the plugin’s Review features, click the Review button on the SYSTRAN Toolbar:

For more information, see Using the Review Button on page 33.
Chapter 5:
Using the SYSTRAN Clipboard Taskbar (SCT)

Launching SCT  56
Using SCT  56
Selecting Clipboard Translator Options  57
Customizing Translations  58
   Selecting Translation Options  58
   Using User Dictionaries  59
Using the SYSTRAN Clipboard Taskbar (SCT)

The SYSTRAN Clipboard Taskbar (SCT) is supported by:

✔ SYSTRAN Personal
✔ SYSTRAN Professional Standard
✔ SYSTRAN Professional Premium

The features and limitations of your software may vary, depending on the product you purchased. For more information, see Table 2-1 on page 12.

The SYSTRAN Clipboard Taskbar (SCT) lets you translate text from most any application by cutting or copying text to the Windows Clipboard. SCT automatically translates the Clipboard text, which you can then paste into your application using the appropriate commands in your application. SCT is particularly convenient when you want to perform translations in applications for which there are no SYSTRAN 5.0 plugins.

By default, SCT lets you cut, copy and paste Clipboard text within the same application. For users who want to paste translated text from the Clipboard into different applications, SCT provides a Cross-Application Support option. By default, this option is disabled to increase efficiency. However, you can enable it if you want to cut or copy text from one application and paste the translated text into another application. For example, you can highlight text in Notepad and press Ctrl+C to copy the text to the Clipboard; you can then go to WordPad and press Ctrl+V to paste the translated text from the Clipboard.

The SCT also provides an Active Clipboard option. When Active Clipboard is enabled, the translation process occurs automatically when you cut or copy text to the Clipboard, without having to click the Translate button. This option gives you the convenience of translating text using the fewest number of mouse clicks. It is particularly convenient if you will be performing many translations and don’t want to click the Translate button for each translation.
Launching SCT

To launch SCT:

1. Click the Start button on the Windows Taskbar.
2. Point to Programs, point to SYSTRAN 5.0, and click SYSTRAN Clipboard Taskbar. The SCT appears (see Figure 5-1).

Using SCT

To use SCT:

1. Use the Source Language drop-down list to select a source language, or select Auto to have SCT ascertain the language automatically (see Using the Source Language Drop-Down List on page 22).
2. Use the Target Language drop-down list to select a target language (see Using the Target Language Drop-Down List on page 23).
3. To cut, copy, and paste text between applications, enable Cross-Application Support (see Selecting Clipboard Translator Options, below).
4. To translate text without having to click the Translate button, enable Active Clipboard (see Selecting Clipboard Translator Options, below).
5. In your application, cut or copy text to the Clipboard the way you normally would. If Active Clipboard is enabled, the Clipboard text is translated automatically and you can skip to the next step. Otherwise, click the Translate button to translate the Clipboard text:

To show that the Clipboard text has been translated, the language displayed in the source drop-down matches the language of the text on the Clipboard and the Translate button is disabled.

6. Go to the location where you want to paste the translated text, then paste the text as you normally would in that application.
7. To improve your translation, click the Clipboard Translations Options button to select the appropriate translation options (see Using the Translation Options Button on page 23):

Selecting Clipboard Translator Options

SCT provides Clipboard Translation Options that let you enable the Cross-Application Support and Active Clipboard options.

- Cross-Application Support lets you cut or copy text from one application and paste the translated text into another application.
- Active Clipboard allows the translation process to occur automatically when you cut or copy text to the Clipboard, without having to click the Translate button.

To access these options:

1. Click the Clipboard Translation Options button:

   ![Clipboard Translator Options Window]

   The Clipboard Translation Options window appears (see Figure 5-2).

   [Clipboard Translator Options Table]

   | Active Clipboard | Yes |
   | Cross-Application Support | Yes |

   Figure 5-2: Clipboard Translator Options Window

2. To change the Active Clipboard setting, click Active Clipboard. When the down arrow appears next to the current setting, select a different setting from the drop-down list (see Figure 5-3 on page 58).
3. To change the Cross-Application Support setting, click Cross-Application Support. When the down arrow appears next to the current setting, select a different setting from the drop-down list.

4. Click the OK button to exit the Clipboard Translator Options window.

Customizing Translations

After you translate Clipboard text, you can perform the following activities to customize your translations:

- Selecting Translation Options, below
- Using User Dictionaries, below

Selecting Translation Options

One way to customize translations is to review your current translation options and change them as necessary. You can then translate the Clipboard text again to apply your selections to the translation.

To access translation options, click the Translations Options button on the SYSTRAN Toolbar:

For more information, see Using the Translation Options Button on page 23.
Using User Dictionaries

Another way to customize translations is by using terms stored in User Dictionaries and Translation Memory. To access User Dictionaries and Translation Memory, click the User Dictionaries button on the SYSTRAN Toolbar:

For more information, see Using the Dictionaries Button on page 27.
Chapter 6:
Translating PDF Documents
Translating PDF Documents

PDF document translation is supported by:
✔ SYSTRAN PDF Translator
✔ SYSTRAN Professional Standard
✔ SYSTRAN Professional Premium

The features and limitations of your software may vary, depending on the product you purchased. For more information, see Table 2-1 on page 12.

The Portable Document Format (PDF) is a popular file format developed by Adobe Systems. PDF captures formatting information from a variety of applications, making it possible to send formatted documents and have them appear on the recipient's monitor or printer as they were intended.

The following SYSTRAN applications support the ability to translate PDF documents:

- Plugin for Internet Explorer: lets you translate embedded PDF files. See Chapter 3, Using the Plugin for Internet Explorer.
- Plugin for Microsoft Word: lets you revise and translate PDF files. See Chapter 4, Using the Plugins for Microsoft Office.
- STPM: lets you import a PDF file into STPM and translate the file. See Chapter 7, Using SYSTRAN Translation Project Manager (STPM).
- SMTU: lets you import one or more PDF files into a batch file and then translate all the files in the batch. See Chapter 8, Using SYSTRAN MultiTranslate Utility (SMTU).

For added convenience, SYSTRAN 5.0 provides a right-click command for translating PDF files from the Windows Explorer or My Computer window. To use this feature:

1. In the Windows Explorer or My Computer window, click the PDF file you want to translate.
2. Press the right mouse button and click Open and Translate in Word.
3. You can then use the plugin for Microsoft Word, if desired (see Chapter 4, Using the Plugins for Microsoft Office).
Part III: SYSTRAN Expert Tools

Contents

- Chapter 7, Using SYSTRAN Translation Project Manager (STPM)
- Chapter 8, Using SYSTRAN Multi-Translate Utility (SMTU)
- Chapter 9, Using SYSTRAN Dictionary Manager (SDM)
Chapter 7: Using SYSTRAN Translation Project Manager (STPM)

Understanding Files, Web Pages, and Projects  64
Launching STPM  65
Displaying or Hiding STPM Toolbars  66
Using STPM  67
Importing a File or Web Page  67
Importing a File  68
Displaying a Web Page  69
Opening an Existing Project  69
Translating Files and Web Pages  70
Improving Translations  71
Using Alignment  71
Adding User-Choice Selections  72
Reviewing Terminology and Sentences  76
Selecting Translation Options  78
Using User Dictionaries  78
Searching and Highlighting  79
Performing Miscellaneous STPM Activities  82
Performing Contextual Dictionary Activities  82
Specifying DNT Entities  83
Finding Words and Expressions in User Dictionaries  84
Editing Text  85
Formatting Text  86
Navigating between Projects  87
Saving Projects  87
Exporting Projects, Source Files, and Target Files  89
Using SYSTRAN Translation Project Manager (STPM)

SYSTRAN Translation Project Manager (STPM) is supported by:
✔ SYSTRAN Professional Standard (supports Advanced version)
✔ SYSTRAN Professional Premium (supports Expert version)

This chapter describes the Expert version of STPM. You may not be able to use all these features if you have the Advanced version. For a complete description of the features supported by each STPM version, see SYSTRAN Translation Project Manager (STPM) on page 17.

SYSTRAN Translation Project Manager (STPM) is a “translation workbench” that lets you manage translations from initial document analysis through dictionary updates, and use reviewing tools for quality assurance. Using STPM, you can import DOC, RTF, TXT, HTML, XHTML, PDF, and TMX-formatted files into STPM and access Web pages, translate them, and compare the original (source) and translated (target) documents side-by-side. You can then perform post-editing to customize translations or enrich the source document with “user-choice” annotations. STPM also interacts with SYSTRAN’s Translation Memory™ to integrate post-edited sentences into TM. STPM also provides editing and formatting capabilities. You can also export projects, source files and Web pages, and target files and Web pages.

Understanding Files, Web Pages, and Projects

Files are imported into STPM using Import File on the File menu, while Web pages are accessed using STPM’s Web Toolbar. When you import a file or display a Web page, STPM creates a “project” automatically. A project contains a source document and a target document. Each document appears in its own window.

- The source text window shows the file or Web page in its original language.
- The target text window shows the file or Web page after it has been translated. This window is empty until you translate the source document or Web page.

Your STPM session can have more than one project open at the same time. Each project appears in its own folder in the SYSTRAN Translation Project Manager window. You can navigate between the projects as necessary (see Navigating between Projects on page 87).

Project files end with the extension .stp and can only be opened with STPM.
Launching STPM

To launch STPM:

1. Perform one of the following steps:
   - Double-click the SYSTRAN Translation Project Manager icon on your desktop.
   - Click the Start button on the Windows Taskbar, point to Programs, point to SYSTRAN 5.0, and click SYSTRAN Translation Project Manager.

Either step displays the SYSTRAN Translation Project Manager window. Figure 7-1 shows the components in this window and Table 7-1 on page 66 describes them.

![Figure 7-1: Components of the SYSTRAN Translation Project Manager Window](image-url)
Displaying or Hiding STPM Toolbars

By default, all STPM toolbars are displayed. If you will not be using certain functions, you may want to hide the toolbar for those functions to reduce the items on your screen.

To hide or display STPM toolbars:

1. Move the pointer to the STPM toolbar area.
2. Press the right mouse button. A pop-up menu appears with a list of the STPM toolbars (see Figure 7-2). A checkmark next to a toolbar name means the toolbar is displayed.

3. To hide a toolbar, click its name to remove the checkmark next to it.

To display a toolbar that is hidden, click its name so the checkmark appears next to it.

Table 7-1: SYSTRAN Translation Project Manager Window Components

<table>
<thead>
<tr>
<th>Screen Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>Contains the name of the application and Windows controls for minimizing, maximizing, and closing the STPM window and application.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>Contains the STPM menus. Each menu has a list of commands you can click to perform various STPM activities. See STPM Menus and Commands on page 151.</td>
</tr>
<tr>
<td>Standard Toolbar</td>
<td>Provides buttons for commonly used STPM commands. See Standard Toolbar (STPM) on page 155.</td>
</tr>
<tr>
<td>Format Toolbar</td>
<td>Provides a drop-down list for selecting fonts and formatting. See Format Toolbar (STPM) on page 155.</td>
</tr>
<tr>
<td>Web Toolbar</td>
<td>Lets you enter Web page addresses (URLs). See Web Toolbar (STPM) on page 156.</td>
</tr>
<tr>
<td>Stop Toolbar</td>
<td>Stops the current action.</td>
</tr>
<tr>
<td>SYSTRAN Toolbar</td>
<td>Lets you select source and target languages, choose translation options, and perform translation activities. See SYSTRAN Toolbar (STPM) on page 156.</td>
</tr>
<tr>
<td>Main Area</td>
<td>The area where the source and target windows appear.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays status messages at the bottom of the STPM window.</td>
</tr>
<tr>
<td>Progress Bar Area</td>
<td>Shows the progress of the translation.</td>
</tr>
</tbody>
</table>

Figure 7-2: STPM Toolbar

- Standard
- Format
- Web
- Stop
- SYSTRAN

---

**Displaying or Hiding STPM Toolbars**

By default, all STPM toolbars are displayed. If you will not be using certain functions, you may want to hide the toolbar for those functions to reduce the items on your screen.

To hide or display STPM toolbars:

1. Move the pointer to the STPM toolbar area.
2. Press the right mouse button. A pop-up menu appears with a list of the STPM toolbars (see Figure 7-2). A checkmark next to a toolbar name means the toolbar is displayed.

3. To hide a toolbar, click its name to remove the checkmark next to it.

To display a toolbar that is hidden, click its name so the checkmark appears next to it.
Using STPM

The following procedure summarizes the steps for using STPM.

1. Optional: On the File menu, click New Project or click the New Project button on the SYSTRAN Toolbar.

Creating a project is optional, because a new project is created automatically when you import a file or display a Web page in step 2.

2. Import the file or display the Web page you want to translate (see Importing a File or Web Page, below).

3. Translate the file or Web page. See Translating Files and Web Pages on page 70.

4. Optional: Review the translation and improve it if necessary (see Improving Translations on page 71). Then repeat step 3 to translate again. Repeat steps 3 and 4 as necessary until you achieve the desired results.

5. Save the project. See Saving Projects on page 87.

Importing a File or Web Page

The first step in using STPM is to import a file or display the Web page you want to translate.

- To import a file, see Importing a File, below.
- To display a Web page, see Displaying a Web Page on page 69.
- If the file or Web page resides in an STPM project that you previously worked with, open that project (see Opening an Existing Project on page 69).
Importing a File

STPM lets you translate DOC, RTF, TXT, HTML, XHTML, PDF, and TMX-formatted files. To import one of these file types:

1. On the File menu, click Import File. The Open dialog box appears (see Figure 7-3).

2. For Files of type, select the type of file you want to open.

3. Navigate to the location where the file you want to open resides.

4. Click the file and click the Open button. STPM creates a new project and displays the selected file in the source document window (see Figure 7-4).

Figure 7-3: Open Dialog Box

Figure 7-4: Example of a File in a Source Document Window
Displaying a Web Page

If you want to translate a Web page, use the following procedure to display the page.

1. In the Address field of the Web Toolbar:
   
   ![Address Field](image)

   enter the Web address (URL) of the Web page you want to translate.

2. Click the Open button to the right of the Address field:

   STPM creates a new project and displays the Web page in the source document window (see Figure 7-5).

   ![Web Page in Source Document Window](image)

   If a Web page is not displayed properly or at all, it may contain complex formatting such as Flash or a Java applet. To see whether a page has complex formatting, open it with Internet Explorer.

Opening an Existing Project

If the file or Web page you want to translate resides in an STPM project you previously accessed, use the following procedure to open the project.

1. Perform one of the following steps:
   
   - On the File menu, click Open Project.
   
   OR

   - Click the Open Project button:

   Either step displays the Open dialog box (see Figure 7-3 on page 68).
2. Navigate to the location where the project you want to open resides.
3. Click the project and click the Open button. The selected project opens, with the source and target documents displayed in their respective windows.

If you did not translate the file or Web page, the target window is empty.

Translating Files and Web Pages

After you import a file, display a Web page, or open a project, use the following procedure to translate it.

1. Use the Source Language drop-down list to select a source language, or select Auto to have the software ascertain the language automatically (see Using the Source Language Drop-Down List on page 22).
2. Use the Target Language drop-down list to select a target language (see Using the Target Language Drop-Down List on page 23).
3. Click the Translate button to perform the translation:

   A progress bar at the bottom-right side of the window shows the progress of the translation.
   When the translation completes, the translated document or Web page appears in the target document window (see Figure 7-6).

![Source Web page](image1)

![Translated Web page](image2)

Figure 7-6: Example of Source and Translated Web Pages
Improving Translations

After you translate a source document or Web page, you can perform the following activities to improve your translations:

- Using Alignment, below
- Adding User-Choice Selections on page 72
- Selecting Translation Options on page 78
- Using User Dictionaries on page 78
- Searching and Highlighting on page 79

Using Alignment

STPM provides an alignment feature that lets you select a sentence in either the source or target and view the corresponding sentence in the other document or Web page. Using this feature, you can spot areas where you may want to improve translations for the current document or Web page (described in subsequent sections in this chapter) or even change the source or target text (see Editing Text on page 85 and Formatting Text on page 86).

Figure 7-7 shows an example of a sentence selected in the source document and automatically highlighted in the target document.

![Figure 7-7: Example of Using the Alignment Feature](image-url)
Adding User-Choice Selections

One way to improve translations is by using the following STPM user-choice capabilities in the Review window:

- **Alternative Meanings** — shows alternative translations based on different meanings of a source word or expression. See Selecting Alternative Meanings, below.
- **Translation Memory** — shows machine translations along with your Translation Memory entries and allows you to select which one to use. See Selecting a Translation Memory on page 73.
- **Source Analysis** — shows how the software handled source ambiguities and allows you to override the software selections. See Modifying Source Analysis on page 75.

Selecting Alternative Meanings

The Alternative Meanings tab in the Review window shows alternative meanings for expressions in SYSTRAN or User Dictionaries. If no SYSTRAN or User Dictionaries are selected, no alternative meanings are shown. Figure 7-8 shows an example of the Alternative Meanings tab.

![Figure 7-8: Alternative Meanings Tab](image_url)
To use the Alternative Meanings tab:

1. If the Review window is not displayed, click the Review button on the SYSTRAN Toolbar:

2. If the Alternative Meanings tab is not the topmost tab in the Review window, click it to move it to the front.

3. Review the choices on each line. To select a choice, click the radio button in front of it.

4. If you want the software to always handle a choice as shown in the Alternative Meanings tab, click the checkbox in the left column.

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation.

To reverse an Alternative Meaning selection, click the selection in the Alternative Meanings tab, then click Delete Alternative Meanings Choice on the Tools menu.

Selecting a Translation Memory

The Translation Memory tab in the Review window shows sentences for which a Translation Memory has been applied. Using this tab, you can compare machine translations with your Translation Memory entries and decide which one should be used. Figure 7-9 on page 74 shows an example of the Translation Memory tab.
Figure 7-9: Translation Memory Tab

1. If the Review window is not displayed, click the Review button on the SYSTRAN Toolbar:

2. If the Translation Memory tab is not the topmost tab in the Review window, click it to move it to the front.

3. Review the choices on each line. To select a choice, click the radio button in front of it.

4. If you want the software to always handle a choice as shown in the Translation Memory tab, click the checkbox in the left column.

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation:

   To reverse a Translation Memory selection, click the selection in the Translation Memory tab, then click Delete TM Choice on the Tools menu.
Modifying Source Analysis

The Source Analysis tab in the Review window shows how the software handled source ambiguities and allows you to override the software selections. Figure 7-10 shows an example of the Source Analysis tab.

Figure 7-10: Example of Source Analysis Tab

To use the Source Analysis tab:

1. If the Review window is not displayed, click the Review button on the SYSTRAN Toolbar:

2. If the Source Analysis tab is not the topmost tab in the Review window, click it to move it to the front.

3. Review the choices on each line. To select a choice, click the radio button in front of it.
4. If you want the software to always handle a choice as shown in the Source Analysis tab, click the checkbox in the left column.

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation:

To reverse a Source Analysis selection, click the selection in the Source Analysis tab, then click Delete Source Ambiguity Choice on the Tools menu.

Another way to improve translations is by reviewing terminology and sentences. Using this feature, you can identify expressions such as Not Found Word that the software found.

**Reviewing Terminology**

The Terminology Review tab in the Review window lets you identify expressions such as Not Found Word or Terminology Extraction that the software found.

For more information, see [Using the Review Button on page 33](#).

You can click the thumb tack ( ) in the Review window to hide this window when you’re not using it (see [Using the STPM and SMTU Workspace on page 35](#)).

**Reviewing Sentences**

The Sentence Review tab in the Review window lets you compare sentences in the source and target. You can then check the sentences you want to send to User Dictionaries, where you can work with them further. This tab is particularly useful if you have identical sentences with different translations and want to specify which translation is preferred. [Figure 7-11 on page 77](#) shows an example of entries in the Sentence Review tab.
To use the Sentence Review tab:

1. If the Review window is not displayed, click the Review button on the SYSTRAN Toolbar:

2. If the Sentence Review tab is not the topmost tab in the Review window, click it to move it to the front.

3. Review the sentences on each line. To send a sentence to a new User Dictionary (UD), click the checkbox to the left of the sentence.

   To select all the sentences in the tab, click Select All at the bottom-left side of the tab.
When you select a sentence in the Sentence Review tab, the corresponding sentence in the source is highlighted.

4. Click the Send to SDM button to send the checked sentences to the appropriate UD:

When the Save As dialog box appears, select a file name for the SYSTRAN Dictionary Manager files and click Save. You can then use SDM to work with the sentences to suit your translation requirements, if necessary (see Chapter 9, Using SYSTRAN Dictionary Manager (SDM)).

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation:

Selecting Translation Options
Another way to improve translations is to review your current translation options and change them as necessary. You can then translate the document again to apply your selections to the translation.

To access translation options, click the Translations Options button on the SYSTRAN Toolbar:

For more information, see Using the Translation Options Button on page 23.

You can click the thumb tack ( ) in the Translation Options window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

Using User Dictionaries
Another way to improve translations is by using terms stored in User Dictionaries and Translation Memory. To access User Dictionaries and Translation Memory, click the User Dictionaries button on the SYSTRAN Toolbar:

For more information, see Using the Dictionaries Button on page 27.

You can click the thumb tack ( ) in the User Dictionaries window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).
Searching and Highlighting

STPM provides a Search and Highlight button that lets you view particular words and expressions, such as extracted terminology, Not Found Words, words, words with alternative meanings, and words with source ambiguities. By identifying these words, you can take the appropriate steps to improve your translations.

Expressions are color coded to make them easy to locate. The software uses a default color to mark expressions. If desired, you can select a different color from the Search and Highlight window. The Search and Highlight window also provides buttons that let you view all instances of an expression or locate them one at a time. You can even combine these features to show all instances of an expression and locate them one instance at a time.

Figure 7-12 on page 79 shows an example where all Not Found Words are highlighted in the default color of mauve. Figure 7-13 on page 80 shows an example where a Not Found Word is highlighted individually.

You can click the thumb tack ( ) in the Search and Highlight window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

Figure 7-12: Example of Viewing All Not Found Words
To search and highlight words:

1. Click the Search and Highlight button on the SYSTRAN Toolbar:

The Search and Highlight window appears (see Figure 7-14 on page 81). The leftmost column in the Search and Highlight window shows the color used to identify the expression.
2. To locate a particular word, type the word in the field under Word Search; then click either to view all instances of the word or to view individual instances of the word.

Word Search is performed in the currently selected document. If the source document is selected, for example, the word search is conducted in the source document only.

3. For all other expressions, you can:
   
   - View all instances of an expression by clicking the highlight button next to the expression you want to find: 
     To remove the highlight from the expressions, click this button again.
   
   - View individual instances of an expression by clicking the magnifying glass button next to the expression you want to find: 
     Continue to click this button to identify the next instance of the expression. When you reach the last instance of the expression, the highlight moves to the first instance of the expression in the document or Web page.
Performing Miscellaneous STPM Activities

You can perform the following miscellaneous STPM tasks:

- Perform contextual dictionary activities. See Performing Contextual Dictionary Activities on page 82.
- Set DNT blocks. See Specifying DNT Entities on page 83.
- Find expressions in User Dictionaries. See Finding Words and Expressions in User Dictionaries on page 84.
- Edit text. See Editing Text on page 85.
- Format text. See Formatting Text on page 86.
- Navigate between projects in the SYSTRAN Translation Project Manager window. See Navigating between Projects on page 87.
- Save projects. See Saving Projects on page 87.
- Export projects, source files and Web pages, and target files and Web pages. See Exporting Projects, Source Files, and Target Files on page 89.

Performing Contextual Dictionary Activities

Using Send to SDM on the Tools menu, you can send selected words and expressions to a new UD. You can then use the linguistic tools in SDM to access the entries.

1. In the source document, select the word or expression you want to send to the UD.
2. On the Tools menu, point to Send to SDM and click either the name of the dictionary where you want the expressions sent or New Dictionary to send the expressions to a new dictionary. If you click an existing dictionary, that dictionary appears. If you click New Dictionary, the Save As dialog box appears (see Figure 7-15 on page 82).

![Figure 7-15: Save As Dialog Box](Image)
3. Optional: Enter a file name for the UD that will contain the selected word or expression. Then click the Save button.

SDM launches automatically. You can now work with the entries to improve the quality of your translations. For more information, see Chapter 9, Using SYSTRAN Dictionary Manager (SDM).

You can also select an existing dictionary to which you want to send expressions by selecting a dictionary from the dictionary list. The selected dictionary will appear in the contextual menu.

Specifying DNT Entities

STPM provides several Do Not Translate (DNT) commands in the Tools menu and right-click menu that let you designate DNT entities. When you specify an entity as DNT, STPM omits that area from being translated until you remove the DNT designation.

The DNT entities you can specify are:

- Set Expression DNT — a sequence of words (part of a sentence) that is not to be translated. The software’s sentence-analysis capabilities consider the sequence as a single entity and part of the sentence. Typically, proper nouns, such as company names, can be set as DNT expression.

- Set Paragraph DNT — specifies part of a document that is not to be translated. The full area is omitted from the translation process and is not taken into account by the translation. Typically, document headers and addresses are set as DNT paragraph.

- Set Insertion DNT — identifies a sequence of words as an insertion within a complete sentence that is not to be translated. Text to the left and right of the sequence is considered one sentence. Typically, bracketed comments and acronyms are set as DNT insertion.

After you mark DNT areas and translate the document, you can use the Search and Highlight window to locate the DNT expressions, paragraphs, and insertions (see Searching and Highlighting on page 79).

To specify DNT entities:

1. In the source or target document, click the items you want to designate as DNT.

2. Perform one of the following steps:
   - On the Tools menu, click Set Expression DNT, Set Paragraph DNT, or Set Insertion DNT.
   - Press the right mouse button and click Set Expression DNT, Set Paragraph DNT, or Set Insertion DNT.

To remove a DNT designation from an entity:

1. Click the entity whose DNT designation you want to remove.

You can use the Do Not Translate options in the Search and Highlight window to identify all DNT blocks, as well as expression, paragraph, and insertion DNTs (see Searching and Highlighting on page 79).
2. Perform one of the following steps:
   - On the Tools menu, click Delete DNT Block.
   - Press the right mouse button and click Delete DNT Block.

Finding Words and Expressions in User Dictionaries

There may be times when you want to view other instances of a word or phrase in the current dictionary or another dictionary. To simplify this procedure, STPM provides a search feature that lets you locate words or phrases in local dictionaries as well as SYSTRAN Online dictionaries.

1. In the source or target document, select the word or expression you want to find.
2. On the Tools menu, click Find in Dictionaries. SDM launches automatically and the Find dialog box appears, with the selected word or expression shown next to Find What (see Figure 7-16).

![Figure 7-16: Find Dialog Box](image)

3. To change or revise the word or expression to be found, edit it next to Find what.
4. Next to Find where, specify the location where the search is to take place.
5. Under Search options, click any options you want to specify for this search (see Table 7-2 on page 85).
6. Click the Find button. SDM locates all instances of the word or phrase in the location specified that match the search options and displays the results at the bottom of the Find dialog box.
7. To go to one of the found words or expressions, double-click the word or expression at the bottom of the Find dialog box.
Editing Text

You can edit the source and target documents as necessary to improve your translations. For example, you may have used the Search and Highlight window to identify source ambiguities and decide to change an expression in the source document to see how it impacts the translation.

The editing activities you can perform include:

- **Adding Text**
  You can add text to the source or target document by clicking in the desired area of the document and typing the new text.

- **Delete Text**
  You can delete text from the source or target document by clicking in the document and pressing either the Backspace to delete the text to the left of the cursor or the Delete key to delete the text to the right of the cursor. You can also delete large areas of text by selecting the areas and pressing the Delete key, clicking Cut on the Edit menu, or clicking the Cut button:

- **Move Text**
  You can move text by clicking within the source or target document by clicking the text and dragging it to another location. You can even drag text between the source and target documents.

After you perform these tasks, you can click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation.
**Formatting Text**

STPM provides a Format toolbar that lets you change the look and feel of text in the source and target documents.

The translation uses formatting information to identify the nature of different parts of a document. As a result, the better your text is formatted, the better the translation will be.

To change the text format in these documents, click the text, then click the appropriate button in the format toolbar (see **Figure 7-17**).

![Figure 7-17: STPM Format Toolbar](image)
Navigating between Projects
You can have more than one STPM project open at a time. STPM provides a number of ways to navigate between projects:

- Click a project tab in the STPM window (see Figure 7-18).
- Click the name of an open project on the Window menu.
- Click the left or right project-navigation arrow (see Figure 7-18).

![Figure 7-18: Controls for Navigating Between and Closing Projects](image)

Saving Projects
When you finish working with a project, save it. Saving a project saves the work you performed in the project and allows you to open the project in the future.

1. Perform one of the following steps:
   - On the File menu, click Save Project.
   - Click the Save Project button on the SYSTRAN Toolbar:

   If this is the first time you are saving the project, the Save As dialog box appears (see Figure 7-19 on page 88).
2. Optional: To save the project in a different location, navigate to the location where you want to save it.

3. Next to File name, type a name for the project file.

4. Click the Save button.

If you have already saved the project, you can use the Save Project As command on the File menu to save it under a different name or in a different location.

If you try to close a project without saving it, a message prompts you to save the project.
Exporting Projects, Source Files, and Target Files

STPM provides export capabilities for exporting project files, source files and Web pages, and target files and Web pages.

Exporting Projects

To export projects from STPM:

1. If you have more than one project open, be sure the project you want to export is the topmost project.
2. On the File menu, click Export Project. The Save As dialog box appears (see Figure 7-20).

3. Optional: To save the project in a different location, navigate to the location where you want to save it.
4. Next to File name, type a name for the project.
5. Click the Save button.
Exporting Source Files or Web Pages

To export a source file or Web page from STPM:

1. If you have more than one project open, be sure the source file or Web page you want to export is the topmost project.

2. On the File menu, click Export Source. The Save As dialog box appears (see Figure 7-21).

3. Optional: To save the file in a different location, navigate to the location where you want to save it.

4. Next to File name, type a name for the source file.

5. For Save as type, indicate whether the file is to be saved as an HTML file (.html and .htm), text file (.txt), Microsoft Word document, or rich text format (.rtf).

6. Click the Save button.
Exporting Target Files or Web Pages

To export a target file or Web page from STPM:

1. If you have more than one project open, be sure the target file or Web page you want to export is the topmost project.

2. On the File menu, click Export Target. The Save As dialog box appears (see Figure 7-22).

3. Optional: To save the file in a different location, navigate to the location where you want to save it.

4. Next to File name, type a name for the source file.

5. For Save as type, indicate whether the file is to be saved as an HTML file (.html and .htm), text file (.txt), Microsoft Word document, or rich text format (.rtf).

6. Click the Save button.
Chapter 8: Using SYSTRAN MultiTranslate Utility (SMTU)

Understanding Batch Files  93
Launching SMTU  94
  Displaying or Hiding SMTU Toolbars  95
Using SMTU  96
  Opening a Batch File  96
  Opening a New Batch File  97
  Opening an Existing Batch File  98
Adding Files, Folders, and Web Pages  98
  Adding Files  98
  Adding Folders  99
  Adding Web Pages  100
Arranging Items in the Batch File  101
Translating Batch File Contents  102
Customizing Translations  103
  Viewing Source and Target Documents  103
  Selecting Translation Options  104
  Using User Dictionaries  104
  Using SMTU’s Review Feature  105
Performing Miscellaneous SMTU Activities  105
  Specifying Batch Entry Options  105
  Navigating between Batch Files  109
  Saving the Project  109
  Closing Batch Files  110
  Using the SMTU Command Line Interface  111
Using SYSTRAN MultiTranslate Utility (SMTU)

SYSTRAN MultiTranslate Utility (SMTU) is supported by:

✔ SYSTRAN Professional Premium

The SYSTRAN MultiTranslate Utility (SMTU) lets you translate groups (or “batches”) of documents at one time. The types of document you can add to batches are TXT, RTF, DOC, HTML, XHTML, PPT, XLS, PDF, and TMX-formatted files. SMTU has a progress indicator that provides a visual indication of the translation and shows the time required to perform each translation.

SMTU also lets you translate Web documents by specifying the Web page's URL. SMTU provides a “Web crawler” that lets you extract and translate the content of a website.

For users who prefer command-line interfaces (CLIs), SMTU provides a CLI for automating the translation process. To optimize translations, SMTU lets you specify general and document-specific translation options. It also provides Terminology Extraction and Not Found Word review aggregation capabilities for any user-defined set of documents.

Understanding Batch Files

Batch files consist of files, Web pages, and folders that you want translated at the same time. Batch files are useful for translating multiple files, Web pages, and folders because you can translate all of these items simply by translating the batch file that contains them, instead of translating them individually.

Batch files follow a “tree” hierarchy, much like Windows Explorer. The “root” (or “parent”) directory is the batch file itself. The batch file contents are one level below the root. If the batch file contains a folder, the contents of that folder are one level below the batch file contents.

When you select Translation Options, User Dictionaries, Review, and Batch Entry options for your translations, you can assign them at the batch level, folder level, or individual file level.

- If you apply them to the batch file, the settings are inherited by all the items in the batch file.
- If you apply them to a folder, the settings are inherited by all of the items (files and subfolders) in the folder.
- You can click individual files in the batch file or in a folder and change the settings for the selected files only.

Similarly, when Web pages are loaded into SMTU, you can set Batch Entry options to have crawled pages inherit their settings from the root page.

For additional control, you can use Batch Entry options to have settings for a file, Web page, or folder be inherited from a parent. For example, you can specify whether the destination where a file will reside is inherited from its parent. Similarly, for a Web page, you can specify whether the crawl URL and depth are inherited from the parent Web page. For more information, see Specifying Batch Entry Options on page 105.
Launching SMTU

To launch SMTU:

1. Perform one of the following steps:
   a. Double-click the SYSTRAN MultiTranslate Utility icon on your desktop.
   b. Click the Start button on the Windows Taskbar, point to Programs, point to SYSTRAN 5.0, and click SYSTRAN MultiTranslate Utility.

Either step displays the SYSTRAN MultiTranslate Utility window. Figure 8-1 shows the components in this window and Table 8-1 on page 94 describes them.

Figure 8-1: Components of the SYSTRAN MultiTranslate Utility Window

Table 8-1: SYSTRAN MultiTranslate Utility Window Components

<table>
<thead>
<tr>
<th>Screen Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>Contains the name of the application and Windows controls for minimizing, maximizing, and closing the SMTU window and application.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>Contains the SMTU menus. Each menu has a list of commands you can click to perform various SMTU activities. See SMTU Menus and Commands on page 159.</td>
</tr>
<tr>
<td>Standard Toolbar</td>
<td>Provides buttons for commonly used SMTU commands. See Standard Toolbar (SMTU) on page 161.</td>
</tr>
</tbody>
</table>
Displaying or Hiding SMTU Toolbars

By default, all SMTU toolbars are displayed. If you will not be using certain functions, you may want to hide the toolbar for those functions to reduce the items on your screen.

To hide or display SMTU toolbars:

1. Move the pointer to the SMTU toolbar area.

2. Press the right mouse button. A pop-up menu appears with a list of the SMTU toolbars (see Figure 8-2). A checkmark next to a toolbar name means the toolbar is displayed.

3. To hide a toolbar, click its name to remove the checkmark next to it.

   To display a toolbar that is hidden, click its name so the checkmark appears next to it.
Using SMTU

The following procedure summarizes the steps for using SMTU.

1. Optional: On the File menu, click New Project or click the New Project button on the SYSTRAN Toolbar:

Creating a project is optional, because a new project is created automatically when you create or open a batch file in step 2.

2. Create a new batch file or open one you previously saved. See Opening a Batch File, below.

3. Add the files, folders, and Web pages you want to translate into the batch file. See Adding Files, Folders, and Web Pages on page 98.

4. Order the batch file contents in the appropriate sequence. See Arranging Items in the Batch File on page 101.


6. Optional: Review the translation and improve it if necessary (see Customizing Translations on page 103). Then repeat step 4 to translate again. Repeat steps 4 and 5 as necessary until you achieve the desired results.

7. Save the batch file. See Saving the Project on page 109.

8. Close the batch file. See Closing Batch Files on page 110.

Opening a Batch File

The first step in using SMTU is to open a batch file. This can be either a new batch file or one you previously opened and saved using SMTU.

- To open a new batch file, see Opening a New Batch File, below.

- To open a batch file you previously saved, see Opening an Existing Batch File on page 98.

You can have more than one batch file open in your SMTU session. You can then use the controls on the right side of the batch file to navigate between them (see Navigating between Batch Files on page 109).
**Opening a New Batch File**

To open a new batch file:

1. Perform one of the following steps:
   - On the File menu, click New Project.
   - OR
   - Click the New Project icon:

   Either step displays a new batch file in the SYSTRAN MultiTranslate Utility window (see *Figure 8-3*). Batch files are numbered sequentially, starting with 1, until you save them.

2. Use the procedure under *Adding Files, Folders, and Web Pages on page 98* to add files, folders, and Web pages to the batch file.

![Figure 8-3: Example of an Untitled Batch File in the SMTU Window](image-url)
Opening an Existing Batch File

To open an existing batch file:

1. Perform one of the following steps:
   - On the File menu, click Open Project.
     OR
   - Click the Open Project icon:
     📝

     Either step displays the Open dialog box (see Figure 8-4 on page 99).

2. Navigate to the location where the batch file you want to open resides.

3. Click the batch file and click the Open button. The selected batch file opens, with the files and folders that were in the batch file when you last saved it.

4. Optional: If desired, you can:
   - Add files, folders, and Web pages to the batch file (see Adding Files, Folders, and Web Pages on page 98).
   - Rearrange the order of the items in the batch file (see Arranging Items in the Batch File on page 101).
   - Delete items from the batch file (see Table 8-2 on page 102).

Adding Files, Folders, and Web Pages

After you open a batch file, add the files, folders, and Web pages you want to translate.

Adding Files

To add files to the batch:

1. Perform one of the following steps:
   - On the Batch menu, click Add File to Batch.
     OR
   - Click the Add File to Batch button:
     💌

     Either step displays the Open dialog box (see Figure 8-4).
2. Locate the file you want to add to the batch, then click it and click the Open button to add it to the batch file. The path where the file resides appears, along with the destination where the translated file will be placed and the size of the file.

As a shortcut, you can double-click a file in the Open dialog box to add it to the batch.

3. To add more files, repeat steps 1 and 2.

The following shortcuts are available for adding multiple files from the Open dialog box:

- To add contiguous files, click the first file you want to add. Then hold down the Shift key and click the last file you want to add. All files between the first and second files you clicked are selected.
- To add multiple files that are not contiguous, click the first file. Then hold down the Ctrl key and click each additional file you want to add.

Once the files are selected, click Open.

**Adding Folders**

The following procedure describes how to add folders to the batch. When you add a folder, all the files in the folder that correspond to file type options will be translated. Recursive with "include subfolders" option:

1. Perform one of the following steps:
   - On the Batch menu, click Add Folder to Batch.
     OR
Click the Add Folder to Batch button:

Either step displays the Browse for Folder dialog box (see Figure 8-5).

Figure 8-5: Browse for Folder Dialog Box

2. Locate the folder you want to add to the batch, then click it and click the Open button to add it to the batch file. The path where the folder resides appears, along with the destination where the translated file will be placed.

3. To add more folders, repeat steps 1 and 2.

The Browse for Folder dialog box has a Make New Folder button that lets you create new folders.

Adding Web Pages
To add Web pages to the batch file:

1. In the address field of the URL Toolbar, enter the Web address (URL) of the Web page you want to add to the batch file.

2. Click the Add to Batch button:

The Web page is added to the batch file. The path where the Web page resides appears, along with the destination where the translated page will be placed.

3. To add more Web pages, repeat steps 1 and 2.
Arranging Items in the Batch File

Files, folders, and Web pages in a batch file are translated starting with the topmost item in the file and working down. In Figure 8-6, for example, the Word document 215 Years Ago.doc is translated first, followed by the webpage systransoft.com, the contents of the Log Books folder, and the Word document AT&T.doc. Similarly, the files in a folder are translated according to their order in the folder, starting with the top item.

If desired, you can change the order of items in the batch file or folder to change the sequence in which they are translated. Just click an item in the batch file or folder, then use the commands on the Batch menu or the buttons on the Batch Toolbar to move the selected item up or down. You can even remove the selected item from the batch file or folder if you do not want to translate it.

Table 8-2 on page 102 lists the commands and buttons for changing the order of items in a batch file or folder.

To view the contents of a folder in a batch file, click the plus sign to the left of the folder name. Files in a folder cannot be moved outside the folder.

Figure 8-6: Example of Batch File Contents
Translating Batch File Contents

After you add files, folders, and Web pages to the batch file, use the following procedure to translate the contents of the batch file.

1. Use the Source Language drop-down list to select a source language (see Using the Source Language Drop-Down List on page 22).

2. Use the Target Language drop-down list to select a target language (see Using the Target Language Drop-Down List on page 23).

3. Click the Translate button on the SYSTRAN Toolbar:

   and select the appropriate command from the drop-down list (see Figure 8-7):
   
   - Translate Batch — translates all the items in the batch file.
   - Translate All Untranslated Entries — translates all entries that have not been translated.
   - Translate Selected Entries — translates only the entries you select in the batch file. Before you use this command, select the items in the batch file that you want to translate:

   If the items are contiguous, click the first item you want to translate; then hold down the Shift key and click the last item you want to translate. All items between the two are selected automatically.

   If the items are not contiguous, click the first item you want to translate; then hold down the Ctrl key and click each additional item you want to translate.

Table 8-2: Commands and Buttons for Arranging Items in a Batch File or Folder

<table>
<thead>
<tr>
<th>Batch File Command</th>
<th>Batch Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove From Batch</td>
<td>X</td>
<td>Deletes the selected item from the batch file.</td>
</tr>
<tr>
<td>Move Up</td>
<td>↑</td>
<td>Moves an item up in the batch file.</td>
</tr>
<tr>
<td>Move Down</td>
<td>↓</td>
<td>Moves an item down in the batch file.</td>
</tr>
</tbody>
</table>

Figure 8-7: Commands from the Translate Button Drop-down List
When you select a command from the Translate button, the Status column shows the status of the translations. After an item has been translated, its status changes to Complete.

The Batch Entry options may be configured to prevent certain file types from being translated. For more information, see Specifying Batch Entry Options on page 105.

Customizing Translations
After you translate a batch file, you can perform the following activities to customize your translations:

- Viewing Source and Target Documents, below
- Selecting Translation Options on page 104
- Using User Dictionaries on page 104
- Using SMTU’s Review Feature on page 105

Viewing Source and Target Documents
The Batch menu provides commands for viewing source and target documents in the batch file. You can view source documents either before or after they are translated. Translated documents can only be accessed after they have been translated.

When you open a source or translated document, the document opens in its native application. If you open a Word document that has been translated, for example, SMTU automatically launches Word (if the application is not open) and displays the translated document. Similarly, if you open a source Web page, SMTU launches your default browser and displays the Web page.

To view documents:

1. In the batch file, click the item you want to open.

   You can only select one file, folder, or Web page at a time.

2. Perform one of the following steps:

   - View the source version of the selected item: on the Batch menu, click Open Source Document.
   - View the translated version of the selected item: on the Batch menu, click Open Target Document.
   - View the selected item in STPM: on the Batch menu, click Open in Project Manager.

If you clicked a folder in step 1, Windows Explorer displays the folder where the translated source or translated files appear.
Selecting Translation Options

One way to customize translations is to review your current translation options and change them as necessary. You can then translate the document, spreadsheet, presentation, or email again to apply your selections to the translation.

To access translation options, click theTranslations Options button on the SYSTRAN Toolbar:

By default, translation options are applied to the entire batch file. To apply them to selected files, folders, and Web pages, select the files, folders, and Web pages to which the options will be applied. For more information, see Understanding Batch Files on page 93.

To select contiguous items in the batch file, click the first item, then hold down the Shift key and click the last item you want to select; all items between the two you clicked are selected. To select non contiguous items, click the first item; then hold down the Ctrl key and click each additional item you want to select.

For more information, see Using the Translation Options Button on page 23.

You can click the thumb tack ( ) in the Translation Options window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

Using User Dictionaries

Another way to customize translations is by using terms stored in User Dictionaries and Translation Memory. To access User Dictionaries and Translation Memory, click theUser Dictionaries button on the SYSTRAN Toolbar:

By default, User Dictionaries are applied to the entire batch file. To apply them to selected files, folders, and Web pages, select those items in the batch file. For more information, see Using the Dictionaries Button on page 27.

To select contiguous items in the batch file, click the first item, then hold down the Shift key and click the last item you want to select; all items between the two you clicked are selected. To select non contiguous items, click the first item; then hold down the Ctrl key and click each additional item you want to select.

You can click the thumb tack ( ) in the User Dictionaries window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

If two or more items selected in the batch have different User Dictionary settings, the User Dictionaries window becomes blank. Any settings you specify will be applied to the selected items.
Using SMTU’s Review Feature

Another way to customize batch translations is by using SMTU’s Review feature. Using this feature, you can identify expressions such as Not Found Word or Terminology Extraction that the software found. For more information, see Using the Review Button on page 33.

If two or more items selected in the batch have different Terminology Review settings, the Terminology Review tab becomes blank. Any settings you specify will be applied to the selected items.

You can click the thumb tack ( ) in the Review window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

Performing Miscellaneous SMTU Activities

You can perform the following miscellaneous SMTU tasks:

- Select batch entry options. See Specifying Batch Entry Options, below.
- Navigate between batch files. See Navigating between Batch Files on page 109.
- Save batch file information. See Saving the Project on page 109.
- Close batch files. See Closing Batch Files on page 110.
- Use the SMTU command-line interface. See Using the SMTU Command Line Interface on page 111.

Specifying Batch Entry Options

SMTU provides a Batch Entries Option button that lets you specify crawl, file type, and miscellaneous options for batch files. These options can be applied to the entire batch file, selected folders, or selected file.

To specify batch entry options:

1. Perform one of the following steps:
   - On the View menu, click Batch Entry Options.
   - OR
   - Click the Batch Entry Options button on the SYSTRAN Toolbar:

   Either step displays the Batch Entry Options window (see Figure 8-8 on page 106).

2. By default, Batch Entry Options are applied to the entire batch file. To apply them to selected files, folders, and Web pages, select the files, folders, and Web pages to which the options will be applied. For more information, see Understanding Batch Files on page 93.

To select contiguous items in the batch file, click the first item, then hold down the Shift key and click the last item you want to select; all items between the two you clicked are selected. To select non-contiguous items, click the first item; then hold down the Ctrl key and click each additional item you want to select.
3. Select the appropriate options in the Batch Entry Options window (see Table 8-3 on page 107).

4. Click OK.

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections to the translation:

![Batch Entry Options Window](image)

**Figure 8-8: Batch Entry Options Window**

You can click the thumb tack ( ) in the Batch Entry Options window to hide the window when you’re not using it (see Using the STPM and SMTU Workspace on page 35).

If two or more items selected in the batch have different Batch Entry Option settings, the selections in the Batch Entry Options window becomes blank. Any settings you specify will be applied to the selected items.
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Misc</td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td>Specifies the location where the translated documents will reside.</td>
</tr>
<tr>
<td></td>
<td>Inherit = inherits the same path of its parent.</td>
</tr>
<tr>
<td></td>
<td>Browse = lets you select the location where the translated document will be saved.</td>
</tr>
<tr>
<td>Generate STPM Data</td>
<td>Specifies whether SMTU generates data for STPM.</td>
</tr>
<tr>
<td></td>
<td>Yes = generate data for STPM.</td>
</tr>
<tr>
<td></td>
<td>No = do not generate data for STPM.</td>
</tr>
<tr>
<td>Include Subfolders</td>
<td>Specifies the path where the target file will be saved.</td>
</tr>
<tr>
<td></td>
<td>Inherit = inherits the same path of its parent.</td>
</tr>
<tr>
<td></td>
<td>Browse = lets you select the location where the file will be saved.</td>
</tr>
<tr>
<td>Crawl Options</td>
<td></td>
</tr>
<tr>
<td>Crawl URL</td>
<td>Allows SMTU to crawl Web pages.</td>
</tr>
<tr>
<td></td>
<td>Inherit = inherits the same setting as its parent.</td>
</tr>
<tr>
<td></td>
<td>Yes = allows crawling.</td>
</tr>
<tr>
<td></td>
<td>No = prevents crawling.</td>
</tr>
<tr>
<td>Crawl Depth</td>
<td>If Crawl URL is enabled, specifies the crawl depth (from 0 to 5).</td>
</tr>
<tr>
<td>Only Crawl Within Domain</td>
<td>Determines whether crawling is limited to the Web page’s domain.</td>
</tr>
<tr>
<td></td>
<td>Inherit = inherits the same setting as its parent.</td>
</tr>
<tr>
<td></td>
<td>Yes = restricts crawling to the domain.</td>
</tr>
<tr>
<td></td>
<td>No = does not restrict crawling to the domain.</td>
</tr>
<tr>
<td>Change Links</td>
<td>Changes the links to point to the translated local version.</td>
</tr>
<tr>
<td></td>
<td>Inherit = inherits the same setting as its parent.</td>
</tr>
<tr>
<td></td>
<td>Yes = change the links.</td>
</tr>
<tr>
<td></td>
<td>No = does not change the links.</td>
</tr>
<tr>
<td>File Types</td>
<td></td>
</tr>
<tr>
<td>HTML (.htm, .html)</td>
<td>Allows or prevents translation of HTML pages ending with the extension .htm or .html.</td>
</tr>
<tr>
<td></td>
<td>Yes = allows translation of HTML pages.</td>
</tr>
<tr>
<td></td>
<td>No = prevents translation of HTML pages.</td>
</tr>
<tr>
<td>Text (.txt)</td>
<td>Allows or prevents translation of text files ending with the extension .txt.</td>
</tr>
<tr>
<td></td>
<td>Yes = allows translation of text pages.</td>
</tr>
<tr>
<td></td>
<td>No = prevents translation of text pages.</td>
</tr>
</tbody>
</table>
Table 8-3: Options in the Batch Entry Options Window (Continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
</table>
| Rich Text Format (.rtf)               | Allows or prevents translation of Rich Text Format (RTF) files ending with the extension .rtf.  
|                                       | Yes = allows translation of RTF files.                                      |
|                                       | No = prevents translation of RTF files.                                     |
| Microsoft Word (.doc)                 | Allows or prevents translation of Microsoft Word files ending with the extension .doc.  
|                                       | Yes = allows translation of Word documents.                                |
|                                       | No = prevents translation of Word documents.                               |
| Microsoft Excel (.xls)                | Allows or prevents translation of Excel spreadsheet files ending with the extension .xls.  
|                                       | Yes = allows translation of Excel files.                                   |
|                                       | No = prevents translation of Excel files.                                  |
| Microsoft Powerpoint (.ppt)          | Allows or prevents translation of Microsoft PowerPoint presentations ending with the extension .ppt.  
|                                       | Yes = allows translation of PowerPoint presentations.                      |
|                                       | No = prevents translation of PowerPoint presentations.                     |
| Adobe Portable Document Format (.pdf) | Allows or prevents translation of Adobe Portable Document Format files ending with the extension .pdf.  
|                                       | Yes = allows translation of Adobe PDF files.                              |
|                                       | No = prevents translation of Adobe PDF files.                             |
| Translation Memory eXchange           | Allows or prevents accessing of terms from Translation Memory files that end with the extension .tmx.  
|                                       | Yes = allows terms to be accessed from Translation Memory.                |
|                                       | No = prevents terms from being accessed from Translation Memory.          |
| XML (.xml)                            | Allows or prevents translation of Extensible Markup Language (XML) documents ending with the extension .xml.  
|                                       | Yes = allows translation of XML documents.                                |
|                                       | No = prevents translation of XML documents.                               |
Navigating between Batch Files

You can have more than one batch file open at a time. SMTU provides a number of ways to navigate between them:

- Click a batch file tab in the SMTU window (see Figure 8-9 on page 109).
- Click the left or right batch-file navigation arrow (see Figure 8-9 on page 109).

Figure 8-9: Controls for Navigating Between and Closing Batch Files

Saving the Project

When you finish working with a batch file, you can save the project. Saving a project saves information about the batch file; it does not save the files and folders themselves.

1. Perform one of the following steps:
   - On the File menu, click Save Project.
   - Click the Save Project button on the SYSTRAN Toolbar:

If this is the first time you are saving the project, the Save As dialog box appears (see Figure 8-10 on page 110).
2. Optional: To save the project in a different location, navigate to the location where you want to save it.

3. Next to File name, type a name for the batch file.

4. Click the Save button.

If you have already saved the project, you can use the Save Project As command on the File menu to save it under a different name or in a different location.

If you try to close a batch file without saving the project, a message prompts you to save the project.

**Closing Batch Files**

When you finish working in a batch file, click the X to the right of the batch-file navigation arrows to close a batch file (see Figure 8-9 on page 109).

If you want to save your changes to a batch file, save the batch file before you close it (see Saving the Project on page 109). There is no precautionary message that appears when you close a batch file you have not saved. Therefore, be sure you do not need to access an unsaved batch file before you close it.
Using the SMTU Command Line Interface

When you installed SYSTRAN Professional Premium 5.0, the installation installed the executable smtuc.exe in the SYSTRAN root directory (C:/Program Files/SYSTRAN/5.0/premi/). You can use this executable to launch SMTU from a command line and translate batch files. You can also use it to coordinate batch translations with Microsoft Windows Scheduler.

To view the options available with this executable, run smtuc -h to display the following online help:

---
Command-line interface to SYSTRAN MultiTranslate Utility.
Usage: smtuc -t[u] BATCH-FILE OPTIONS
-t BATCH-FILE translate batch
-tu BATCH-FILE translate all untranslated entries
OPTIONS:
-s save the batch file after translation
-sa FILE save batch to a different file after translation
only one -s or -sa is recognized
-v (verbose) explains what is being done
---

CLI Examples

In the following example, SMTU translates all untranslated entries in the SYSTRAN batch file project called My File.sba, located on C:\My Batch Files and saves the batch file after translation.

smtuc -tu "C:\My Batch Files\My File.sba" -s

In the following example, SMTU translates all untranslated entries in the SYSTRAN batch file project called Site.sba, located on C:\My Batch Files and saves the results in the project called Site_01.sba located on C:\My Batch Files.

smtuc -t "C:\My Batch Files\Site.sba" -sa "C:\My Batch Files\Site_01.sba"

Using the CLI to Schedule a Translation Job

The CLI can be used with Microsoft Windows Scheduler to schedule batch-file translations. Windows Scheduler typically is accessed by:

1. Clicking the Start button.
3. Clicking Scheduled Tasks.
4. When Windows Scheduler starts, add a new scheduled task.
5. Double-click the new task. When the New Task dialog box appears, select smtuc.exe as the program to run.
6. For Run as, append the arguments you want to pass to the smtuc.exe path.
7. Click the OK button to exit the dialog box.
Chapter 9:
Using SYSTRAN Dictionary Manager (SDM)

Overview 113
  User Dictionaries (UDs) 113
  Normalization Dictionaries (NDs) 113
  Translation Memories (TMs) 114
Launching SDM 114
  Displaying or Hiding SDM Toolbars 115
Managing a Dictionary or Translation Memory 115
  Creating a New Project 116
Working with User Dictionary Entries 125
  Adding Words and Phrases 125
  Inserting Words or Phrases into a User Dictionary 126
  Removing Words and Phrases from a User Dictionary 127
  Checking the Confidence Level of User Dictionary Entries 127
Editing User Dictionary Entries 129
  Changing Entry Types 130
Coding User Dictionary Entries 130
Using Expert Coding 131
Sorting Language Columns 134
Marking Headwords 135
Using Textual Lookup Operators 135
Finding Entries 138
Reversing Entries in User Dictionaries 140
Examples of Using Reverse Entries 140
Procedure for Reversing Entries in a User Dictionary 141
Working with Dictionaries 141
  Viewing and Changing Dictionary Properties 141
  Importing Files into a User Dictionary 142
  Exporting Files 143
Using Intuitive Coding to Build High-Quality Dictionaries 144
Using SYSTRAN Dictionary Manager (SDM)

SYSTRAN Dictionary Manager (SDM) is supported by:
✔ SYSTRAN Personal (supports Basic version)
✔ SYSTRAN Office Translator (supports Basic version)
✔ SYSTRAN Professional Standard (supports Advanced version)
✔ SYSTRAN Professional Premium (supports Expert version)

This chapter describes the Expert version of SDM. You may not be able to use all these features if you have the Basic or Advanced version. For a complete description of the features supported by each SDM version, see SYSTRAN Dictionary Manager (SDM) on page 19.

SYSTRAN Dictionary Manager (SDM) lets you build, create, and maintain User Dictionaries (UDs), Translation Memories (TMs), and Normalization Dictionaries (NDs). These dictionaries are used in other SYSTRAN 5.0 applications to customize your translations.

SDM offers significant advantages, including:
- SYSTRAN's unique Intuitive Coding™ technology
- Vast data importation capability
- Fine-tuning tools for dictionary entries
- An extensive group of linguistic tools for improving coding quality, from simple Intuitive Coding™ to Expert Coding

Overview

The following sections describe UDs, TMs, and NDs.

User Dictionaries (UDs)

User Dictionaries (UDs) let you increase the quality of source language analyses, which also increases the translation output for all associated target languages. UDs can be used for a number of functions, including:
- Automatically translating Not Found Words in the SYSTRAN dictionary.
- Overriding the target-language meaning of a word or expression in the SYSTRAN dictionaries, a capability that lets you customize translation output to fit specific needs.
- Ensuring that an expression is always treated as a unit by SYSTRAN analysis programs. (For SDM, an expression is a group of words with no verb.)

Normalization Dictionaries (NDs)

There are two types of Normalization Dictionaries (NDs): source normalization and target normalization.

Source normalization normalizes source document before translation. It can be used to:
- Make consistent use of terminology in the source document: it is for instance possible to define that “colour” should be normalized to “color” as well as its inflected forms.
Expand languages “shortcuts.” In email language or chats, for example, “4u” can be normalized to “for you” before translation, so that it is correctly processed by translation engine.

Target normalization adapts translation output to user needs in terms of terminology consistency. It can also provide a way to replace expressions chosen by the software’s translation engine with user-defined expressions.

NDs are the perfect complement to UDs, allowing you to reduce size and redundancy of UDs.

**Translation Memories (TMs)**

Translation Memories (TMs) are databases of aligned pre-translated sentences. Unlike Dictionaries, TM entries can be formatted (for example, italic or bold) and are used by the translation engine to perform matches on full sentences in the source document. TMs are not usually created manually, but are built using SYSTRAN’s Translation Project Export or from TMX files.

**Launching SDM**

To launch SDM, perform one of the following steps:

- Double-click the SYSTRAN Dictionary Manager icon on your desktop.
- Click the Start button on the Windows Taskbar, point to Programs, point to SYSTRAN 5.0, and click SYSTRAN Dictionary Manager.

Either step displays the SYSTRAN Dictionary Manager window appears. Figure 9-1 on page 114 shows the components in this window and Table 9-1 on page 115 describes them.

SDM can also be launched from STPM or SMTU by clicking the button in those applications.

![SYSTRAN Dictionary Manager Window](image)
Displaying or Hiding SDM Toolbars

By default, all SDM toolbars are displayed. If you will not be using certain functions, you may want to hide the toolbar for those functions to reduce the items on your screen.

To hide or display SDM toolbars:

1. On the View menu, point to Toolbars. A list of toolbars appears (see Figure 9-2 on page 115). A checkmark next to a toolbar name means the toolbar is displayed.

   ![SDM Toolbar](image)
   
   Figure 9-2: SDM Toolbar

2. To hide a toolbar, click its name to remove the checkmark next to it.

3. To display a toolbar that is hidden, click its name so the checkmark appears next to it.
Managing a Dictionary or Translation Memory

The following sections provide a step-by-step process of managing UDs and NDs. The same procedure applies for TMs.

For UDs and TMs, entries consist of words and expressions in the source and target languages. For NDs, the target language is the source language and appears as a “Normalized” column in the dictionary view. Dictionaries can be configured for grammatical, confidence indicators, comments, and other terminological characteristics.

Each dictionary is associated with the concept of Domains. Domains are dynamic contextual terminology specifications. There are two types of Domains associated with UDs, system domains and custom domains.

- System domains are bundled into SDM.
- Custom domains are created by the person who creates the dictionary.

The following procedure summarizes the steps for creating a new UD or ND:

1. Create a new project and define its properties. See Creating a New Project, below.
2. Populate the UD, TM, or ND with words and phrases.
3. Work with entries, if necessary.
4. Perform additional dictionary activities, if necessary. See Working with Dictionaries on page 141.

Before proceeding, we recommend you read Using Intuitive Coding™ to Build High-Quality Dictionaries on page 144 to learn how to build high-quality UDs and NDs.

Creating a New Project

The first step in creating a UD, TM, or ND is to create a new project. During this procedure, you specify the properties for your UD, TM, or ND.

1. Perform one of the following steps:
   - On the File menu, point to New and click Dictionary Project, TM Project, or Normalization Project.
   - Click the down arrow to the right of the New button on the SYSTRAN toolbar and click Dictionary Project, TM Project, or Normalization Project.

Either step displays a properties dialog box similar to the one in Figure 9-3 on page 117, with the Languages tab shown.

The figures in the following steps show the Dictionary Properties dialog box associated with a UD. If you selected a TM or ND, the dialog box properties will vary slightly from those in the Dictionary Properties dialog box.
2. Use the tabs in the dialog box to specify the properties for your UD, TM, or ND. Proceed to Completing the Languages Tab on page 118.
Completing the Languages Tab

The first tab you complete when creating a new dictionary is the Languages tab. This tab lets you select the source and target languages and the informational columns you want to view in your dictionary.

1. Using the drop-down list in the top-right corner, select a source language (see Figure 9-4). All other available languages appear below Available languages.

Figure 9-4: Selecting a Source Language from the Drop-down List

If only one language pair is installed, the target language appears automatically below Visible Columns; double-click the language to move it below Available Languages.

2. Select a target language below Available Languages.

3. Informational Columns lets you select the columns of information you want to include alongside the language columns in a dictionary. Select a column under Informational Columns and click the following button to move the column under Visible columns:

For more information about these columns, see Table 9-2 on page 120.

4. To add more informational columns, repeat the previous step. If you change your mind about a column, click it under Visible columns and click the following button to move the column back below Informational Columns:
5. After you add the informational columns, arrange the order of their importance. The higher the informational column, the greater its priority.
   - To move an informational column up in order, click it under Visible columns and click the following button:

   ![Up button]

   - To move an informational column down in order, click it under Visible columns and click the following button:

   ![Down button]

6. The software assigns an incremental number to track every dictionary entry. To view these numbers, click Show ID.

7. The software provides a visual indication of whether the coding for an entry was successful. To enable this feature, click Show Coding Status.

8. Click the OK button. The message in Figure 9-5 appears.

![Figure 9-5: Information Message]

9. Click OK to remove the message. The Properties tab in the Dictionary Properties dialog box appears (see Figure 9-7 on page 121).

10. Proceed to Completing the Properties Tab on page 121.

![Figure 9-6: Example of Selecting Values from a Drop-down List]
Table 9-2: Informational Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Shows the part of speech (noun, verb, adjective, and so on) associated with the words or phrase. To change the category, click it, choose another one from the drop-down list and click the checkmark in the top-right corner (see Figure 9-6).</td>
</tr>
<tr>
<td>Comment</td>
<td>Provides a column where you can type comments about a word or phrase.</td>
</tr>
<tr>
<td>Confidence</td>
<td>A read-only column that displays a graded, 5-bar color-coded that automatically evaluates the coding quality of the entry. The measurement is the result of a matching made against the SYSTRAN’s Linguistic Resources database. The more bars that are illuminated, the greater the level of confidence. For more information, see <a href="#">Editing User Dictionary Entries</a>.</td>
</tr>
<tr>
<td>Domain</td>
<td>Shows the domain(s) applied to a word or phrase (a domain is a dynamic terminology specification). To change the selection shown, click it, choose another one from the drop-down list and click the checkmark in the top-right corner (similar to the one in Figure 9-6).</td>
</tr>
<tr>
<td>Example</td>
<td>Provides a column where you can type an example of using the word or phrase.</td>
</tr>
<tr>
<td>Frequency</td>
<td>A read-only column that shows the number of times a word, expression, or sentence occurs in a document.</td>
</tr>
<tr>
<td>Priority</td>
<td>Lets you specify how the User Dictionary (UD) interacts with the SYSTRAN Main Dictionary. The highest priority is 1 and gives total priority to UD entries over the Main Dictionary. The default priority is 4. To change the default setting, choose another one from the drop-down list, and click the checkmark in the top-right corner (similar to the one in Figure 9-6). For a description of the priorities, see Table 9-3 on page 120.</td>
</tr>
</tbody>
</table>

Table 9-3: Dictionary Priorities

<table>
<thead>
<tr>
<th>Priority</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The entry has precedence over any other rules (internal rules in the software or longer main dictionary expressions). Main dictionary homographs are not preserved</td>
<td>Lets you guarantee that a UD entry will match. Use higher priority carefully, since it can degrade the main translation by hiding grammatical words, common expressions, or common homographs. For example, adding “a can” in a UD degrades any sentence containing the modal “can”.</td>
</tr>
<tr>
<td>2</td>
<td>The entry has precedence over longer expressions from the main dictionary, but not over grammatical words (the ones only ruled out by the priority 1).</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The entry has no precedence over longer expressions in the main dictionary nor grammatical rules. Homographs from the main dictionary are not preserved.</td>
<td></td>
</tr>
</tbody>
</table>
Completing the Properties Tab

The Properties tab lets you specify various properties for the dictionary you are creating.

Table 9-3: Dictionary Priorities

<table>
<thead>
<tr>
<th>Priority</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>The entry has no precedence over longer expressions or grammatical rules and homographs from main dictionary are preserved.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>The entry will fire only if there is no such entries in the main dictionary.</td>
<td>Coding entry with this priority ensure not to degrade normal translation, and will only impact not found words.</td>
</tr>
<tr>
<td>6</td>
<td>The entry will not fire but will show as alternative meaning during translation</td>
<td>Useful for building an alternative-meanings dictionary without degrading core-translation quality.</td>
</tr>
<tr>
<td>7</td>
<td>The entry will not be fired.</td>
<td>Used for “lookup operator find” dictionary tasks. See Using Textual Lookup Operators on page 135.</td>
</tr>
</tbody>
</table>

1. For Friendly name, type the name that will be displayed when selecting the dictionary for a translation (see Working with SYSTRAN Dictionaries and Domains on page 28). We recommend you...
assign a name that is as explicit as possible for the dictionary content and origin (for example, “Jazz and Blues dictionary”).

The language supported by the dictionary automatically appears in another field. Therefore, you do not have to enter the language as part of the friendly name.

2. For Author, type the name of the dictionary’s creator or owner.

3. For E-mail, type the author’s email address.

4. For Version, enter a number that characterizes the dictionary main version.

The Build field is a read-only field that shows the number of times this dictionary has been compiled. You cannot change this value.

5. For Comment, type any optional comments that may be helpful to users of this dictionary.

6. Font setting shows the current font settings for the dictionary file. To change this setting, click the following button to display the Font dialog box; then select the appropriate font settings and click OK.

To simultaneously display languages that are related to different charsets (such as French and Greek, for example), select a Unicode font.

7. Click the Domains and priority tab, then proceed to Completing the Domains and Priority Tab, on the following page.
Completing the Domains and Priority Tab

The Domains and priority tab lets you add and prioritize Domains associated with your UD.

1. To add a system domain to the dictionary, click one under System domains and click the following button to move the system domain below Dictionary domains:

   ![System domain button](image)

   To quickly add a system domain to Dictionary domains, double-click it.

2. Optional: Along with the 21 system domains provided by SYSTRAN, you can create custom domains to raise the accuracy of the capability of SYSTRAN to the highest possible level for machine translation. To create custom domains for the dictionary, type a name for the custom domain below Custom domain, then click the Add button. The custom domain turns light gray below Dictionary domains. Repeat this step for each custom domain you want to create.

   ![Custom domain button](image)

   To remove a system or custom domain, either double-click it under Dictionary domains, or click it and click the button.

3. After adding system and custom domains, check the dictionary domains you want to activate in this dictionary.
4. Using the Priority drop-down list, assign a priority to the dictionaries. If you have several dictionaries with the same words or phrases, the definitions from the dictionary with the highest priority will be shown.

If you selected Priority as an informational column, you will be able to change this priority on a per-word or per-phrase basis.

5. Click OK. The Multilingual page appears in the SDM window, with the informational columns you specified (see Figure 9-9).

After you create your UD, TM, or ND, you can view and change its properties by clicking Dictionary Properties on the Tools menu (see Viewing and Changing Dictionary Properties on page 141).

Figure 9-9: Sample Multilingual Page in the SDM Window
Working with User Dictionary Entries

The following sections describe how to work with UD entries. Topics include:

- Adding Words and Phrases, below
- Inserting Words or Phrases into a User Dictionary on page 126
- Removing Words and Phrases from a User Dictionary on page 127
- Checking the Confidence Level of User Dictionary Entries on page 127
- Editing User Dictionary Entries on page 129
- Changing Entry Types on page 130
- Coding User Dictionary Entries on page 130
- Using Expert Coding on page 131
- Sorting Language Columns on page 134
- Marking Headwords on page 135
- Using Textual Lookup Operators on page 135
- Finding Entries on page 138
- Reversing Entries in User Dictionaries on page 140

Adding Words and Phrases

After you specify the properties for your UD, TM, or ND, you can enter words and phrases into it. For UDs and NDs, entries consist of words and phrases in the source and target language. For TMs, entries are full sentences and no coding process is performed.

UDs are used to designate two types of terms:

- Multilingual terms that are to be translated
- Do Not Translate (DNT) that are not to be transmitted

You enter these terms on their own pages in the UD. By default, UDs open to the Multilingual screen. To go to the Do not translate screen, either hold down the Ctrl key and press Tab, or click the Do not translate button at the bottom-left side of the UD window (see Figure 9-10).

Figure 9-10: Multilingual/Do Not Translate Buttons
To add words and phrases:

1. Confirm that the UD is open to the appropriate page (Multilingual or Do Not Translate).
2. On the Edit menu, click Add Entry or click the Add Entry button on the Toolbar:
   
   ![Add Entry button]

   You can also specify a new entry in the source language column by double-clicking on an empty row in that column.

3. In the leftmost column, type the word or phrase for the source language.
4. If you are entering words or phrases into the Multilingual page, move the cursor to the Target language field, then enter the appropriate word or phrase.
5. If the UD has informational columns, complete them appropriately. For more information about these columns, see Table 9-2 on page 120.
6. To add more words and phrases, repeat steps 2 through 5.
7. When you finish adding words and phrases, click the File menu and click Save. When the Save As dialog box appears, assign a name to your UD and click Save.

To differentiate the source language from the target language, this field is highlighted in yellow in the Multilingual page.

You can also specify a new entry in the source language column by double-clicking on an empty row in that column.

To sort entries in a column, click the header column. For example, if your UD has a column called English, you can sort the entries in that column by clicking the English header column.

**Inserting Words or Phrases into a User Dictionary**

To insert words or phrases into a UD:

1. Confirm that the UD is open to the appropriate page (Multilingual or Do Not Translate).
2. Click in the field where you want the new record to appear. (The new record will appear above the row where you clicked.)
3. On the Edit menu, click Insert Entry or click the Insert Entry button on the Toolbar:
   
   ![Insert Entry button]

4. In the leftmost column, type the word or phrase for the source language.
5. If you are entering words or phrases into the Multilingual page, move the cursor to the Target language field, then enter the appropriate word or phrase.
6. If the UD has informational columns, complete them appropriately. For more information about these columns, see Table 9-2 on page 120.
7. To insert more words and phrases, repeat steps 2 through 6.
8. When you finish inserting words and phrases, click the File menu and click Save.
Removing Words and Phrases from a User Dictionary

To remove words and phrases from a UD:

1. Confirm that the UD is open to the appropriate page (Multilingual or Do Not Translate).
2. Click in the row that has the word or phrase you want to remove.
3. On the Edit menu, click Delete Entry or click the Delete Entry button on the Toolbar:

   The row is deleted and each row below it moves up.
4. To remove more words and phrases, repeat steps 2 and 3.

   To select contiguous entries quickly, click the first one, then hold down the Shift key and click the last one. All entries in between are automatically selected. If the entries are not contiguous, click the first one, then hold down the Ctrl key and click each additional one you want to select. You can then click Delete Entry deletes all the selected entries.
5. When you finish removing words and phrases, click the File menu and click Save.

Checking the Confidence Level of User Dictionary Entries

UDs and NDs allow you to select Confidence as an informational column. If you selected this column when you specified the properties for your dictionary, you can use it to check the confidence level of your entries.

   If your UD or ND does not have the Confidence column, you can revise the dictionary’s properties to include this column (see Viewing and Changing Dictionary Properties on page 141).

1. Double-click the Status (leftmost) column on the row that has the entries you want to check (see Figure 9-11 on page 128). Green bars in the Confidence column show the confidence level of the entries and one of four symbols appears in the Status column cell next to the entry (see Table 9-4 on page 128).
Figure 9-11: Viewing the Confidence Level for a Definition

2. If the confidence level is low, it means the software has little confidence in how the entry is coded. To increase the confidence level, revise your source and/or target language entries as well as the settings in the informational columns. Then repeat the previous step to achieve a higher confidence level.

When the software cannot find an appropriate way to code your entries, Error appears in the Category column (if this column is in your dictionary) and a red x appears in the second column (see Table 9-4).

Table 9-4: Status Column Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![green checkmark]</td>
<td>SYSTRAN’s Allcoding engine was able to find a current coding for all languages.</td>
</tr>
<tr>
<td>![yellow checkmark]</td>
<td>The coding of the entry has been validated (for instance, by using Expert Coding). This is the highest level of validation.</td>
</tr>
<tr>
<td>![warning]</td>
<td>Serves as a warning; in the record, one or more target language entries are not in correlation with the source language entry. The text in the cells in question appear in red, and a status message appears in the Status Bar.</td>
</tr>
<tr>
<td>![error]</td>
<td>SDM cannot find any correlation between the source language and most target language entries. In this case, the entry may not be valid or requires additional information.</td>
</tr>
</tbody>
</table>
Editing User Dictionary Entries

Editing the elements of a UD is straightforward. Among the fields of an entry that can be edited are source language, target language, Category, Domain, and Comment. Confidence cannot be edited, because it provides a measurement based on the compilation of the UD.

To edit UD entries:

1. Use SDM to open the dictionary you want to edit.
2. Double-click the field to be edited to highlight it.
3. For text fields, single-click in the highlighted field. You can then use common keyboard functions to edit the entry.
4. For informational columns, edit the content appropriately.
5. The SDM window provides commands and buttons for working with dictionary entries.
   - To cut an entry, click the cell in the SDM window where the entry appears, then click the Edit menu and click Cut or click the following button:

   ![Cut button]

   - To copy an entry, click the cell in the SDM window where the entry appears, then click the Edit menu and click Copy or click the following button:

   ![Copy button]

   - To paste an entry that you cut or copied, click the cell in the SDM window where the entry is to be pasted, then click the Edit menu and click Paste or click the following button:

   ![Paste button]

   - To reverse an action, click the Edit menu and click Undo or click the following button:

   ![Undo button]

   - To add an entry to the SDM window, click the Edit menu and click Add Entry or click the following button:

   ![Add Entry button]

   - To insert an entry in the SDM window, click the Edit menu and click Insert Entry or click the following button:

   ![Insert Entry button]

   - To delete an entry from the SDM window, click the Edit menu and click Delete Entry or click the following button:

   ![Delete Entry button]

6. After you finish editing, click the File menu and click Save to save your changes.
Changing Entry Types
UD entries fall into two categories: multilingual and DNT. Using Change entry type on the Edit menu, you can change a multilingual entry to a DNT entry, or change a DNT entry to a multilingual entry.

To change entry types:
1. With the appropriate UD open, click the entry to be changed.
2. On the Edit menu, click Change entry type. The selected entry moves from the current tab (Multilingual or Do not translate) to the next row available on the other tab in the UD window.

Coding User Dictionary Entries
Using the Code entry and Code all commands in the Tools menu, you can ensure the syntactical accuracy of your UD term translations. Using these commands instructs SDM to evaluate UD term translations against the SYSTRAN Linguistic Resources database and to deliver the results back to the active UD.

Coding an Individual User Dictionary Entry
To code an individual UD entry:
1. With the appropriate UD open, confirm that the appropriate page (Multilingual or Do Not Translate) is displayed.
2. Click in any active field in the record that is to be coded.
3. On the Tools menu, click Code Entry or click the Code Entry button on the toolbar to code the active record:

Either step initiates the compilation process, during which the UD is rendered usable for the SYSTRAN Translation System. When the process finishes, the pertinent results of the Code Entry command are returned to the UD.

Coding All User Dictionary Entries
To code all UD entries:
1. With the appropriate UD open, confirm that the appropriate page (Multilingual or Do Not Translate) is displayed.
2. Click in any active field in the record that is to be coded.
3. On the Tools menu, click Code All or click the Code All button on the toolbar to code all of the records in the UD:

Either step initiates the compilation process, during which the UD is rendered usable for the SYSTRAN Translation System. When the process finishes, the pertinent results of the Code All command are returned to the UD.

A Save operation performed on a UD automatically compiles the active UD. UDs configured with informational columns display pertinent information in these columns as a result of the operation.
Using Expert Coding

Expert Coding lets you finely review, modify, and validate the coding of an entry in a UD or ND.

To use Expert Coding:

1. With the appropriate UD or ND open, click the entry with which you want to use Expert Coding.
2. Perform one of the following steps:
   - On the Tools menu, click Expert Coding.
   - Press the right mouse button and click Expert Coding.

Either step displays the Expert Coding dialog box (see Figure 9-12).

![Expert Coding Dialog Box](image)

3. For General Category, select a part of speech for the complete entry.
4. Monolingual entry shows the original entry. If desired, you can modify the entry.
5. The button lets you recode the entry after a modification in the text field.

If you recode an entry, all other modifications made to this entry are discarded.

6. Use Monolingual category to select the part of speech of the expression in the current language.
7. Confidence shows how confident the software is in the automatic coding of the entry in the current language.
The confidence level displayed in the Expert Coding dialog box is predicated on a per-language basis, whereas the confidence level displayed in the dictionary view is for all languages. Therefore, the Expert Coding dialog box shows precisely the confidence level in the specified language.

8. The buttons let you navigate through the languages of the currently selected entries. As you scroll through languages, the Monolingual entry changes to reflect the currently selected language.

9. A “group” is a set of words that are in agreement (for instance, noun and adjective are in agreement in French or Spanish). The main group is the group containing the headword (in bold). The other groups are secondary groups.

```
<table>
<thead>
<tr>
<th>Main group</th>
<th>Group 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>couleur</td>
<td></td>
</tr>
<tr>
<td>vert</td>
<td></td>
</tr>
<tr>
<td>clar</td>
<td></td>
</tr>
</tbody>
</table>
```

10. The center of the dialog box is the coding area (see Figure 9-13). This area contains fields that are language-dependent and vary with the part of speech selected from the Word Category drop-down list. Some fields require you to enter values, while others let you select choices from a drop-down list or a right-click menu.

```
<table>
<thead>
<tr>
<th>Category</th>
<th>WordCategory</th>
<th>noun</th>
<th>noun</th>
<th>adjective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morphology</td>
<td>Number</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gender</td>
<td>feminine</td>
<td>masculine</td>
<td></td>
</tr>
<tr>
<td>Syntax</td>
<td>AdjPosition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Preposition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Semantic</td>
<td>Human</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Context</td>
<td>SemCategory</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 9-13: Drop-down List in Expert Coding Dialog Box
11. To change groupings, right-click above the Category and Word Choice fields in the center of the dialog box. When the menu in Figure 9-14 appears, click New Group, Add to group, or Delete Group.

Figure 9-14: Right-Click Menu

12. To modify a group in which a word belongs, press the right mouse button use Delete group to detach the word from its current group; then use Add to group to add the group to an existing group (main group or a secondary group) or New group to create a new group.

13. To define the headword of an expression, press the right mouse button and click Headword. This command is a toggle that turns the headword property on and off.

14. Use Merge with next and Split words on the right-click menu to merge and split words to define a set of words that should be considered as a single token. For example, in the following entry:

<table>
<thead>
<tr>
<th>Main group</th>
<th>Group 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>plug</strong></td>
<td><strong>and</strong></td>
</tr>
<tr>
<td><strong>play</strong></td>
<td><strong>device</strong></td>
</tr>
<tr>
<td><strong>noun</strong></td>
<td><strong>noun</strong></td>
</tr>
<tr>
<td><strong>noun</strong></td>
<td><strong>noun</strong></td>
</tr>
</tbody>
</table>

We can tell the software that plug and play should be considered as a single entity for this use.
15. To modify the appearance of the field grid, drag the border rows or press the right mouse button, point to Align, and click by Word width, by Content, or Evenly.

16. The buttons at the bottom of the dialog box shows the ID of the entry. You can use these buttons to navigate forward and backward through the dictionary.

17. Click the OK button. The entry you worked on appears in the UD or ND.

The symbol means that the entry has been reviewed and validated by hand. The Confidence is now automatically 100%.

### Sorting Language Columns

Using Sort language columns on the View menu, you can sort language columns by:

- Content
- Content and category
- Headword
- Duplicate checking

The first three sorting methods sort language columns alphabetically. Duplicate checking groups similar dictionary entries. This allows you to spot redundancies in the dictionary. In the TM in Figure 9-15 on page 134, for example, the group duplicates in the first column shows two entries are probably similar and should be reviewed.

This command detects a duplicate entry that has different codings, but represents the same string.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>The green color</td>
<td>La couleur verte</td>
</tr>
<tr>
<td>The green color</td>
<td>La couleur verte</td>
</tr>
</tbody>
</table>

Figure 9-15: Example of Duplicate Checking
To sort language columns:

1. With the appropriate UD open, click the View menu.
2. Point to Sort language columns and click the appropriate command:
   - Content sorts the column alphabetically by content.
   - Content and category sorts the column alphabetically by content and category.
   - Headword sorts the column alphabetically by headword.
   - Duplicate checking sorts the column by duplicate entries.

Marking Headwords

Using Mark Headwords on the View menu, you can see, after the current entry is coded, which part of the word has been analyzed as the main word (headword) of the expression. Examples include nut in lug nut, Library in Library of Congress, and day in red letter day.

To mark headwords:

1. With the appropriate UD open, click the entry whose noun is to be designated as a headword.
2. On the View menu, click Mark Headwords.

Using Textual Lookup Operators

Lookup operators are an advanced coding feature that extends the power of dictionaries beyond classical terminological entries. Lookup operators provide a reference to a complex entity (numerical for instance) included within a UD or a normalization entry. They consist of numeric, URI, and FIND operators (see Table 9-5). These operators fall into two categories:

- Simple: simple operators require no parameter.
- Complex: complex operators require a parameter. The parameters for the FIND operator, for example, is the sub-dictionary name.

Table 9-5: Textual Lookup Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Recognizes numeric expressions (100, 1.2, ...).</td>
</tr>
<tr>
<td>URI</td>
<td>Recognizes any uri (for example, <a href="http://www.yahoo.fr">www.yahoo.fr</a>, <a href="mailto:durant@multilingual.com">durant@multilingual.com</a>).</td>
</tr>
<tr>
<td>FIND</td>
<td>Looks for a word in a second dictionary whose name is specified as a parameter of this lookup operator. This operator lets you factorize complex entries.</td>
</tr>
</tbody>
</table>

To use textual lookup operators, enable textual lookup operator mode by either clicking Textual lookup operators on the View menu or clicking the Textual lookup operators button:
When this mode is enabled, you can use the buttons in Table 9-6 to insert textual lookup operators.

**Table 9-6: Textual Lookup Operators**

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![NUMBER]</td>
<td>NUMBER</td>
<td>Simple</td>
<td>Numeric entities</td>
</tr>
<tr>
<td>![URI]</td>
<td>URI</td>
<td>Simple</td>
<td>URL entities</td>
</tr>
<tr>
<td>![FIND]</td>
<td>FIND</td>
<td>Complex</td>
<td>Matching in a sub-dictionary</td>
</tr>
</tbody>
</table>

**Examples of Using Textual Lookup Operators**

Figure 9-16 shows an example of the `<NUMBER1>` operator inserted in English and French entries. In this figure, the sentence “Dow Jones closed below 2000.” is matched with the translation “Le Dow Jones a fini sous les 2000 points.”

![Figure 9-16: Example of Textual Lookup Operators](image)

When you finish inserting textual lookup operators, you can exit this mode by clicking Textual lookup operators on the View menu or clicking the Textual lookup operators button. When you exit, the operators change to buttons.

Figure 9-17 shows how the operators in Figure 9-16 appear when textual lookup operator mode is disabled. In this example, the symbol ![NUMBER] represents any numeric sequence.

![Figure 9-17: Example of Using Lookup Operators](image)

In Figure 9-18 on page 136, the dictionary contains operators that point to the dictionary name F1Team. As defined below, the combination of the two operators enables the recognition of expressions like “Williams GP Team” and translation by “écurie Williams”. In this example, F1Team is the friendly name of a sub-dictionary used to recognize and translate parts of a given expression (see Figure 9-19 on page 137).

![Figure 9-18: Another Example of Using Lookup Operators](image)
Table 9-5 describes the operators.

**Entering Lookup Operators**

To enter Lookup operators:

1. Perform one of the following steps to enable textual lookup mode:
   - On the View menu, click Textual lookup operators.
   - Click the Textual lookup operators button:

2. Double-click a dictionary entry. The Simple Lookup Operator button ( ) and Lookup Operator button ( ) become available.

3. Select the appropriate lookup operator by clicking the Simple Lookup Operator button ( ) or Lookup Operator ( ) button, or by clicking on the drop-down list next to these buttons.

4. For complex operators, click the symbol to display a small dialog in which you can enter the parameter.
Finding Entries

There may be times when you want to view other instances of a word or phrase in the current dictionary or another dictionary. To simplify this procedure, SDM provides a search feature that lets you locate words or phrases in local dictionaries as well as SYSTRAN Online dictionaries.

1. On the Edit menu, click Find. The Find dialog box appears (see Figure 9-21).

![Figure 9-21: Find Dialog Box](image)

2. Next to Find what, type the word or phrase you want to find.
3. Next to Find where, specify the location where the search is to take place.
4. Under Search options, click any options you want to specify for this search (see Table 9-7 on page 138).
5. Click the Find button. SDM locates all instances of the word or phrase in the location specified that match the search options and displays the results at the bottom of the Find dialog box (see Figure 9-22 on page 139).
6. To go to one of the found words or expressions, double-click the word or expression at the bottom of the Find dialog box.

Table 9-7: Search Options in the Find Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole word</td>
<td>Locates entire words and phrases that match the entry you typed in the Find what field, and not part of larger words.</td>
</tr>
<tr>
<td>Target</td>
<td>Locates words or phrases in the target language column that match the entry you typed in the Find what field.</td>
</tr>
<tr>
<td>Source</td>
<td>Locates words or phrases in the source language column that match the entry you typed in the Find what field.</td>
</tr>
<tr>
<td>Match case</td>
<td>Locates words and phrases that match the capitalization you used in the Find what field.</td>
</tr>
</tbody>
</table>
Table 9-7: Search Options in the Find Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headword</td>
<td>Locates noun phrases whose nouns have been defined as headwords (see Marking Headwords on page 135).</td>
</tr>
<tr>
<td>Lemma</td>
<td>Locates words that share a common stem, part of speech, and word sense (such as compute and computing).</td>
</tr>
<tr>
<td>Form</td>
<td>Locates the word or phrase in the specified form.</td>
</tr>
<tr>
<td>Language</td>
<td>Locates the word or phrase you typed in the Find what field in the specified language.</td>
</tr>
<tr>
<td>Domains</td>
<td>Locates the word or phrase you typed in the Find what field in the specified domain.</td>
</tr>
</tbody>
</table>
Reversing Entries in User Dictionaries

UDs give you the flexibility to “reverse” source and target language entries on the Multilingual page.

- If you reverse an entry in the source language column, it allows the source language for that entry to be used as the target language.
- If you reverse an entry in the target language column, it allows the target language for that entry to be used as the source language.

Examples of Using Reverse Entries

The following example shows how this feature works. Assume that the following entry is reversed in the French column:

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>a can</td>
<td>⇔ un réservoir</td>
<td>envase di agua</td>
</tr>
</tbody>
</table>

- English->French (can->réservoir)
- English->Spanish (can->envase di agua)
- French->Spanish (réservoir-> envase di agua)

Now assume that the following entries in the French and Spanish columns have are configured for reverse entries. This means that French and Spanish can be used as a source language for this entry.

The dictionary generates the following pairs:

- "English->French (can->réservoir)
- "English->Spanish (can->envase di agua)
- "French->Spanish (réservoir-> envase di agua)
- "Spanish->French (envase di agua->réservoir)

In the following example, all columns are configures for reverse entries. This means that French and Spanish can be used as a source language for this entry, and English can be used as a target language.

The dictionary generates the following pairs:

- "English->French (can->réservoir)
- "English->Spanish (can->envase di agua)
- "French->Spanish (réservoir-> envase di agua)
- "Spanish->French (envase di agua->réservoir)
- "French->English (réservoir->can)
- "Spanish->English (envase di agua->can)
Procedure for Reversing Entries in a User Dictionary

To reverse entries in a UD:

1. Click the source or target word or phrase you want to reverse.

   Reversing the translation (target column) can be dangerous. For example, defining an entry like “can” as an English source negatively impacts translation, since it conflicts with the auxiliary “can”.

2. Perform one of the following steps:
   - On the Edit menu, click Back translation.
   - Press the right mouse button and click Back translation.

   A double-arrow appears in the lower-left corner of the source language column to show that the entry has been reversed (see Figure 9-23).

3. To reverse additional entries, repeat steps 1 and 2.

4. If you change your mind about reversing an entry, click the entry, then Back translation again to remove the double-arrow.

Working with Dictionaries

The following sections describe basic and advanced activities you can perform with dictionaries. Basic activities include:

- Viewing and Changing Dictionary Properties, below
- Importing Files into a User Dictionary on page 142
- Exporting Files on page 143

Viewing and Changing Dictionary Properties

After you create a UD, TM, or ND, you can view its properties and change them if desired.

1. Perform one of the following steps:
   - On the Tools menu, click Dictionary properties.
     OR
   - Click the Dictionary Properties button:

     ![Dictionary Properties button]

     Either step displays the Dictionary Properties dialog box, with the Language tab in front.

2. View the properties for the current dictionary and change them if necessary. For information about specifying dictionary properties, see Completing the Languages Tab, Completing the Properties Tab, and Completing the Domains and Priority Tab.
Importing Files into a User Dictionary

SDM provides an import feature that lets you import files into a UD. By importing files, you don’t have to retype the data you want to use in SDM.

For information about the format that the imported files must follow, see Importing and Exporting Files on page 181.

Files you can import include:

- Formatted text (*.txt) files
- Microsoft Excel (*.xls) files
- TMX (*.tmx) files
- XML (*.xml) files

To import files into a UD:

1. Open the dictionary into which you want to import the files.
2. On the File menu, click Import. The Open dialog box appears (see Figure 9-24).

3. Navigate to the location where the file you want to import resides.
4. For Files of type, select the type of file you want to import.
5. Click the file and click the Open button. SDM imports the entries into the current dictionary.

As a shortcut, you can double-click the file in the Open dialog box to import its contents into SDM.
Exporting Files

There may be times when you want to work on dictionary entries outside of SDM. For example, you may want to export a UD, TM, or ND in Microsoft Excel format, so you can perform Excel activities on the file. You can then use SDM’s import feature (described on page 142) to import the file back into a dictionary if desired.

To export files from a UD:

1. Open the dictionary whose entries you want to export.
2. On the File menu, click Export. The Save As dialog box appears (see Figure 9-25).
3. Navigate to the location where you want the exported file to reside.
4. For File name, enter a name for the file that will contain the exported entries
5. For Files of type, select the format for the file you want to export.
6. Click the Save button to export the entries to the file.

If there are no UDs open, the imported file opens in a new UD window automatically. If there is more than one UD open, SDM tries to merge the imported data into the currently active UD file.

The Export command is only available when a UD is open in the SDM window.
Using Intuitive Coding™ to Build High-Quality Dictionaries

Intuitive Coding™ is a SYSTRAN process that aids in the transformation of UDs and NDs into “run-time” dictionaries used for SYSTRAN translations (it does not apply to TMs). Saving a dictionary requires a linguistic processing of the entries. This “coding” process performs an analysis of the source and target or normalized language term entries to enrich the data for the production of the runtime dictionary. For example, Intuitive Coding™ can provide the software with gender-bias and inflection patterns.

The coding process is facilitated by SYSTRAN’s Intuitive Coding™ Technology®. This technology converts into linguistic information all “clues” that exist in the entries (clues can be implicit for instance determiners or explicit and represented using brackets). Schematically, coding level varies from fully automatic coding, where SDM either finds the information it needs in the entries guesses it when the information is missing, to expert coding, where you can review all coding performed by the software and correct and complete it with additional linguistic information.

Obtaining a good coding quality is important, since it impacts the way the terms are analyzed during the translation. The instruments of the SYSTRAN Intuitive Coding™ process are:

- Protected Sequences
- Bracketing
- Canonical Form
- Upper-Case Letters
- Simple and Compound Entries
- Intuitive Clues
- Conditional Entries
- Grammatical entries

Intuitive Coding™ clues and specifications are language-specific. SYSTRAN provides a comprehensive list of these clues by language at http://www.systransoft.com/Support/Dicts/.

Protected Sequences

Protected sequences are words and phrases that do not undergo analysis. Rather, they are accepted as-is for the final translated product.

When it comes to protected sequences, it is important to keep the original format of the entry in your glossary. For example, if the sequence is in capital letters in the document to be translated, it must be entered in capital letters in the external dictionary. To designate proper nouns, acronyms, and expressions as protected sequences, encode them with quotation marks ("."). Figure 9-26 shows an example.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;if desired&quot;</td>
<td>&quot;si vous le souhaitez&quot;</td>
</tr>
<tr>
<td>NATO&quot;</td>
<td>&quot;OTAN&quot;</td>
</tr>
</tbody>
</table>

Figure 9-26: Example of Using Intuitive Coding™
Bracketing

Use brackets to isolate a compound within a larger compound. This can be helpful when translating from English, where the relationship between different elements of a compound are not as obvious as in other languages. Figure 9-27 shows an example.

<table>
<thead>
<tr>
<th>English</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>customized [toolbar button]</td>
<td>botón personalizado de la barra de herramientas</td>
</tr>
</tbody>
</table>

Figure 9-27: Example of Using Brackets

Canonical Form

Like a traditional paper dictionary, canonical form — the simplest form of a word or phrase — is the ideal form for entering words and phrases into a UD. UD entries in their inflected form are translated by the SYSTRAN Translation System, but the additional information is interpreted as a clue to a particular use of a word.

The canonical form is dependent on the languages it is to encode. In French, for example, the canonical form of a nominal or adjectival entry is the masculine singular, while verbal entries are in the infinitive.

Upper-Case Letters

Use of capital letters adheres to the same guideline as canonical form — all entries entry should be in their native format. Otherwise, the software interprets the uppercase as an additional linguistic clue. The original format is automatically detected and respected.

The use of the uppercase in most languages is a clue for proper nouns and acronyms. Therefore, we recommend you limit their use.

<table>
<thead>
<tr>
<th>French</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auchan</td>
<td>Alcanço</td>
</tr>
</tbody>
</table>

Figure 9-28: Example of Using Uppercase

Simple and Compound Entries

You can enter simple and compound words into a UD. Compound words are best for instances in which a word needs to be treated as a single unit. This is akin to a traditional paper dictionary, where the translation of compound words that include the main entry itself is given alongside the main entry.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>drive</td>
<td>commande</td>
</tr>
<tr>
<td>drive shaft</td>
<td>axe d'entraînement</td>
</tr>
<tr>
<td>a can</td>
<td>un bidon</td>
</tr>
<tr>
<td>a watering can</td>
<td>un anoxoir</td>
</tr>
</tbody>
</table>

Figure 9-29: Example of Using Simple and Compound Entries
Intuitive Clues

SDM uses clues — determiners and particles — to determine the grammatical category of an entry. Through the use of these clues, SDM avoids ambiguities that exist between certain categories.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>a light</td>
<td>une lumière</td>
</tr>
<tr>
<td>to light</td>
<td>allumez</td>
</tr>
</tbody>
</table>

Figure 9-30: Example of Using Intuitive Clues

In gender-biased languages, the meaning of a noun can be different, depending on whether the feminine or the masculine form is used. You can use determiners to specify gender-bias for an ambiguous UD entry.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>check mark</td>
<td>une cache</td>
</tr>
<tr>
<td>stagecoach</td>
<td>un cache</td>
</tr>
</tbody>
</table>

Figure 9-31: Example of Using Determiners

For translating singular nouns to plural form and vice-versa, it is preferable to enter the desired inflected form into the UD. The software interprets this as a clue and generates the expected form.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>business</td>
<td>los afanes</td>
</tr>
<tr>
<td>accident insurance</td>
<td>assurance-accidents</td>
</tr>
</tbody>
</table>

Figure 9-32: Example of Using Plural Forms

When it comes to specific structures, a preposition used with a noun, verb, or adjective should be added to the entry. This forces the software to take this information into account and perform its translations in accordance with it.

<table>
<thead>
<tr>
<th>English</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>to dream (of)</td>
<td>soñar [con]</td>
</tr>
<tr>
<td>to ask (for)</td>
<td>preguntar [por]</td>
</tr>
</tbody>
</table>

In some cases, a preposition is required in some languages. For these languages, specify the preposition, without brackets, to ensure that the software translates it.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>to attend</td>
<td>asistir à</td>
<td>asistir</td>
</tr>
<tr>
<td>to wait for</td>
<td>attendre</td>
<td>esperar</td>
</tr>
</tbody>
</table>

Figure 9-33: Examples of Specific Structures
Conditional Entries

At times, it may be necessary to enter a word that has different meanings, depending on its context. In such cases, repeat the entry as often as necessary and add the different contexts in brackets next to it.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>to save (a document)</td>
<td>sauvegarde</td>
</tr>
<tr>
<td>to save (money)</td>
<td>économiser</td>
</tr>
<tr>
<td>to save (a child)</td>
<td>sauver</td>
</tr>
</tbody>
</table>

Figure 9-34: Example of Conditional Entries

Grammatical Entries

Grammatical information can be added to clarify ambiguities. While the parts of speech that are available are language-dependent, the parts of speech for the complete entry (in the Category field) typically include:

- Noun (n), Proper Noun (pn), Acronym
  Examples: “retail product”, “Yahoo.com”, and “IRS”
- Adjective (a)
  Example: “light blue”
- Verb (v)
  Example: “to switch off”
- Adverb
  Example: “right now”
- Preposition
  Example: “on the upper edge of”
- Sequence
  While it is not a part of speech, a sequence notifies the coding engine that the entry should be kept as is and should not be coded. All characters in the entries are part of the entry and should be matched this way. This special category is useful for coding non grammatical entries.

This information need only be entered once for each multilingual entry.

<table>
<thead>
<tr>
<th>French</th>
<th>English</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>pouvoir (n)</td>
<td>power</td>
<td>poder</td>
</tr>
<tr>
<td>pouvoir (v)</td>
<td>can</td>
<td>poder</td>
</tr>
<tr>
<td>appropriate (a)</td>
<td>appropriate</td>
<td></td>
</tr>
<tr>
<td>Aérospatiale (pn)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-35: Example of Specifying Grammatical Entries
Gender clues can be included, as appropriate:

- (m) for masculine
- (f) for feminine

<table>
<thead>
<tr>
<th>French</th>
<th>English</th>
</tr>
</thead>
<tbody>
<tr>
<td>artist[f]</td>
<td>artist</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>English</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>day (m)</td>
<td>dia (m)</td>
</tr>
</tbody>
</table>

Figure 9-36: Examples of Using Gender Clues

For nouns and proper nouns, you can specify a category at the time of entry to a UD. This additional information is especially useful when the software engine does not know the entry.

<table>
<thead>
<tr>
<th>English</th>
<th>French</th>
<th>Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>file clash</td>
<td>archivador (human)</td>
<td></td>
</tr>
<tr>
<td>gender (non human)</td>
<td>broyeur (nonhuman)</td>
<td></td>
</tr>
<tr>
<td>Windows 2000 (product name)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Britanny</td>
<td>Breizh (location)</td>
<td></td>
</tr>
<tr>
<td>Dupont (last name)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>John (first name)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-37: Example of Using Proper Nouns
Part IV: Appendixes

Contents

• Appendix A, Menu, Command, and Toolbar Reference
• Appendix B, Preparing English Text for MT
• Appendix C, Sample Imperative Translations
• Appendix D, Importing and Exporting Files
• Glossary
Appendix A

Menu, Command, and Toolbar Reference

SYSTRAN Translation Project Manager (STPM)  151
STPM Menus and Commands  151
STPM Toolbars  155
STPM Right-Click Menus  157

SYSTRAN MultiTranslate Utility (SMTU)  159
SMTU Menus and Commands  159
SMTU Toolbars  161

SYSTRAN Dictionary Manager (SDM)  162
SDM Menus and Commands  162
SDM Toolbars  167

SYSTRAN Server Commands  168
SYSTRAN Translation Project Manager (STPM)

STPM Menus and Commands
The following sections describe the menus and commands available in STPM.

File Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Project</td>
<td>Ctrl+N</td>
<td>Opens a new, unsaved project.</td>
</tr>
<tr>
<td>Open Project...</td>
<td>Ctrl+O</td>
<td>Opens a project you previously saved.</td>
</tr>
<tr>
<td>Save Project</td>
<td>Ctrl+S</td>
<td>Saves a project. (If the project has not been saved, the Save As dialog box appears.)</td>
</tr>
<tr>
<td>Save Project As</td>
<td></td>
<td>Saves a new project that has not been saved, or saves an existing project under a different name or at a different location.</td>
</tr>
<tr>
<td>Close Project</td>
<td>Ctrl+W</td>
<td>Closes the current project.</td>
</tr>
<tr>
<td>Import File</td>
<td></td>
<td>Imports a selected file into STPM.</td>
</tr>
<tr>
<td>Export Project</td>
<td></td>
<td>Exports the project into Translation Memory exchange (.tmx) format.</td>
</tr>
<tr>
<td>Export Source</td>
<td></td>
<td>Exports the source document in HTML (.htm or .html), text (.txt), Microsoft Word (.doc), or Rich Text Format (.rtf) format.</td>
</tr>
<tr>
<td>Export Target</td>
<td></td>
<td>Exports the target document in HTML (.htm or .html), text (.txt), Microsoft Word (.doc), or Rich Text Format (.rtf) format.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Exits the STPM application.</td>
</tr>
</tbody>
</table>
Edit Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td>Reverses the last action performed.</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
<td>Repeats the last change you made.</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Removes the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Copies the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Inserts the Clipboard contents at the cursor location.</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td>Selects the entire contents in the file.</td>
</tr>
</tbody>
</table>

Format Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>A toggle command that bolds or unbolds text.</td>
</tr>
<tr>
<td>Italic</td>
<td>A toggle command that adds or removes italics.</td>
</tr>
<tr>
<td>Underline</td>
<td>A toggle command that adds or removes underlines.</td>
</tr>
</tbody>
</table>
### Tools Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Expression DNT</td>
<td>Places highlighted text into Do Not Translate status.</td>
</tr>
<tr>
<td>Set Paragraph DNT</td>
<td>Places highlighted paragraph into Do Not Translate status.</td>
</tr>
<tr>
<td>Set Insertion DNT</td>
<td>Identifies a sequence of words as an insertion within a complete sentence that is not to be translated.</td>
</tr>
<tr>
<td>Delete DNT Block</td>
<td>Removes the Do Not Translate status from highlighted text when the text has been previously designated DNT.</td>
</tr>
<tr>
<td>Send to SDM</td>
<td>Sends highlighted words to SDM.</td>
</tr>
<tr>
<td>Show UD Entry</td>
<td>Sends selected words and phrases to a new or existing User Dictionary.</td>
</tr>
<tr>
<td>Delete Alternative Meanings Choice</td>
<td>Deletes Alternative Meaning choices.</td>
</tr>
<tr>
<td>Delete Source Ambiguity Choice</td>
<td>Deletes Source Ambiguity choices.</td>
</tr>
<tr>
<td>Delete TM Choice</td>
<td>Deletes Translation Memory choices.</td>
</tr>
<tr>
<td>Find in Dictionaries</td>
<td>Lets you locate words or phrases in local dictionaries as well as SYSTRAN Online dictionaries.</td>
</tr>
</tbody>
</table>
Window Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Projects</td>
<td>The names of all open projects appear at the top of this menu. Unsaved projects appear as Document n, where n is the number of the document. A check mark shows the current project. To move to another project click its name.</td>
</tr>
<tr>
<td>Horizontal View</td>
<td>Arranges the source and target windows above one another.</td>
</tr>
<tr>
<td>Vertical View</td>
<td>Arranges the source and target windows side by side.</td>
</tr>
</tbody>
</table>

Help Menu (STPM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Shows copyright and version information.</td>
</tr>
</tbody>
</table>
STPM Toolbars

The following sections describe the STPM toolbar.

**Standard Toolbar (STPM)**

- **Saves a project** (If the project has not been saved, the Save As dialog box appears)
- **Opens a new, unsaved project**
- **Opens a project you previously saved**
- **Removes the selected item and stores it on the Clipboard**
- **Copies the selected item and stores it on the Clipboard**
- **Arranges the source and target windows above one another**
- **Arranges the source and target windows side by side**
- **Repeats the last change you made**
- **Reverses the last action performed**
- **Inserts the Clipboard contents at the cursor location**

**Format Toolbar (STPM)**

- **A toggle button that bolds or unbolds text**
- **A toggle button that adds or removes italics**
- **A toggle button that adds or removes underlines**
- **Lets you select typefaces for selected text**
- **Shifts text to the left**
- **Centers text**
- **Shifts text to the right**
- **A toggle button that adds or removes numbers**
- **A toggle button that adds or removes bullets**
- **A toggle button that indents a paragraph**
- **A toggle button that outdents a paragraph**
**Stop Toolbar (STPM)**

- Stops the current action

**Web Toolbar (STPM)**

- Address field for entering a Web page URL
- Address: [http://www.systransoft.com/About](http://www.systransoft.com/About)
- Takes you to the specified Web page

**SYSTRAN Toolbar (STPM)**

- Translate button
- Source Language drop-down list
- Target Language drop-down list
- User Dictionaries button
- Review button
- Translation Options button
- Search and Highlight button
STPM Right-Click Menus

The following menu appears when you right-click in the STPM window:

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Removes the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Copies the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Inserts the Clipboard contents at the cursor location.</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td>Selects all items in the document or Web page.</td>
</tr>
<tr>
<td>Set Expression DNT</td>
<td></td>
<td>Places highlighted text into Do Not Translate status.</td>
</tr>
<tr>
<td>Set Paragraph DNT</td>
<td></td>
<td>Places the highlighted paragraph into Do Not Translate status.</td>
</tr>
<tr>
<td>Set Insertion DNT</td>
<td></td>
<td>Identifies a sequence of words as an insertion within a complete sentence that is not to be translated.</td>
</tr>
<tr>
<td>Delete DNT Block</td>
<td></td>
<td>Removes the Do Not Translate status from highlighted text when the text has been previously designated DNT.</td>
</tr>
<tr>
<td>Send to SDM</td>
<td></td>
<td>Sends highlighted words to SDM.</td>
</tr>
</tbody>
</table>

Table A-7: STPM Right-Click Menu
The following menu appears when you right-click in the STPM toolbar area:

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show UD Entry</td>
<td></td>
<td>Sends selected words and phrases to a new or existing User Dictionary.</td>
</tr>
<tr>
<td>Delete Alternative Meanings Choice</td>
<td></td>
<td>Deletes Alternative Meaning choices.</td>
</tr>
<tr>
<td>Delete Source Ambiguity Choice</td>
<td></td>
<td>Deletes Source Ambiguity choices.</td>
</tr>
<tr>
<td>Delete TM Choice</td>
<td></td>
<td>Deletes Translation Memory choices.</td>
</tr>
<tr>
<td>Find in Dictionaries</td>
<td></td>
<td>Lets you locate words or phrases in local dictionaries as well as SYSTRAN Online dictionaries.</td>
</tr>
</tbody>
</table>

The following menu appears when you right-click in the STPM toolbar area:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Displays (checked) or hides the standard toolbar in STPM.</td>
</tr>
<tr>
<td>Format</td>
<td>Displays (checked) or hides the Format toolbar in STPM.</td>
</tr>
<tr>
<td>Web</td>
<td>Displays (checked) or hides the Web toolbar in STPM.</td>
</tr>
<tr>
<td>Stop</td>
<td>Displays (checked) or hides the Stop button in STPM.</td>
</tr>
<tr>
<td>Systran</td>
<td>Displays (checked) or hides the SYSTRAN toolbar in STPM.</td>
</tr>
</tbody>
</table>
SYSTRAN MultiTranslate Utility (SMTU)

SMTU Menus and Commands
The following sections describe the menus and commands available in SMTU.

**File Menu (SMTU)**

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Project</td>
<td>Ctrl+N</td>
<td>Opens a new, unsaved project.</td>
</tr>
<tr>
<td>Open Project</td>
<td>Ctrl+O</td>
<td>Opens a project you previously saved.</td>
</tr>
<tr>
<td>Save Project</td>
<td>Ctrl+S</td>
<td>Saves a project. (If the project has not been saved, the Save As dialog box appears.)</td>
</tr>
<tr>
<td>Save Project As</td>
<td></td>
<td>Saves a new project that has not been saved, or saves an existing project under a different name or at a different location.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Exits the SMTU application.</td>
</tr>
</tbody>
</table>

**View Menu (SMTU)**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation Options</td>
<td>Lets you display options for improving translations.</td>
</tr>
<tr>
<td>User Dictionaries</td>
<td>Lets you select User Dictionaries to be used in your translation.</td>
</tr>
<tr>
<td>Review</td>
<td>Lets you review terminology.</td>
</tr>
<tr>
<td>Batch Entry Options</td>
<td>Lets you select options for processing batch entries.</td>
</tr>
</tbody>
</table>
**Batch Menu (SMTU)**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Files to Batch</td>
<td>Adds files to the current batch file.</td>
</tr>
<tr>
<td>Add Folders to Batch</td>
<td>Adds folders to the current batch file.</td>
</tr>
<tr>
<td>Remove From Batch</td>
<td>Removes items from the current batch file.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves items in the batch file up in order.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves items in the batch file down in order.</td>
</tr>
<tr>
<td>Open Source Document</td>
<td>Opens the selected source document.</td>
</tr>
<tr>
<td>Open Translated Document</td>
<td>Opens the selected target document.</td>
</tr>
<tr>
<td>Open in Project Manager</td>
<td>Launches STPM and places the selected target document in the source window.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the translation operation currently in progress.</td>
</tr>
</tbody>
</table>

**Help Menu (SMTU)**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Shows copyright and version information.</td>
</tr>
</tbody>
</table>
SMTU Toolbars

The following sections describe the SMTU toolbar.

**Standard Toolbar (SMTU)**
- Opens a new, unsaved project
- Opens a project you previously saved
- Saves a project (If the project has not been saved, the Save As dialog box appears)

**Batch Toolbar (SMTU)**
- Lets you add folders to the batch
- Lets you add files to the batch
- Removes files, folders, and Web pages from a batch
- Moves items up in a batch
- Moves items down in a batch

**URL Toolbar (SMTU)**
- Address field for entering a Web page URL
- Adds the Web page to the batch

**Stop Button (SMTU)**
- Stops the current action
SYSTRAN Toolbar (SMTU)

- Translate button
- Dictionary button
- Review button
- Source Language Drop-down list
- Target Language Drop-down list
- Translation Options button
- Batch Entry Options button

SYSTRAN Dictionary Manager (SDM)

SDM Menus and Commands

File Menu (SDM)

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl+O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save without coding</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recent Files</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl+P</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Keyboard/Shortcut</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td></td>
<td>Opens a new, unsaved User Dictionary project, Translation Memory project, or Normalization Project.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
<td>Opens a User Dictionary, Translation Memory, or Normalization Dictionary project you previously saved.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td>Saves a new project that has not been saved, or saves an existing project under a different name or at a different location.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save without coding</td>
<td></td>
<td>Saves the currently open dictionary without the coding.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td>Saves a new dictionary that has not been saved, or saves an existing dictionary under a different name or at a different location.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td>Closes the currently open dictionary.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
<td>Imports text-, Microsoft Excel-, TMX-, or XML-formatted files into SDM.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td></td>
<td>Exports formatted text files or Microsoft Excel files from SDM.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recent Files</td>
<td></td>
<td>Provides a shortcut for opening recently accessed SDM files.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup</td>
<td></td>
<td>Lets you select the paper size and source, orientation (portrait or landscape) and margins for the page.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
<td>Lets you see how the currently displayed page will appear when you print it. Also, lets you print the page.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
<td>Lets you print the currently displayed page.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Exits the SDM application.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Edit Menu (SDM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td>Reverses the last action performed.</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Removes the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Copies the selected item and stores it on the Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Inserts the Clipboard contents at the cursor location.</td>
</tr>
<tr>
<td>Add entry</td>
<td></td>
<td>Adds an entry to the dictionary.</td>
</tr>
<tr>
<td>Insert entry</td>
<td>INS</td>
<td>Inserts an entry into the dictionary.</td>
</tr>
<tr>
<td>Delete entry</td>
<td></td>
<td>Deletes an entry from the dictionary.</td>
</tr>
<tr>
<td>Change entry type</td>
<td></td>
<td>Changes a multilingual entry to a DNT entry or a DNT entry to a multilingual entry</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
<td>Lets you locate words or phrases in local dictionaries as well as SYSTRAN Online dictionaries.</td>
</tr>
<tr>
<td>Back translation</td>
<td></td>
<td>Reverses the source/target language assignment for a dictionary entry.</td>
</tr>
</tbody>
</table>
View Menu (SDM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>Lets you display and hide SDM toolbars.</td>
</tr>
<tr>
<td>Sort language columns</td>
<td>Lets you sort language columns by content, content and category, headword, or duplicate entries.</td>
</tr>
<tr>
<td>Mark Headwords</td>
<td>Lets you see, after the current entry is coded, which part of the word has been analyzed as the main word (headword) of the expression.</td>
</tr>
<tr>
<td>Textual lookup operators</td>
<td>Lets you enable or disable textual lookup mode.</td>
</tr>
</tbody>
</table>

Tool Menu (SDM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code entry</td>
<td>Lets you code individual User Dictionary entries.</td>
</tr>
<tr>
<td>Code all</td>
<td>Lets you code all User Dictionary entries.</td>
</tr>
<tr>
<td>Expert coding</td>
<td>Lets you finely review, modify, and validate the coding of an entry in a User Dictionary or Normalization Dictionary.</td>
</tr>
<tr>
<td>Dictionary</td>
<td>Lets you view and change the properties for the current dictionary.</td>
</tr>
<tr>
<td>Dictionary</td>
<td>properties…</td>
</tr>
</tbody>
</table>
Window Menu (SDM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Cascades all open dictionaries, allowing you to see all or part of the dictionaries that are currently open.</td>
</tr>
<tr>
<td>Tile</td>
<td>Tiles all open dictionaries, allowing you to see all or part of the dictionaries that are currently open.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges icons.</td>
</tr>
<tr>
<td></td>
<td>All open dictionaries are listed with a checkmark.</td>
</tr>
</tbody>
</table>

Help Menu (SDM)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Shows copyright and version information.</td>
</tr>
<tr>
<td>SDM Help</td>
<td>Lets you access SDM online help.</td>
</tr>
</tbody>
</table>
**SDM Toolbars**

**Standard Toolbar (SDM)**
- Opens a new User Dictionary, Translation Memory, or Normalization Dictionary
- Opens an existing User Dictionary, Translation Memory, or Normalization Dictionary
- Saves the currently open dictionary
- Saves the currently open dictionary without coding
- Prints the currently open dictionary
- Cuts a dictionary entry to the Clipboard
- Copies a dictionary entry to the Clipboard
- Pastes a dictionary entry from the Clipboard
- Displays copyright information
- Codes selected dictionary entries
- Codes all dictionary entries
- Deletes an entry from the dictionary
- Deletes an entry from the dictionary
- Inserts an entry into the dictionary
- Adds an entry to the dictionary
- Reverses the last task performed

**Lookup Operators Toolbar (SDM)**
- Lets you select lookup operators
- Lets you select simple lookup operators
- Lets you enable or disable textual lookup mode.
Status Bar (SDM)

Table A-19: SYSTRAN Server Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About SYSTRAN Server</td>
<td>Shows copyright and version information.</td>
</tr>
<tr>
<td>SYSTRAN Plugins</td>
<td>Enables (checked) or disables (not checked) SYSTRAN plugins.</td>
</tr>
<tr>
<td>Interface Language</td>
<td>Lets you select an interface language for SYSTRAN 5.0 (see Figure A-1).</td>
</tr>
<tr>
<td>Check for dictionary updates</td>
<td>Lets you check for and download dictionary updates.</td>
</tr>
<tr>
<td>Logs</td>
<td>Lets you view SYSTRAN logs.</td>
</tr>
<tr>
<td>Quit</td>
<td>Lets you exit SYSTRAN 5.0.</td>
</tr>
</tbody>
</table>

Figure A-1: Selecting an Interface Language
Appendix B
Preparation of English Text for MT

General Principles 170
Grammar Writing Rules 170
Using Articles 170
Avoiding Speech Ambiguity 170
Using Enumeration 171
Ensuring Subject-Verb Agreement 171
Using Prepositions 171
Using Infinitives at the Beginning of Sentences 172
Using Imperatives 172
Observing Punctuation Rules 172
Using Main Clauses 172
Using Subordinate Clauses 173
Using Relative Clauses 173
Avoiding Multiple Stacking 174
Using Compound Words 174
Using Capitalization 174
Using Spelling Variations 175

Lexical Ambiguities 175
Disambiguation of Product Names and Menus 175
Avoiding Lexical Ambiguities 175
Using Compounds 176

Format and Typographical Issues 176
Segmentation Tags 176

Do-Not-Translate (DNT) Tags 177
Preparation for English Text for MT

This appendix provides guidelines for preparing English text for use with machine translation (MT).

**General Principles**

The three most frequent problems found in analyzing English sentences are:

- Very long sentences, typically including more than one sub-clause.
- Sentences with incorrect punctuation usage, including sentences with too much punctuation.
- Use of lexically or syntactically ambiguous words.

To improve translations, follow these writing recommendations:

- **Write shorter sentences.**
  Restrict a sentence so it expresses one or two thoughts. Multiple sentences, connected by the appropriate conjunctions, normally result in better machine translation.

- **Use fewer sub-clauses.**
  This suggestion is closely related to sentence length. You should avoid sub-clauses when possible, except in obvious cases, such as conditional (if... then...) phrases.

- **Use punctuation wisely.**
  Machine translation can digest only so much punctuation. Therefore, use just enough punctuation to clarify ideas. Too much punctuation, especially commas, reaches a point of diminishing return quickly.

- **Avoid using syntactically or lexically ambiguous words.**
  Use grammatical markers (such as determinants) to mark the word category. Use adjectives to specify the noun (for example: “activation key” instead of “key”).

The following sections provide additional information about these rules.

**Grammar Writing Rules**

**Using Articles**

When writing English text for MT, use grammatical markers such as articles whenever possible.

**Avoiding Speech Ambiguity**

The biggest challenge for MT is resolving “part-of-speech” ambiguity. One of the most common and difficult problems in English analysis is eliminating ambiguity between a noun and a verb. This problem is exacerbated because almost every short noun can be a verb. For example, the phrase “start configuration” can be interpreted as “start the configuration” or as “the start configuration.” Inserting articles helps eliminate ambiguity between a noun and a verb.

Avoid abbreviated telegraphic style as much as possible by inserting “the” or “a” before a word with more than one part of speech.
Example

Instead of: Empty file
Use: Empty the file
Or: The empty file

Rule: Use articles to reduce part-of-speech ambiguity

Using Enumeration
In enumeration or lists, articles are needed to identify the relationship between the list items. Articles are also helpful in identifying which item in a list is modified.

Example

Instead of: Install programs and configuration files.
MT Output: Installer programmes et fichiers de Configuration.
Use: Install the programs and the configuration files.
MT Output: Installer les programmes et les fichiers de Configuration.

Rule: Use articles to clearly identify each item in a list. Repeat modifiers as necessary.

Ensuring Subject-Verb Agreement
Number disagreement, such as between subject and verb, occurs when there is a prepositional phrase or more than one item or action in a sentence. It is important to remember that a prepositional phrase does not affect the number of the subject and the verb.

Example

Instead of: The icon resets and come back into operation.
Use: The icon resets and comes back into operation.

Rule: Use a consistent number (singular or plural) for the subject and verb in a sentence

Using Prepositions
Prepositions are often hard for MT to analyze for scope when used in coordinated expressions. It is stylistically better and improves MT results to repeat prepositions in coordinated expressions.

Example

Instead of: When the problem occurs it can be fixed by starting Windows 95 in “Safe Mode” and removing the driver in the Network Control Panel.
MT Output: Quand le problème se produit il peut être fixé en démarrant Windows 95 en "Safe Mode" et enlever le pilote au Panneau de configuration de Network.
Using Infinitives at the Beginning of Sentences

When using a subordinate conjunction with an infinitive, the clause must be clear. Use an unambiguous conjunctive expression.

Example

Instead of: To find out who is approved to maintain your User Dictionary you can look up the list Users.

Use: In order to find out who is approved to maintain your User Dictionary you can look up the list Users.

Rule: Start subordinate phrases with a conjunction. Use “in order to” instead of “to” if the subordinate clause begins with an infinitive.

Using Imperatives

Imperatives are best placed at the beginning of a sentence, rather than embedded in the sentence.

Example

Instead of: Right click on the job(s) you would like to restore and select "Restore".

Use: Right click on the job(s) you would like to restore. Select "Restore".

Rule: Place imperatives at the beginning of a sentence.

Observing Punctuation Rules

Punctuation divides a sentence into logical parts. Without clear and correct punctuation, it is often possible to interpret a sentence in several ways.

Using Main Clauses

Example

Instead of: Supply Cassette The supply cassette has a spindle that includes notches for 14.5" widths.

MT Output: La Cassette débitrice la Cassette débitrice a un axe qui inclut des entailles pour des largeurs de 14.5".

Use: Supply Cassette: The supply cassette has a spindle that includes notches for 14.5" widths.
Rule: Place a comma before “and” or “but” to introduce an independent clause. You can also use a semicolon or start a new sentence.

**Using Subordinate Clauses**

Subordinate clauses are often introduced by a conjunction, such as when, then, because, after, although. By placing a comma at the start or at the end of the subordinate clause, you can help MT establish correct clause boundaries.

Example

Instead of: When the download is completed press a key to Reset the engine.

MT Output: Quand le téléchargement est pressé réalisée par touche pour remettre à zéro le périphérique.

Use: When the download is completed, press a key to Reset the engine.

MT Output: Quand le téléchargement est terminé, appuyez sur une touche pour remettre à zéro le périphérique.

Rule: Place a period or a semicolon to separate independent clauses.

**Using Relative Clauses**

Non-restrictive relative clauses are separated from the preceding main clause by a comma. These clauses are often introduced by words like "(one of) which", "where", and "when". The term "non-restrictive" means the relative clause does not limit the sense of the words in the principal clause.

Example

Instead of: Any external clock source that is connected to the “External Clock” input port. One of which is available on each node in the network.

MT Output: Any external clock source that is connected to the “External Clock” input port. One of which is available on each node in the network.

Or: Any external clock source that is connected to the "External Clock" input port One of the "External Clock" input ports is available on each node in the network.

Rule: Connect a non-restrictive relative clause to its main clause, separated by comma.

Optional: start a new sentence and repeat the subject of the clause. Compare this rule with restrictive relative clauses that are not set off by commas:

"The candidate who best meets these requirements will obtain the place".

Unlike the sentence above, this sentence cannot be split into two independent statements.
Embedded relative clauses are set off by a comma. Be sure to keep the subordinate clause close to the main clause it modifies.

Example

Instead of:  On August 20, 2001, a new internal power cable connector was introduced to production that retains sufficient grip with its motherboard contacts.
Use:  On August 20, 2001, a new internal power cable connector, that retains sufficient grip with its motherboard contacts, was introduced to production.

Rule:  Keep subordinate clauses close to the phrase they modify, and delimit embedded (relative) clauses with commas.

**Avoiding Multiple Stacking**

It is often better to separate a very long sentence into two sentences. This practice avoids the multiple stacking of main clauses and subordinate clauses.

Example

Instead of:  If you have a buffer that is manufactured earlier or if you are installing an Agfaline 44 OLP with a refurbished Avantra 44 imager you will need to order this buffer plate upgrade kit from Agfa Wilmington.
Use:  If you have a buffer that is manufactured earlier, or if you are installing an Agfaline 44 OLP with a refurbished Avantra 44 imager, you will need to order this buffer plate upgrade kit from Agfa Wilmington

Rule:  Limit sentence length. A sentence should have only one clause and no sub-clause, unless required (for example, conditionals such as IF...THEN). In case of doubt, start a new sentence.

**Using Compound Words**

Example

Instead of:  The CD ROM is available from SYSTRAN SD upon request.
Use:  The CD-ROM is available from SYSTRAN SD upon request.

Rule:  To avoid ambiguity, hyphenate compound words that modify other words or phrases.

**Using Capitalization**

Acronyms should be consistently spelled in capital letters only.

Example

Instead of:  You must explicitly select sx api support or your frame buffer driver will not be loaded.
Use:  You must explicitly select SX API Support or your frame buffer driver will not be loaded.

Rule:  Use only capital letters for acronyms.
**Using Spelling Variations**

Many variations in spelling include differences in capitalization and hyphenated vs. non-hyphenated spelling of a word. Compare the following examples:

When running the calibration from the Macintosh Application Diagnostics, there is a possibility that auto focus may be disabled dependent on the last scan performed.

The inclusion of Auto Focus within the Xcalibur VLF will increase the manufacturing capability of the drum while maintaining very consistent image quality.

Magnification compensation for auto-focus and optical descreening.

**Rule:** Apply consistent spelling conventions.

**Lexical Ambiguities**

**Disambiguation of Product Names and Menus**

Product names and menus cannot be easily differentiated from basic words in the sentence. Menus and product names should be marked either by typographical variants to avoid ambiguity.

Examples using uppercase as a differentiating marker - entry Return (proper noun) in UD.

Source: Press Return to continue

MT Output: Appuyez sur Return pour continuer

**Avoiding Lexical Ambiguities**

When a word has two meanings, use a compound instead of a simple word.

Example UD

key = touche

activation key = clef d'activation

Instead of: Without these we cannot give you a key.

MT Output: Sans ces derniers nous ne pouvons pas vous donner une touche.

Use: Without these we cannot give you an activation key.

MT Output: Sans ces derniers nous ne pouvons pas vous donner une clef d'activation.
Using Compounds
Coordinated compounds like “the EtherShare and the OPI serial number” are better translated when the input is “the EtherShare serial number and the OPI serial number”.

Example 1

Instead of: The request must include both the EtherShare and the OPI serial number.
MT Output: La demande doit inclure EtherShare et le numéro de série d'OPI.

Use: The request must include both the EtherShare serial number and the OPI serial number
MT Output: La demande doit inclure le numéro de série d’EtherShare et le numéro de série d’OPI.

Example 2

Instead of: High temperature can cause internal component failure of the machine and low can cause them to operate inconsistently.
MT Output: Une haute température peut causer l’échec de composant interne de la machine et bas peut les faire fonctionner inconséquemment.

Instead of: High temperature can cause internal component failure of the machine and a low temperature can cause them to operate inconsistently.
MT Output: Une haute température peut causer l’échec de composant interne de la machine et une basse température peut les faire fonctionner inconséquemment.

Rule: In the case of coordination, write complete compounds when possible.

Format and Typographical Issues
Since SYSTRAN’s MT usually translates each segment as an individual unit, it is vital to have good translation quality that segments syntactically, depending on the preceding or following segments. In a bulleted list, each segment is logically and syntactically dependent on the lead sentence. MT separates the segments and can misinterpret the instructions.

Segmentation Tags
In HTML format, the <BR> tag is a segmentation marker and should not be used inside sentences. SYSTRAN’s translation engine relies on this type of information to segment the input into translation units.

Instead of: This CSB is to inform the field that <BR> from now on a 15 meters Highwater cable is available as a spare part via the EVS system.
MT Output: This CSB is to inform the field that
From now on a 15 meters Highwater cable is available as a spare part via the EVS system.
Use: This CSB is to inform the field that from now on a 15 meters Highwater cable is available as a spare part via the EVS system.

Segment: This CSB is to inform the field that from now on a 15 meters Highwater cable is available as a spare part via the EVS system.

Rule: Avoid using <BR> tags in the middle of the sentences.

**Do-Not-Translate (DNT) Tags**

Information in tables may need to be excluded from translation. Examples of tabular information that should not be translated include references to error messages, device names, and general information that should not be translated. Currently, these tables are translated, which results in meaningless translations. Using Do-not-translate (DNT) tags, you can resolve this problem.
Appendix C

Sample Imperative Translations

English into French   179
English into German   179
English into Italian   179
English into Portuguese   180
English into Spanish   180
SAMPLE IMPERATIVE TRANSLATIONS

This appendix provides sample sentences and their translations for each Imperative Translation Mode available for English into French, German, Italian, Portuguese, and Spanish. There are no imperative options available for English target translations.

The imperative option can be combined with the pronoun options.

English into French

Sample English sentence using the imperative:

Push the button.

Imperative Translation (default):
Poussez le bouton (or Pousse le bouton, depending on the pronoun option)

Infinitive Option:
Pousser le bouton.

English into German

Sample English sentence using the imperative:

Turn the knob.

Imperative Translation (default):
Drehen Sie den Drehknopf (or Drehe den Drehknopf or Dreht den Drehknopf, depending on the pronoun option)

Infinitive Option:
Drehknopf drehen.

English into Italian

Sample English sentence using the imperative:

Shut the door.

Imperative Translation (default):
Chiuda il portello.

Infinitive Option:
Chiudere il portello.
**English into Portuguese**

Sample English sentence using the imperative:

Open the door.

Imperative Translation (default):
Abra a porta.

Infinitive Option:
Abrir a porta.

**English into Spanish**

Sample English sentence using the imperative:

Verify the position.

Imperative Translation (default): Verifique la posición (or Verifiquen la posición Verifica la posición, or Verifícan la posición, depending on pronoun option)

Infinitive Option:
Verificar la posición.
Appendix D

Importing and Exporting Files

Importing Formatted Text Files  182
    Sample Formatted Text File  183
Importing Microsoft Excel Files  183
    Sample Excel Spreadsheet  184
Exporting Files  184
Importing and Exporting Files

Using SYSTRAN Dictionary Manager’s (SDM’s) Import feature, you can open dictionaries created with a spreadsheet application, such as Microsoft Excel, or a common text editor. These dictionaries must be specifically formatted before they can be imported into SDM. This appendix describes how to format these dictionaries.

Importing Formatted Text Files

Text files to be imported as dictionaries must contain dictionary content and document headers. Some headers are necessary for importation into SDM, while others are optional. All of the headers serve as precursors to raw information — which follows an = symbol — that is pertinent to the User Dictionary (UD). Table D-1 identifies the required and optional fields that formatted text files must adhere to successfully import into SDM.

Table D-1: Required and Optional Fields for Importing Formatted Text Files into SDM

<table>
<thead>
<tr>
<th>Header</th>
<th>Description of Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>#AUTHOR=</td>
<td>Optional: contains the name of the creator of the dictionary.</td>
</tr>
<tr>
<td>#EMAIL=</td>
<td>Optional: contains the email address of the creator of the dictionary.</td>
</tr>
<tr>
<td>#COVERED DOMAINS=</td>
<td>Optional header: lists all domains configured to the dictionary.</td>
</tr>
<tr>
<td>#ENCODING=</td>
<td>Defines the encoding of the file. UTF-8 encoding is recommended.</td>
</tr>
<tr>
<td>#GENERAL DICTIONARY DOMAINS=</td>
<td>Optional header: lists the system domains configured to the dictionary.</td>
</tr>
<tr>
<td>#MULTI</td>
<td>Required: determines the UD tab Multilingual for the header information that follows.</td>
</tr>
<tr>
<td>#SUMMARY=</td>
<td>Required: the name of the UD file.</td>
</tr>
<tr>
<td>#&lt;Languages&gt;&lt;Informational columns&gt;=</td>
<td>Required: designates all informational columns for the UD, including the 2-letter ISO 639 codes for languages; Include those that are to be in the UD. Field is tab-delimited.</td>
</tr>
<tr>
<td>#DNT</td>
<td>Required; determines the UD tab Do not translate for the header information that follows.</td>
</tr>
</tbody>
</table>
Sample Formatted Text File

The following sample text file is formatted for importing into SDM.

```
#AUTHOR=SYSTRAN
#EMAIL=smith@systran.fr
#COVERED DOMAINS=Computers/Data Processing
#ENCODING=UTF-8
#GENERAL DICTIONARY DOMAINS=Computers/Data Processing
#SUMMARY=Demo Computer
#MULTI
#ENFRNOTEDOMAINS
write and compute écriture et calcul
write cycle cycle d'écriture
write enable validation écriture
write error erreur à l'écriture
write fault error erreur d'écriture
"write forward" (noun) écriture anticipée
#DNT
#ENNOTEDOMAINS
hiccupure
```

After the text file above is imported, it appears in SDM as shown in Figure D-1.

![Figure D-1: Example of How Imported Formatted Text Appears in SDM](image-url)
Importing Microsoft Excel Files

To import dictionaries created with Microsoft Excel, be sure the files consist of two worksheets, each named for the tab in the UD: Multilingual and Do not translate.

As with formatted text files, the Microsoft Excel file column headings reflecting the Languages and informational columns for the UD must be present as they will be displayed in SDM.

Sample Excel Spreadsheet

Figure D-2 is an Excel spreadsheet that is formatted for importing into SDM.

![Figure D-2: Example of Formatting an Excel Spreadsheet for SDM](image)

After the Excel file above is imported into SDM, it appears in SDM as shown in Figure D-3.

![Figure D-3: Example of How an Imported Excel Spreadsheet Appears in SDM](image)

Exporting Files

Just as formatted text files and Microsoft Excel files can be imported into SDM, UDs created in SDM can be exported to these two formats. The operation is a straight reversal of the import information in the previous sections of this appendix, with the newly created files reflecting the columnar headings settings configured in SDM.
# Glossary

This glossary explains in detail the terminology used in this manual.

**A**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acronym</strong></td>
<td>In SYSTRAN terminology, a word, all upper case, formed from the initial letters of other words or parts of a series of words, such as WAC for Women's Army Corps.</td>
</tr>
<tr>
<td><strong>Adjective</strong></td>
<td>A word used to modify a noun by limiting or qualifying. In English, it can be distinguished by one of several suffixes, such as -able, -ous, -er, and -est, because it directly precedes a noun or noun phrase, such as red in a red door, or because it is preceded by a form of to be, such as the door is red.</td>
</tr>
<tr>
<td><strong>Adverb</strong></td>
<td>A word that modifies a verb, an adjective, or another adverb, such as brightly in The sun shines brightly.</td>
</tr>
<tr>
<td><strong>Algorithm</strong></td>
<td>A step-by-step problem-solving procedure.</td>
</tr>
<tr>
<td><strong>Article</strong></td>
<td>A word used to signal a noun and to specify its application. In English, the definite article is the, and the indefinite articles are a and an.</td>
</tr>
<tr>
<td><strong>Auxiliary verb</strong></td>
<td>A verb, such as have, can, or will, that accompanies the main verb in a clause and helps to make distinctions in aspect, mood, tense, and voice.</td>
</tr>
</tbody>
</table>

**C**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clause</strong></td>
<td>A group of two or more words which contains a verb. One or more clauses make up a complete sentence.</td>
</tr>
</tbody>
</table>

**D**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DNT</strong></td>
<td>An acronym for Do Not Translate.</td>
</tr>
<tr>
<td><strong>DNT List</strong></td>
<td>A list of words created by the translator that will not be translated by the SYSTRAN Translation System.</td>
</tr>
<tr>
<td><strong>Do Not Translate</strong></td>
<td>A sequence of words (part of a sentence) that is not to be translated.</td>
</tr>
<tr>
<td><strong>Do Not Translate (DNT) Insertion</strong></td>
<td>A sequence of words within a complete sentence that is not to be translated.</td>
</tr>
<tr>
<td><strong>Do Not Translate (DNT) Paragraph</strong></td>
<td>A part of a document that is not to be translated.</td>
</tr>
</tbody>
</table>
Embedded clause
A subordinate clause that is embedded in the middle of a main clause. For example, The camera, which I bought yesterday, is already broken.

Expression
In SYSTRAN terminology, a noun phrase consisting of more than one noun or any combination of nouns and adjectives, where the Head Word is a noun, such as lug nut, Library of Congress, and red letter day. Complete sentences are not valid SYSTRAN expressions; neither are any phrases that contain verbs.

Expression Dictionary
The SYSTRAN dictionary that contains expressions. See Stem Dictionary.

Finite verb
A verb form that is limited in tense, person, and number, such as goes in He goes.

First person
A pronoun that refers to the speaker. For example, I in I see, or We in We are. Also, a verb form that refers to the speaker. For example, am in I am, or are in We are. Verb inflection rarely indicates person in English, but in other languages, it often does.

Head Word
In SYSTRAN terminology, the noun in a noun phrase that can change when plural, such as nut in lug nut, Library in Library of Congress, and day in red letter day.

Homograph
In SYSTRAN terminology, one of two or more words that have the same spelling and are different parts of speech (for example, noun and verb, or adjective and verb). For example, head as in head west or on the head, and light, as in the light box and light the match.

Imperative
A verb form that is used to express an order or command. For example, Eat in Eat your vegetables.

Infinitive
A verb form that is the ordinary dictionary-entry form. In English, it is often used with to as in He wants to eat. It may also occur without to, for example, get in I made them get in line, or with auxiliary verbs such as must as in We must leave.

Inflection
An alternation of the form of a word by adding suffixes without changing the basic meaning or part of speech, as in making rugs from rug, or by changing the form of a base word, as in making ate from eat.
M

**Main clause** A clause that can stand alone as a complete and correct sentence. For example, It was raining.

N

**NFW** The acronym for Not-Found Word.

**Not-Found Word** A word or string that occurred in the text, but not in the dictionaries used in translation.

**Not-Found Word List** An alphabetical list of all words in a text that were not found in the dictionaries used for translation.

**Not-Found Word Marker** A mark that the translator can select, which appears in the translation to indicate a Not-Found Word.

**Noun** A word that is used to name a person, place, thing, quality, or action, for example, house, flammability, or movement.

**Noun phrase** A phrase that functions as a noun, and that has a noun as its head word.

P

**Parse** To break (a sentence) down into its component parts of speech with an explanation of the form, function, and syntactical relationship of each part.

**Parser** In SYSTRAN terminology, the module of the computer program that performs syntactic or semantic analysis of the Source text.

**Participle** A verb form that can be used with an auxiliary verb. It can also function as an adjective or a noun. See Past Participle and Present Participle.

**Past participle** A verb form that indicates past or completed action. It can be used with an auxiliary verb as in The cake was baked yesterday, or as an adjective, as in baked beans.

**Phrase** A sequence of two or more words which express an idea. See also, Noun Phrase, Verb Phrase, and Prepositional Phrase.

**Plugin** A software component that adds a specific feature or service to a larger application. For example, SYSTRAN 5.0 provides plugins for performing translations from Internet Explorer and the following Microsoft Office 2003, XP, and 2000 applications: Word, Excel, PowerPoint, and Outlook.

**POS** The acronym for Part of Speech.

**Preposition** A word placed before a noun or noun phrase, indicating the relation of that noun or noun phrase to a verb, an adjective, or another noun or noun phrase, such as at, by, in, to, from, and with.
Prepositional phrase  A phrase that consists of a preposition plus the noun or noun phrase that it governs, such as at the park, in reference to your letter, or from Mars.

Present participle  A verb form expressing present action, formed in English from the infinitive plus -ing, which can be used with auxiliary verbs as in He is baking a cake; as an adjective, the baking rack; or as a noun, as in, the act of baking.

Principal Word  The main word in an expression. For example, clip in paper clip. The Principal Word is not necessarily the same as the Head Word. In the expression paper clip box, clip is the Principal Word, but box is the Head Word.

Pronoun  A word that functions as a substitute for a noun or a noun phrase and designates persons or things asked for, previously specified, or understood from the context. For example, I, it, that, and which.

Proper noun  A noun belonging to the class of words used as names for individuals or places. For example, Clinton or Boston.

S

Second person  A pronoun that refers to the listener. For example, you in You see or You are. Also, a verb form that refers to the listener. For example, are in You are. Verb inflection rarely indicates person in English, but in other languages, it often does.

Semantic  Having to do with meaning.

Sentence  A grammatical unit that is syntactically independent and has a subject that is expressed or understood and a predicate that contains at least one finite verb.

Source  The language of the original text, before translation.

Specialized Dictionary  A translation option that allows the translator to choose appropriate subject areas for the document.

Stem Dictionary  The SYSTRAN dictionary that contains all forms of single words. See Expression Dictionary.

Subjunctive  A verb form that indicates possibility, doubt, or desire rather than fact. For example, were in I wish it were true, or start in I suggest you start immediately.

Subordinate clause  A clause that modifies or expands on other clauses. A subordinate clause modifies or expands on another clause. It cannot stand alone, as that he gave in The account that he gave was true.

Subordinate clause marker  A word that indicates a clause is a subordinate clause, such as that, which, or who.

Subordinate phrase  A phrase that modifies or expands on other phrases.

Syntactic  Having to do with sentence structure.
**T**

**Target**
The language into which the text is translated.

**Third person**
A pronoun that refers to neither the speaker nor the listener. For example, He in He is, She in She is, it in it is, or They in They are. Also, a verb form that refers to neither the speaker nor the listener. For example, is in He is and She is, or are in They are. Verb inflection rarely indicates person in English, but in other languages, it often does.

**Translation Memory (TM)**
A set of translated and validated sentences that can be integrated into the translation process.

**U**

**UD**
The acronym for User Dictionary.

**User Dictionary**
A dictionary used in translation that has been created by the user for the purpose of tailoring translations to his specific needs. Definitions in a UD override the ones in SYSTRAN’s dictionaries.

**V**

**Verb**
A word that expresses existence, action, or occurrence.

**Verb phrase**
In SYSTRAN terminology, a phrase or other construction used as a verb. Verb phrases are not acceptable entries in a UD.

**Verb-noun homograph**
In SYSTRAN terminology, a word that has a verb usage, such as the word work in I work all day and a noun usage, such as the word work in Work is fun.
LIST OF FIGURES

Figure 2-1: SYSTRAN Toolbar ........................................... 21
Figure 2-2: Example of the Translation Options Window .......... 24
Figure 2-3: Example of User Dictionaries Window ................. 30
Figure 2-4: Example of Selecting a SYSTRAN Dictionary ....... 31
Figure 2-5: Using Arrows to Prioritize Dictionaries and Domains ... 32
Figure 2-6: Example of the Terminology Review Tab ............. 34
Figure 2-7: User Dictionaries Window ............................... 35
Figure 2-8: Close-up of the User Dictionaries Button .......... 36
Figure 3-1: Plugin for Internet Explorer ............................ 40
Figure 3-2: Displaying the Fluid Navigation Options .......... 41
Figure 4-1: Example of Selecting a Language Pair ............... 46
Figure 4-2: Example of Save As Dialog Box ....................... 47
Figure 4-3: Word Plugin Options Window .......................... 48
Figure 4-4: Selecting the Extended Alignment Setting .......... 49
Figure 4-5: Example of Using Alignment in a Microsoft Word Document ........................................ 50
Figure 4-6: Example of Selecting a Language Pair ............... 50
Figure 4-7: Example of a Translated Email ....................... 51
Figure 4-8: Outlook Plugin Options Window ....................... 52
Figure 5-1: SYSTRAN Clipboard Taskbar ......................... 56
Figure 5-2: Clipboard Translator Options Window ............... 57
Figure 5-3: Selecting the Active Clipboard Setting ............ 58
Figure 7-1: Components of the SYSTRAN Translation Project Manager Window ........................................... 65
Figure 7-2: STPM Toolbar ............................................ 66
Figure 7-3: Open Dialog Box ....................................... 68
Figure 7-4: Example of a File in a Source Document Window . 68
Figure 7-5: Example of a Web Page in the Source Document Window ........................................... 69
Figure 7-6: Example of Source and Translated Web Pages .... 70
Figure 7-7: Example of Using the Alignment Feature .......... 71
Figure 7-8: Alternative Meanings Tab ............................. 72
Figure 7-9: Translation Memory Tab ............................... 74
Figure 7-10: Example of Source Analysis Tab .................... 75
Figure 7-11: Example of Sentence Review Tab ............ 77
Figure 7-12: Example of Viewing All Not Found Words .... 79
Figure 7-13: Example of Viewing Individual
Instances of Not Found Words ...................... 80
Figure 7-14: Search and Highlight Window .................. 81
Figure 7-15: Save As Dialog Box ......................... 82
Figure 7-16: Find Dialog Box .............................. 84
Figure 7-17: STPM Format Toolbar ....................... 86
Figure 7-18: Controls for Navigating Between and Closing Projects . 87
Figure 7-19: Save As Dialog Box ......................... 88
Figure 7-20: Save As Dialog Box ......................... 89
Figure 7-21: Save As Dialog Box ......................... 90
Figure 7-22: Save As Dialog Box ......................... 91
Figure 8-1: Components of the SYSTRAN
MultiTranslate Utility Window ....................... 94
Figure 8-2: SMTU Toolbar .................................. 95
Figure 8-3: Example of an Untitled Batch File in the SMTU Window . 97
Figure 8-4: Open Dialog Box .............................. 99
Figure 8-5: Browse for Folder Dialog Box .................. 100
Figure 8-6: Example of Batch File Contents ............... 101
Figure 8-7: Commands from the Translate Button Drop-down List . 102
Figure 8-8: Batch Entry Options Window .................... 106
Figure 8-9: Controls for Navigating Between and
Closing Batch Files ................................. 109
Figure 8-10: Save As Dialog Box ......................... 110
Figure 9-1: SYSTRAN Dictionary Manager Window ........ 114
Figure 9-2: SDM Toolbar ................................. 115
Figure 9-3: Dictionary Properties Dialog Box - Languages Tab . 117
Figure 9-4: Selecting a Source Language from the Drop-down List. 118
Figure 9-5: Information Message .......................... 119
Figure 9-6: Example of Selecting Values from a Drop-down List . 119
Figure 9-7: Dictionary Properties Dialog Box - Properties Tab . 121
Figure 9-8: Domains and Priority Tab ........................ 123
Figure 9-9: Sample Multilingual Page in the SDM Window . 124
Figure 9-10: Multilingual/ Do Not Translate Buttons .......... 125
Figure 9-11: Viewing the Confidence Level for a Definition .... 128
Figure 9-12: Expert Coding Dialog Box .................... 131
## LIST OF TABLES

<table>
<thead>
<tr>
<th>Table 1-1:</th>
<th>Matching Readers with Chapters</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 2-1:</td>
<td>Summary of GUI Components Supported by SYSTRAN 5.0 Products</td>
<td>12</td>
</tr>
<tr>
<td>Table 2-2:</td>
<td>Activities at a Glance</td>
<td>14</td>
</tr>
<tr>
<td>Table 2-3:</td>
<td>STPM Features</td>
<td>18</td>
</tr>
<tr>
<td>Table 2-4:</td>
<td>SDM Features</td>
<td>19</td>
</tr>
<tr>
<td>Table 2-5:</td>
<td>Application-Specific Buttons</td>
<td>22</td>
</tr>
<tr>
<td>Table 2-6:</td>
<td>Translation Options</td>
<td>25</td>
</tr>
<tr>
<td>Table 2-7:</td>
<td>SYSTRAN Dictionaries and Domains</td>
<td>28</td>
</tr>
<tr>
<td>Table 3-1:</td>
<td>Fluid Navigation Options</td>
<td>42</td>
</tr>
<tr>
<td>Table 7-1:</td>
<td>SYSTRAN Translation Project Manager Window Components</td>
<td>66</td>
</tr>
<tr>
<td>Table 7-2:</td>
<td>Search Options in the Find Dialog Box</td>
<td>85</td>
</tr>
<tr>
<td>Table 8-1:</td>
<td>SYSTRAN MultiTranslate Utility Window Components</td>
<td>94</td>
</tr>
<tr>
<td>Table 8-2:</td>
<td>Commands and Buttons for Arranging Items in a Batch File or Folder</td>
<td>102</td>
</tr>
<tr>
<td>Table 8-3:</td>
<td>Options in the Batch Entry Options Window</td>
<td>107</td>
</tr>
<tr>
<td>Table 9-1:</td>
<td>SYSTRAN Dictionary Manager Window Components</td>
<td>115</td>
</tr>
<tr>
<td>Table 9-2:</td>
<td>Informational Columns</td>
<td>120</td>
</tr>
<tr>
<td>Table 9-3:</td>
<td>Dictionary Priorities</td>
<td>120</td>
</tr>
<tr>
<td>Table 9-4:</td>
<td>Status Column Description</td>
<td>128</td>
</tr>
<tr>
<td>Table 9-5:</td>
<td>Textual Lookup Operators</td>
<td>135</td>
</tr>
<tr>
<td>Table 9-6:</td>
<td>Textual Lookup Operators</td>
<td>136</td>
</tr>
<tr>
<td>Table 9-7:</td>
<td>Search Options in the Find Dialog Box</td>
<td>138</td>
</tr>
<tr>
<td>Table A-1:</td>
<td>File Menu (STPM)</td>
<td>151</td>
</tr>
<tr>
<td>Table A-2:</td>
<td>Edit Menu (STPM)</td>
<td>152</td>
</tr>
<tr>
<td>Table A-3:</td>
<td>Format Menu (STPM)</td>
<td>152</td>
</tr>
<tr>
<td>Table A-4:</td>
<td>Tools Menu (STPM)</td>
<td>153</td>
</tr>
<tr>
<td>Table A-5:</td>
<td>Windows Menu (STPM).</td>
<td>154</td>
</tr>
<tr>
<td>Table A-6:</td>
<td>Help Menu (STPM)</td>
<td>154</td>
</tr>
<tr>
<td>Table A-7:</td>
<td>STPM Right-Click Menu</td>
<td>157</td>
</tr>
<tr>
<td>Table A-8:</td>
<td>STPM Toolbar Menu</td>
<td>158</td>
</tr>
<tr>
<td>Table A-9:</td>
<td>File Menu (SMTU)</td>
<td>159</td>
</tr>
<tr>
<td>Table A-10:</td>
<td>View Menu (SMTU)</td>
<td>159</td>
</tr>
</tbody>
</table>
Table A-11: Batch Menu (SMTU) .......................... 160
Table A-12: Help Menu (SMTU) .......................... 160
Table A-13: File Menu (SDM) ............................ 163
Table A-14: Edit Menu (SDM) ............................ 164
Table A-15: View Menu (SDM) .......................... 165
Table A-16: Tool Menu (SDM) ............................ 165
Table A-17: Window Menu (SDM) ........................ 166
Table A-18: Help Menu (SDM) .......................... 166
Table A-19: SYSTRAN Server Commands .............. 168
Table D-1: Required and Optional Fields for Importing Formatted Text Files into SDM ............... 182
INDEX

A
Activities at a glance 14
Adding
  files 98
  folders 99
  web pages 100

B
Batch File
  arranging items 101
  opening 96
  translating contents 102

Bookmarks 10

C
Coding
  all user dictionary entries 130
  expert coding 131
  individual user dictionary entry 130

Conventions 9

Customizing translations
  using Office plugins 52
  using SCT 58
  using SMTU 103

E
Exporting
  files 184
  projects, source files, and target files 89
  source files or web pages 90
  target files or web pages 91

F
Formatting Text 86

I
Importing
  formatted text files 182
  Microsoft Excel files 184

Improving Translations
  selecting Translation Options 42, 78
  translation Options 58
  user Dictionaries 59, 78

Improving translations using STPM 71

L
Launching
  SYSTRAN Clipboard Taskbar 56
  SYSTRAN Dictionary Manager 114
  SYSTRAN MultiTranslate Utility 94

M
Matching users with chapters 8
Menus and Commands (SDM) 162–166
Menus and Commands (SMTU) 159–160
Menus and Commands (STPM) 151–154
  right-click menus 157

Miscellaneous SMTU Activities
  CLI examples 111
  closing batch files 110
  navigating between batch files 109
  saving the Project 109
  specifying batch entry options 105
  using the CLI to schedule a translation job 111
  using the SMTU command line interface 111

Miscellaneous STPM Activities
  contextual Dictionary Activities 82
  editing Text 85
  exporting Projects, Source Files, and Target Files 89
  exporting Source Files or Web Pages 90
  exporting Target Files or Web Pages 91
  finding Words and Expressions in User Dictionaries 84
  formatting Text 86
  navigating between Projects 87
  saving Projects 87
  specifying DNT Entities 83

Z
<table>
<thead>
<tr>
<th>Letter</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Navigation bar 10</td>
</tr>
<tr>
<td>P</td>
<td>Plugin for Internet Explorer 39</td>
</tr>
<tr>
<td></td>
<td>Preparing English Text for MT</td>
</tr>
<tr>
<td></td>
<td>avoiding multiple stacking 174</td>
</tr>
<tr>
<td></td>
<td>capitalization 174</td>
</tr>
<tr>
<td></td>
<td>compound words 174</td>
</tr>
<tr>
<td></td>
<td>compounds 176</td>
</tr>
<tr>
<td></td>
<td>do-not-translate (DNT) tags 177</td>
</tr>
<tr>
<td></td>
<td>ensuring subject-verb agreement 171</td>
</tr>
<tr>
<td></td>
<td>enumeration 171</td>
</tr>
<tr>
<td></td>
<td>format and typographical issues 176</td>
</tr>
<tr>
<td></td>
<td>general principles 170</td>
</tr>
<tr>
<td></td>
<td>grammar writing rules 170</td>
</tr>
<tr>
<td></td>
<td>imperatives 172</td>
</tr>
<tr>
<td></td>
<td>infinitives at the beginning of sentences 172</td>
</tr>
<tr>
<td></td>
<td>lexical ambiguities 175</td>
</tr>
<tr>
<td></td>
<td>main clauses 172</td>
</tr>
<tr>
<td></td>
<td>observing punctuation rules 172</td>
</tr>
<tr>
<td></td>
<td>prepositions 171</td>
</tr>
<tr>
<td></td>
<td>relative clauses 173</td>
</tr>
<tr>
<td></td>
<td>segmentation tags 176</td>
</tr>
<tr>
<td></td>
<td>spelling variations 175</td>
</tr>
<tr>
<td></td>
<td>subordinate clauses 173</td>
</tr>
<tr>
<td>S</td>
<td>Sample Imperative Translations 179–180</td>
</tr>
<tr>
<td></td>
<td>SYSTRAN MultiTranslate Utility</td>
</tr>
<tr>
<td></td>
<td>displaying or Hiding SMTU Toolbars 95</td>
</tr>
<tr>
<td></td>
<td>overview 20</td>
</tr>
<tr>
<td></td>
<td>review feature 105</td>
</tr>
<tr>
<td></td>
<td>SYSTRAN Portable Document Format Translator</td>
</tr>
<tr>
<td></td>
<td>overview 17</td>
</tr>
<tr>
<td></td>
<td>searching and Highlighting 79</td>
</tr>
<tr>
<td></td>
<td>STPM 67</td>
</tr>
<tr>
<td></td>
<td>STPM Menus and Commands 151</td>
</tr>
<tr>
<td></td>
<td>working with user dictionary entries 125</td>
</tr>
<tr>
<td></td>
<td>SYSTRAN Server 168</td>
</tr>
<tr>
<td></td>
<td>SYSTRAN Translation Project Manager</td>
</tr>
<tr>
<td></td>
<td>displaying or Hiding STPM Toolbars 66</td>
</tr>
<tr>
<td></td>
<td>overview 17</td>
</tr>
<tr>
<td></td>
<td>opening an Existing Project 69</td>
</tr>
<tr>
<td></td>
<td>overview 17</td>
</tr>
<tr>
<td></td>
<td>checking the confident level of user dictionary entries 127</td>
</tr>
<tr>
<td></td>
<td>coding all user dictionary entries 130</td>
</tr>
<tr>
<td></td>
<td>coding an individual user dictionary entry 130</td>
</tr>
<tr>
<td></td>
<td>coding user dictionary entries 130</td>
</tr>
<tr>
<td></td>
<td>completing the domains and priority tab 123</td>
</tr>
<tr>
<td></td>
<td>completing the properties tab 121</td>
</tr>
<tr>
<td></td>
<td>creating a new project 116</td>
</tr>
<tr>
<td></td>
<td>displaying or hiding SDM toolbars 115</td>
</tr>
<tr>
<td></td>
<td>editing user dictionary entries 129</td>
</tr>
<tr>
<td></td>
<td>entering lookup operators 137</td>
</tr>
<tr>
<td></td>
<td>finding Entries 138</td>
</tr>
<tr>
<td></td>
<td>importing files into a user dictionary 142</td>
</tr>
<tr>
<td></td>
<td>inserting words and phrases into a user dictionary 126</td>
</tr>
<tr>
<td></td>
<td>managing a Dictionary of Translation Memory 115</td>
</tr>
<tr>
<td></td>
<td>marking headwords 135</td>
</tr>
<tr>
<td></td>
<td>normalizing dictionaries 113</td>
</tr>
<tr>
<td></td>
<td>procedure for reversing entries in a user dictionary 141</td>
</tr>
<tr>
<td></td>
<td>removing words and phrases from a user dictionary 127</td>
</tr>
<tr>
<td></td>
<td>reversing entries in user dictionaries 140</td>
</tr>
<tr>
<td></td>
<td>sorting language columns 134</td>
</tr>
<tr>
<td></td>
<td>translation memories 114</td>
</tr>
<tr>
<td></td>
<td>using expert coding 131</td>
</tr>
<tr>
<td></td>
<td>using textual lookup operators 135</td>
</tr>
<tr>
<td></td>
<td>viewing and changing dictionary properties 141</td>
</tr>
<tr>
<td></td>
<td>working with user dictionary entries 125</td>
</tr>
</tbody>
</table>
T
Terms and concepts 9
Toolbars (SDM)
  lookup operators toolbar 167
  standard toolbar 167
  status bar 168
Toolbars (SMTU)
  batch toolbar 161
  standard toolbar 161
  stop button 161
  SYSTRAN Toolbar 162
  URL toolbar 161
Toolbars (STPM)
  format toolbar 155
  standard toolbar 155
  stop toolbar 156
  SYSTRAN toolbar 156
  web toolbar 156
Translating
  displaying a web page 69
  Microsoft Word documents 46
  PDF Documents 61
  translating Files and Web Pages 70
  Web pages using the plugin for Internet Explorer 40
Translating selected text in a Word document 47

U
Understanding Batch Files 93
Understanding terms and concepts 9
User Dictionaries
  bracketing 145
  canonical form 145
  changing entry types 130
  checking the confidence level of entries 127
  coding all entries 130
  coding an individual entry 130
  coding entries 130
  conditional entries 147
  editing entries 129
  Exporting Files 143
  finding Words and Expressions 84
  grammatical entries 147
  importing files 142
  inserting words or phrases 126
  intuitive clues 146
  procedure for reversing entries 141
  protected sequences 144
  removing words and phrases 127
  reversing entries 140
  simple and compound entries 145
  upper-case letters 145
  using intuitive coding to build high-quality dictionaries 144
  viewing and Changing Dictionary Properties 141
  working with entries 125
Using
  SYSTRAN Clipboard Taskbar 56
  SYSTRAN MultiTranslate Utility 96
Using SYSTRAN Dictionary Manager
  overview 21
  user dictionaries 113
Using SYSTRAN Translation Project Manager (STMP)
  understanding Files, Web Pages, and Projects 64